




In an ideal world, you’d be able to use the same cable to charge and sync all your mobile devices. 

The Anchor Cable has a magnetic tip at one end, onto which you can attach one of three 

interchangeable tips: USB-C, Micro-USB and Lightning. At the other end is a USB-A connector. 

The cable is wrapped in a flexible metal sheath that stretches out a little, so it feels like it should 

hold up better against tension and flex than rubber-coated options. No case is provided for 

the tips so, unless you leave them installed in devices, you’ll want to get a box for safekeeping.

 From $49 (about £35)  WEBSITE anchorcable.com

 INCLUDES 4ft Anchor Cable, USB-C, Micro-USB and Lightning tips

Anchor Cable

 iOpener
Game-changing tech from the world of Apple and beyond

What if you could carry just one cable?

The steel-encased 
cable connects  

to the tips using a  
super-strong magnet.
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Thanks to the 
interchangeable tips, 
the cable works with 
a variety of devices.

The tangle-
free cable 

comes with 
a lifetime 
warranty.
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 Mac owners have been living with 

Wi-Fi since the summer of 1999, and 

which of us would be without it? 

Sure, there are some circumstances 

in which a cabled connection is better, 

but can you imagine if the great 

handheld devices we used today 

had to be plugged in to get online?

This issue we take an in-depth 

look at how to improve your home 

network. Whether some or all of your 

devices use Wi-Fi or Ethernet, you’ve almost certainly run into 

connection troubles at some point. The problem might be with 

your network, the place where you’re trying to get online with 

a device, or further afield. We’ll show you how to pinpoint 

problems, diagnose their causes, solutions for fixing them, 

and advice on products that can eliminate network nuisances.

When you’ve knocked your network into shape, check out 

our second feature and be inspired by all the things you can 

do in a web browser these days. If you need help comparing 

online prices, want something more robust than Safari’s 

Reading List to keep track of pages to return to, or need 

guidance about whether a site is safe to use, you’ll discover 

great web browser extensions for these tasks and more.

Before you get stuck in: if you’re tired of recent system 

updates offering little more than fixes, check out our guide 

to the latest updates’ features on page 40. 
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editor@macformat.com
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Operations Editor 
 Jo is looking forward 

to sorting out her home 

network. Her aim is to 

eliminate the phrase 

‘Mum, the Wi-Fi is so 

laggy!’ from her life.

  
Alex Blake
Commissioning Editor 

 Alex has been on an 

extended Safari this issue, 

researching our guide to 

the many useful (and 

some outright fun) things 

you can do in a browser.

Paul Blachford
Art Editor 

 Paul was intrigued by the 

new 9.7-inch iPad, due to 

its Apple Pencil support, 

until he found out about 

weaknesses for pro users. 

Check out our review on 

page 82 to learn more.
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cards on the Mac Apple working on own chips

ver the years, Apple has started 

introducing its own chips into its 

products. AirPods are equipped with 

the W1 wireless chip, for example, while the 

iPhone X runs on the A11 Bionic chip. Now it 

looks like Apple may start doing the same for 

its Mac computers.

According to Bloomberg, Apple will switch 

Macs over to its own processors as early as 

2020, replacing Intel as its chip supplier. That 

could be a blow to Intel, which has worked with 

Apple on its Mac chips since 2006, when it 

moved away from PowerPC processors. Apple 

currently provides Intel with about 5% of its 

revenues, claims Bloomberg.

The initiative is reportedly code-named 

Kalamata at Apple, and is still in the early 

stages of development. The end goal is to 

have all of Apple’s devices running on its own 

chips, thereby aiding their ability to seamlessly 

Mac processors may be made by Apple in the future

HOT TOPIC!

O
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EDITED BY ALAN STONEBRIDGE 

Apple is looking into 
manufacturing its own 
Mac processors, which 
would mean it would 
no longer be subject 
to Intel’s timeline.
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If Apple develops its own chips, 
it could integrate hardware 
and software more closely

THE POLL

 Log on and see next 
issue’s big question!
twitter.com/macformat
facebook.com/macformat

WE ASKED… Does the new 
£319 iPad’s Apple Pencil 
support interest you?

I need 
convincing

32%

11%

I’m quite 
interested

Definitely 
not 

Yes, it  
looks great

36%

21%

tarting on 1 June, all app 

updates submitted to the Mac 

App Store must be 64-bit-

compatible. This follows Apple’s move 

in January 2018, when it began requiring 

new apps to be optimised for 64-bit Macs.

This latest change will largely affect 

older apps that are yet to add 64-bit 

support. The first time you open a 32-bit 

app on macOS 10.13.4 or later, you’ll get 

a warning telling you that the app is not 

optimised for your Mac.

Apple announced at WWDC 2017 that it 

would start phasing out support for 32-bit 

apps in macOS, and that High Sierra would 

be the last version to support 32-bit apps 

“without compromises”. It also stated that 

all future macOS software must be 64-bit.

Time running out for 32-bit apps
Mac App Store to futureproof your app purchases

S

work and integrate with each other.

One major benefit of the move for 

Apple would be that it could release its 

Mac products to its own timeline, rather 

than having to rely on Intel’s schedule. 

Whenever Intel releases a new generation 

of chips, there is much speculation as to 

whether they will be integrated into Macs 

and whether Apple has time to do so.

Having more control over the Mac’s 

processor would also let Apple integrate 

its hardware and software more closely, 

as it can with the iPhone and iPad. It could 

also mean closer cooperation between iOS 

and macOS, according to Shannon Cross, 

an analyst at Cross Research.

Bloomberg further reports that Apple 

is working on a plan to allow iOS apps to 

work on macOS. The project, code-named 

Marzipan, could be unveiled as soon as 

this year and would benefit from the use 

of Apple’s own chips in the future.

Of course, Apple will want to ensure 

that its own processors are able to keep 

up with Intel’s current crop that are found 

in Macs. Intel’s processors are known for 

their speed and power; therefore Apple 

might first introduce its own chips in its 

MacBook or MacBook Air models, which 

are less demanding than desktop Macs.

By running Macs on its own chips, 

Apple would be the only major computer 

maker to do so. Its rivals, such as Lenovo, 

Dell and Asus, use Intel chips or those of 

its competitor AMD.

When the news of Apple’s potential 

chip switch was first reported, Intel’s 

shares dropped by as much as 9.2%, its 

biggest drop in two years. Still, given the 

early stage of the plan’s development, 

Apple could still change its mind and 

sideline the project.

Intel declined to 

comment on the story, 

stating: “We don’t comment 

on speculation about our 

customers.” Apple has also 

declined to comment.

 macformat.com  @macformat

Apple hires 
former Google 
AI executive

> In the nascent battle for the 

smart home, Siri has come 

under some heavy scrutiny. 

That could be why Apple has 

recently hired Google’s former 

artificial intelligence (AI) chief 

John Giannandrea.

Giannandrea joined Google 

in 2010 when it purchased 

Metaweb, where he was Chief 

Technology Officer. The firm 

wanted to build a “database of 

the world’s knowledge”, which 

has been developed as part 

of Google’s ability to answer 

questions posed by its users.

He joins Apple to run 

its ‘machine learning and AI 

strategy’, including Siri. In an 

email to Apple employees, 

Cook said “John shares our 

commitment to privacy and our 

thoughtful approach as we 

make computers even 

smarter and 

more personal.”

Giannandrea’s move 
will hopefully result 
in a boost to Siri.

The Mac App Store 
is soon to require 
64-bit support for 

future app updates.
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W
ith almost every 

smartphone now 

looking like an 

iPhone, Apple needs to 

differentiate its hardware. 

According to Bloomberg, the 

company plans to do that with 

a curved, gesture-controlled 

iPhone in the future.

The report states that the 

gesture controls would allow 

you to move a finger close to 

the screen (without actually 

touching it) and still be able to 

perform some tasks. However, 

it says that the technology will 

not be ready for at least two 

more years.

As for the curved screen, 

it would gradually curve 

inwards from top to bottom. 

Samsung has released its own 

curved phones, although they 

curve down at the edges.

In order to implement this, 

Apple would use OLED-based 

displays, which can be curved 

in ways which LCD tech can’t. 

The iPhone X is so far the only 

iPhone with an OLED screen.

Bloomberg also reported 

that Apple is working on an 

iPhone that incorporates new 

screen technology known as 

MicroLED, but that this is at 

least three to five years away.

Of course, Apple may 

eventually choose not to use 

this tech – watch this space.

Curved, gesture-controlled iPhones
Apple reportedly working on radical screen tech for the future

W
hen it revealed it was working 

on a new Mac Pro, Apple said 

the computer would not arrive 

in 2017. Now we have a more firm date: 

Apple says it will launch in 2019.

In an interview with Matthew Panzarino 

of TechCrunch, Tom Boger, Apple’s Senior 

Director of Mac Hardware Marketing, said 

“We want to be transparent… with our pro 

community so we want them to know that 

the Mac Pro is a 2019 product.”

Apple has set up a Pro Workflow Team, 

which works with professionals in various 

industries in order to understand what they 

need from the Mac Pro. These users go about 

Apple is designing its powerful computer as a ‘workflow-led’ system Apple has a reputation 

for secrecy, something 

it is keen to uphold 

according to an internal 

memo. The note said 

Apple found 29 leakers 

last year, 12 of whom 

were arrested. It added 

that leakers can lose 

their jobs and “face 

extreme difficulty 

finding employment 

elsewhere.” This stern 

approach is often 

mirrored by other 

Silicon Valley firms.

 Developers working on 

Apple Watch have long 

been restricted from 

creating their own 

watch faces, but that 

might soon change. 

Code from watchOS 

4.3.1 appears to contain 

references to some 

future capability to 

add third-party faces. 

The code, spotted by 

9to5Mac, is not yet 

implemented but could 

come into action as 

soon as watchOS 5 – 

assuming the idea isn’t 

dropped before then.

their work using a Mac Pro, then tell Apple 

where they hit bottlenecks.

Boger confirmed that the next Mac Pro is 

still set to be a modular platform. That might 

not mean the ability to add internal graphics 

cards, though – Panzarino says the vision of 

modularity he saw during the interview was 

of iPad Pros hooked up to an iMac as control 

devices, or of MacBooks running external 

graphics cards. Of course, we still don’t know 

what form this modularity will end up taking.

Finally, John Ternus, Vice President of 

Hardware Engineering at Apple, also stated 

that the workflow-led approach is relevant 

to every computer Apple makes.

APPLE 

NEWS 

ROUNDUP

FIRM SAYS IT 

FOUND 29 

LEAKERS IN 2017

THIRD-PARTY 

WATCH FACES

WATCHOS CODE 

COULD ALLOW 

CUSTOM FACES

Mac Pro to launch in 2019



Apps & games APPLE CORE

Ovivo  
£1.99

 Guide Ovo through 

its monochromatic 

world, switching its 

colour to fall through from 

one area to the other. Gravity 

pulls down in the light, pushes 

up in the dark, and Ovo’s 

momentum carries across the 

colour boundary, enabling it 

to explore new mysteries.

Why you need it: Simple but 

increasingly intriguing visuals.

What’s it best for: Mechanics 

that play with your mind.

Textlicious 
£1.99

 If you’ve seen 

unusual text styles 

on social media or 

in messaging apps – such as 

letters enclosed in circles, 

a script font, or double-struck 

through – but don’t know how 

to recreate the effects, this 

tool for Mac, iPhone and iPad 

offers a simple way to do it.

Why you need it: Enables you 

to use funky text styles.

What’s it best for: Access in 

Services menu/Share sheet.

 After a long hiatus, 

Arctic Monkeys’ first 

album in five years 

goes on sale just a few days 

after this issue! The band 

teased the release at the start 

of April, with an intriguing 

animation featuring the 

album’s artwork, which you 

can watch at bit.ly/amtranq. 

Why you need it: Come on, 

Arctic Monkeys are huge!

What’s it best for: Inventive 

and cool British rock.

 Here’s an augmented reality 

(AR) app that’s educational 

and a whole lot of fun. The 

National Portrait Gallery has 

turned its Tudor collection of fine artworks 

into a digital exhibition for you to explore in 

the comfort of your own home.

The app uses Apple’s ARKit 1.5 technology, 

introduced in iOS 11.3, which is able to detect 

and place objects on vertical surfaces, rather 

[ M O V I E ]

Three Billboards… 
£9.99

 A Missourian mother 

seeks justice for her 

murdered daughter. 

Frances McDormand 

won an Oscar for this 

darkly comedic drama.

[ P O D C A S T ]

Plumbing the 
Death Star  
FREE

 Do Transformers tire? 

Why does Donkey Kong 

wear a tie? Laugh along 

with this overanalysis 

of popular culture.

[ T V  S H O W ]

Gotham (Season 4)
£19.99

 While DC films fail to 

satisfy, this reimagining 

of the origins of Batman 

and his foes is enjoyably 

trashy. It largely works 

due to great casting.

than just horizontal ones. This enables you to 

see what artworks would look like in your own 

home, and you can move in for a closer look at 

the details. The visuals are accompanied by 

narration and period music. 

Although AR doesn’t (yet) allow you to 

reach out and touch the art, at least you won’t 

get barred from a gallery for trying. And you 

don’t have to trek all the way to (or across) 

London and deal with the crowds to enjoy it! 

Tranquility Base…  
Arctic Monkeys £8.99
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APPLE 
TV
 Our top picks 

of what’s worth 
watching and 
playing this month

[ i O S  G A M E ] [ i T U N E S  S T O R E ][ M A C  &  i O S  A P P ]

Augment your home furnishings with Tudor reality

APP OF THE MONTH

Boulevard AR £2.99
[ i O S  A P P ]



APPLE CORE Facts & figures

 macformat.com  @macformat

$100 million 

£50,000,000
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Entrepreneur, inventor, designer. Having 
built his wealth co-founding Apple, what 
did Jobs spend his fortune on?

IN NUMBERS
STEVE JOBS

> Steve Jobs didn’t have just any yacht – he had a super 
yacht. The boat, christened Venus, was only finished 
after his death, at a cost of over $100 million.

> During his lifetime, Jobs was criticised for not giving 
to charity. In reality, he was a prolific philanthropist – 
albeit in private – for example, donating $50 million 
to Stanford hospitals.

> Back in 1986, Pixar had just been 
spun out from Lucasfilm and was 
seeking funding. Jobs invested $10 
million into the company, joining 
the board of directors as chairman.

> How’s this for a perk? Steve Jobs once bought 
a Bösendorfer piano, costing around $80,000, for 
Apple employees to tinkle on during development time.

1

> Steve Jobs bought the famous 
Jackling House in Woodside, 
California in 1984. He abandoned 
the mansion in 2000, leaving it 
empty for 11 years before finally 
demolishing it in 2011.

11 Years

$ $7 85 0, ,_0 00 00 0

> Aside from the Jackling House, 
Jobs had a 5,768-square-foot 
house in Palo Alto, which he 
used as his main residence and 
where he passed away in 2011.

5,768ft2

$10  
million

3

2

5

4

6
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WRITTEN BY ALEX BLAKE 

W
hen the latest round of iPhones 

debuted with wireless charging, 

it felt somewhat overdue. After all, 

wireless charging has exploded in 

recent years, and is almost old news now. The 

global wireless charging market has expanded 

from $1.87 billion in 2014 and is expected to reach 

$22.25 billion by 2022. Apple’s rivals have seen its 

potential and have been equipping their phones 

with wireless charging capabilities for a couple 

of years. In contrast, Apple feels late to the party.

Still, you can see why Apple waited – wireless 

charging has its drawbacks. It’s fiddly as you need 

to line your iPhone up correctly on the charging 

mat. It’s expensive, requiring a compatible iPhone 

and a charging mat, which will set you back more 

than a simple cable will. And not every wireless 

charger will work if your iPhone is clad in a case. 

It’s also slower – you can fast charge an iPhone X 

with a Lightning cable, which gives it up to 50% 

charge in 30 minutes, but you can’t get the same 

speedy charging if you do it wirelessly. 

With all these potential tripping hazards, it’s 

no wonder Apple didn’t jump on wireless charging 

as fast as some of its rivals did. Apple wants your 

wireless charging experience to be as good as 

possible – much better to let its rivals experiment 

while the tech is young, then appear on stage once 

the wrinkles have been ironed out.

Yet there’s no doubt that wireless iPhone 

charging is in Apple’s short-term plans. But what 

lies beyond in the sphere of wireless power? And 

what are other companies working on that could 

determine how you charge up your phone in the 

not-so-distant future?

Power play
On a basic level, the power level of chargers is 

increasing. Some of the original wireless chargers 

for iPhone supplied 5W of power, but CES 2018 

saw the appearance of 15W chargers. Over time, 

this figure is likely to increase, leading to chargers 

that are able to power up your device in less time – 

in theory, at least. That’s because iOS puts a limit 

on the maximum power draw of your iPhone, 

currently at 7.5W for wireless connections; 

iOS 11.2 upped the wireless power limit from 5W 

to 7.5W, so it’s feasible that Apple will continue 

to increase this limit. Hopefully, this will mean 

that you’re eventually able to fast-charge your 

iPhone simply by using a wireless charger.

Apple is at least exploring the possibility 

The future of 
wireless charging
With its own AirPower mat on the way, Apple is 
exploring wireless charging. So what’s the next step?
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The glass-backed iPhone 
8, 8 Plus and X can all be 
charged wirelessly with 
a Qi-certified charger.
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of an improved wireless charger, according 

to two patents published in December 2017.

The first detailed a system that could 

create custom schedules to let a charger send 

power to various different devices, including 

phones, laptops, tablets and watches. The 

proposed system could be used to set up 

complex priority rules, and would remember 

the priority order in the future. For example, 

you could set it to charge your iPhone first, 

but only if your iPad has at least 25% battery 

power. Or you could dictate that your iPhone 

takes charging priority in the evening, but 

only if your calendar shows that you will be 

out of the office the next morning, thereby 

allowing you to have enough charge to use 

your phone while away from a power socket.

The second patent described a wireless 

charging device that could act as a standalone 

adaptor or send power to a charging mat. 

It could also potentially be embedded inside 

furniture or a vehicle interior, and from there 

charge a ‘wireless power receiving device’.

Added into the mix is Apple’s acquisition 

in late 2017 of PowerbyProxi, a company that 

is working on high-power wireless charging 

devices. One such product, the Proxi-Module 

100W, can (as the name suggests) supply up 

to 100W of power wirelessly to compatible 

devices. MacBooks can currently be charged 

by adaptors that supply up to a maximum of 

87W; integrating the tech from PowerbyProxi 

into its future products could allow Apple 

to develop a charger that is not only more 

powerful than its current wired offerings, but 

that can also charge your MacBook wirelessly.

Interestingly, the Proxi-Module 100W 

allows you to charge your devices “through 

any non-electrically conducting medium”, 

including solids, liquids and air. If Apple 

builds that into its future chargers, we could 

see it release a ‘true’ wireless charger that you 

can use without the need to place your device 

on a mat; it would charge simply by being in 

the vicinity of the charger. But in that effort, 

Apple and its new acquisition are not alone.

WattUp, doc?
Apple is reported to have been working with 

companies other than PowerbyProxi when it 

comes to wireless charging. Of particular note 

is Energous, the developer of a true wireless 

charging system called WattUp that aims to 

power up your devices from up to 15 feet away 

(though it’s yet to go on sale). In 2016, prolific 

WattUp is 

the type of 

system we’d 

expect to see 

integrated into 

Apple devices

It may sound odd, but there has 

been a lot of work on developing 

wireless charging for cars. The 

idea is that the electric cars of 

the future will need an easy way 

to charge. For instance, chargers 

could be embedded in your garage, 

allowing you to top up your car 

without having to leave the house.

WiTricity, the company that 

worked with Dell on the Latitude 

7285, has been active in this area; 

with 245 wireless patents to its 

name, it licenses its know-how 

to carmakers, which build wireless 

charging into their vehicles.

Furthermore, a research team 

from Stanford University has 

developed a system that allows 

power to be wirelessly transferred 

to a moving object, perhaps one 

day allowing you to charge your 

car as you drive.

Not only would that be far 

more convenient than having to 

stop and charge your vehicle, but 

it would help to lower its cost and 

increase its range as well.

Driving innovation >

Apple’s AirPower mat will be 
able to charge your iPhone, 
Watch and AirPods (using a 

new case) all at once.



The future of wireless charging APPLE CORE

JUNE 2018 | MACFORMAT | 17

tech leaker Evan Blass spotted a note in 

Energous’s investor prospectus claiming 

that the firm expected its wireless charger 

to undergo Apple compliance testing in the 

future. This came after Energous publicly 

acknowledged that it was working with 

“one of the top five consumer electronics 

companies”, which could be Apple. This set 

off a whirlwind of speculation that Apple was 

actively working on a unit that could charge 

your devices from a distance through the air.

However, Energous’s PR firm replied to 

the allegations, stating that the expectation 

of Apple compliance testing “blankets any 

future anticipated testing and is not indicative 

of specific partners.” Even if Apple is not 

working with Energous, WattUp is the type 

of system we’d expect to see integrated into 

Apple devices sooner or later – we very much 

doubt AirPower represents the height of 

Apple’s ambitions in this field.

Energous isn’t the only company that’s 

working on true wireless charging devices. 

While Apple uses the Qi standard for its 

wireless chargers, a company named Pi is 

selling its own charger (also called Pi) that 

can replenish your phone from a foot away. 

You’ll need a compatible Pi case if your 

iPhone does not come with built-in wireless 

charging capability; if it does, you don’t need 

anything extra. The company claims you can 

charge up to four phones at once using the 

device, as long as they’re all within about 12 

inches of the Pi. Lixin Shi, co-founder of Pi, 

states that the charger’s maximum power 

output is 20W at the moment, but that this 

limit could be increased in the future. 

Pi might eventually even be able to 

charge laptops.

In that respect, however, Pi has 

been beaten to the punch by Dell. 

Last year, the company released the 

Latitude 7285, the first laptop that could be 

charged wirelessly. It’s a 2-in-1 laptop/tablet 

device, so you need the special wireless 

charging keyboard and the wireless charging 

mat to get this benefit. But once that’s all in 

place, you can charge the laptop simply by 

placing it on the mat. It does not have to be 

aligned perfectly in order to charge, either.

Elsewhere, a team at California’s Stanford 

University recently published research on 

‘robust wireless power transfer using a 

nonlinear parity-time-symmetric circuit’. 

In layman’s terms, that means the team has 

developed a wireless charging system that 

can adjust its power output depending on the 

situation. For example, if you move the device 

being charged further away from the charger, 

its power output will be increased to make 

up for the extra distance.

Don’t get too excited about super-long-

range wireless charging yet, though; Tank 

Huang, the founder of charging company 

SmartPower, says there are drawbacks. 

Specifically, the wattage required for long-

range charging could result in it interfering 

with Wi-Fi and Bluetooth connections 

(think of it like a microwave with its door 

open, suggests Huang). Overcoming that 

hitch will be a key task for the future 

of long-range wireless charging.

A wireless future
There is clearly a lot of work going 

into improving the capabilities of 

wireless charging, and no doubt Apple 

is developing the next step after AirPower 

right now (and perhaps the step after that).

Developing wireless charging past its 

current state won’t be easy, not least because 

of the potential clashes with wireless data 

standards, but Apple is forging full steam 

ahead. The company has always chosen to 

go with wireless in the past, as the removal 

of innumerable Ethernet ports, headphone 

jacks and CD drives from its products attests.

As well as that, there are plenty of other 

companies heading in the same direction. 

Apple is prone to snapping up companies that 

develop tech it’s interested in, and has already 

done so with at least one wireless charging 

company in the form of PowerbyProxi. If it’s 

looking to improve its own products with the 

technology developed by one of these firms, 

it has a lot to choose from.
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AirPower >

Last year, 

Dell released 

the first laptop 

that could 

be charged 

wirelessly

By making it available in all of 

its latest phones, it’s clear that 

Apple is committed to wireless 

charging. During the iPhone X 

launch event, it teased AirPower, 

its wireless charging mat that 

can power up to three compatible 

devices at a time. You don’t need 

to worry about placing your devices 

in a certain position or orientation 

on the mat either; AirPower will 

charge them up no matter where 

you place them on the mat.

It’s based on the popular Qi 

charging standard, with a couple of 

software tweaks that allow you to 

monitor on your iPhone the power 

levels of all devices as they charge.

The use of Qi means you can 

charge a compatible iPhone 

anywhere you find a Qi charger,  

such as certain hotel chains.

There are plenty of companies 
developing wireless charging 

tech, so we can hopefully 
look forward to long-range 

charging in the future. 
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Hopes for Apple in 2018
In your newsletter, you asked what we hope 

Apple will do this year. Are you granting me 

three Apple wishes? Lovely! Wish 1: that it 

moves the iPhone’s on/off button to the top 

edge instead of the side – where I inevitably 

press a volume control while awkwardly trying 

to turn it off or take a screenshot.

Wish 2: that it stops bringing out yearly 

system updates, and only releases when 

something sound and secure is ready.

Wish 3: for intentional support to continue 

for Photoshop CS5 so I can update to the 

latest macOS. We can’t all afford subscription 

services! (I have no wishes for MacFormat. 

It’s perfect already.)

B Y  E L E A N O R  P A T R I C K

PAUL SAYS… You wouldn’t believe how many 

times we’ve heard Alan curse when he picks 

up his iPhone X and takes a screenshot by 

accidentally pressing buttons on both sides! 

We can’t see this changing, though, since the 

side button is used even more extensively on 

Apple’s current top-of-the-line smartphone.

We’re hoping to learn about reported 

changes to Apple’s development process at 

WWDC in June. It’ll be interesting to see how 

far it allows features to be held back. We also 

hope it’ll disclose more about the (non-)future 

of 32-bit apps on the Mac; we’ll be returning 

to this topic to cover your options for keeping 

old apps running on macOS 10.14.

Finally, thank you very much for your kind 

words about the magazine.

It’s too easy to accidentally press a volume control and 
the side power button when picking up an iPhone X, 
leading to unintentional screenshots. 
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What’s up with Apple?
Matt Bolton’s commentary on Apple’s 

admission that it got it wrong when 

designing the Mac Pro set me thinking 

about the increasing number of design 

errors from the company.

The idiotic placement of the Lightning 

charging socket on the underside of the 

Magic Mouse has been well publicised. What 

about the thin white rubber feet on the Magic Keyboard, which is so flimsy 

that mine sagged in the middle and scraped on my desk – which I’ve solved 

with four slightly deeper self-adhesive feet, plus an extra in the middle. 

Then there’s the Apple Pencil’s Lightning connector, which precariously 

plugs in to the iPad. Yes, you get an adapter so you can charge from a 

Lightning cable, but that’s so tiny that I’ve yet to find a safe spot to keep it.

Last week, when I turned on my iPad, a message told me the Pencil’s 

battery was down to 2% and needed recharging. I still haven’t found 

anything in iOS to monitor its charge. It also seems there’s no facility in 

macOS for monitoring the charge levels of the Magic accessories. Nor is 

there any help from Apple to indicate how long these relatively expensive 

add-ons need to be connected to reach full charge.

Of course, the trackpad and keyboard can be kept connected and 

used while recharging. But when the mouse or the Pencil run out of juice, 

there’s no option but to take a ‘time-out’ 

of indeterminate length.

Individually these problems may seem 

trivial, but collectively they signal that Apple 

is losing sight of its ‘It Just Works’ mantra. 

B Y  D I G B Y  H A R P E R

ALAN SAYS… Magic Mouse’s charging 

situation is disappointing; even if the 

mouse is functional when its battery is 

past its best, it’ll have to be laid to rest. 

(That said, I find cabled mice horrid to use.) 

You can check Apple Pencil’s charge in 

the Today view; tap Edit at the bottom of 

that view, then add the Batteries widget. 

On a Mac, monitor wireless accessories’ 

charge from the Bluetooth menu bar icon. 

Add it in System Prefs > Bluetooth, then 

click the menu bar icon and put the pointer 

over an accessory’s name. However, I find 

the reliability of its early warning that the 

level is low to be variable.
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More hopes for Apple in 2018
 I’m hoping Apple updates the Mac mini. At the moment, it’s 

the only reasonably priced Mac that allows me to use my own 

monitor. That is of huge importance to me, because of where 

I sit and the height I need to work. I can’t use my husband’s 

iMac as the screen height isn’t adjustable. (How hard could 

that be to engineer? Ach, never mind.)

I produce a lot of creative writing, and back up manually 

on hard disks and flash drives. I don’t use the cloud for this, 

because I don’t trust it not to fail; there are lots of horror 

stories about people whose work vanished there. Time 

Machine has already failed me twice, so I no longer use it 

either. Simple flash drive storage for daily changes and a few 

hard disks for occasional full backups (and a clone of my 

system) work fine for me, and I want to continue to use them.

I would want a new mini to support things like flash drives 

and other media, as it does now. In other words, I want it to 

have plenty of ports. Including one for my printer, one for my 

monitor and several more, whatever the latest ones are.

I hope, in all the striving to produce the next big thing, 

that Apple realises we’re not all panting for that thing. We are 

happy to upgrade as required, but not if we lose the elements 

that make the Mac work for us. If it takes away important 

elements, such as the ability to save our work locally, 

it risks losing our custom. 

B Y  J A N  F O L E Y

JO SAYS… I don’t think Apple will lock us in to cloud-based 

storage. However, I am also concerned that it might reduce 

the number of ports on the Mac mini. The iMac didn’t lose 

out when USB-C was added to it, but the mini is a different 

proposition; ultimately, the fate of its ports might depend 

on whether the Mac mini becomes more of a Mac micro.

The current mini’s design has a 
plethora of ports: two Thunderbolt 2, 
four USB-A, HDMI, Gigabit Ethernet, discrete 
audio in and out, and an SD card reader.

Have Your Say
We want to hear your opinion on what we’re 
covering in MacFormat and how well we’re 

addressing your needs as an Apple fan.

bit.ly/mfsurvey2018
Take part in our reader survey at 

The closing date of this survey is Friday 15 June, 2018

Time is running out!

HomePod and Android
Your article ‘Is HomePod too late?’ (MacFormat 

#324) featured some interesting discussion on 

the pros and cons of Apple’s speaker, and its 

development and marketing strategy. I want to 

point out that it’s not entirely true, as Alex said,  

that AirPlay is “exclusive to Apple devices” and 

“won’t work with Android phones”.

HTC Android phones are one exception, 

having featured built-in AirPlay streaming for 

a while. That was a very welcome development 

as my wife is a big HTC fan, but we have my 

AirPlay speakers all around the house. She can 

now stream music from any source, including 

Apple Music, to all of them from her HTC U11.

This shows how Apple is actually open to 

third parties licensing and employing AirPlay, 

should they choose to do so. The problem may 

lie with those companies. If HomePod catches 

on, I hope more will follow HTC’s lead and bring 

the benefits of AirPlay to Android users.

B Y  T O M  R O G E R S

ALEX SAYS… Please accept our apology 

for overlooking HTC’s licensing agreement. 

Indeed, things are looking up for Apple 

licensing tech, what with it also relaxing the 

approval of HomeKit accessories. I, too, hope 

it can secure new partners with AirPlay 2. 

Right now, though, we’re still waiting for that 

on HomePod, never mind third-party kit.



MATT BOLTON…

When Tim Cook, and others at Apple, say they care about 

social issues, I believe them. I don’t think it’s just typical 

Silicon Valley PR, but I can understand why other people 

would. For a start, we’ve all had a good laugh (cry) at the 

hollowness of something like Google’s ‘Don’t be evil’ mantra. 

Second, we know that manufacturing electronics has a 

shadow cast over it by the use of conflict minerals, regardless 

of how well intentioned companies are. And third – the thing 

that vexes me most – surely 

a company that reportedly has 

over a quarter of a trillion dollars 

in cash should really be making 

more of an impact on these issues.

I found myself thinking about 

these doubts after Apple’s recent 

education event. The company’s 

announcements – grants to equip 

some poor schools with iPads, free coding training for teachers 

in some areas, and improvements and new apps focused on 

education – are wonderful for the people they reach, but it’s 

a narrow impact. A new low-cost iPad that supports a cheaper 

version of the Apple Pencil is great 

on its own merits, but is it really going 

to beat out cheaper Chromebooks in 

schools given the horrifyingly tight 

budget limits they have? Schools can 

buy iPads at a slightly lower price, 

but not really cheap enough – it still 

feels like these iPads will be the 

preserve of the already-cared-for, 

while the kids who would most 

benefit from having these tools will 

be largely left as they are.

I’d love to know the internal 

politics behind these decisions, 

because Apple’s new announcements 

leave things in a strange halfway 

house. Education iCloud accounts 

now get 200GB of storage, instead of 

5GB! But isn’t that move an implicit 

confession that the 5GB the rest of 

us get isn’t enough? Similarly, the 

cheaper Logitech Crayon  

stylus isn’t being sold 

beyond special education 

APPLE CORE Opinion

The new iPad is a wonderful computer for kids to learn on 
and play with, but will its benefits actually reach the kids 
who would be helped by it the most?
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ABOUT MATT BOLTON

 Matt is the editor of Future’s flagship

technology magazine T3 and has been

charting changes at Apple since his

student days. He’s sceptical of tech

industry hyperbole, but still gets warm

and fuzzy on hearing “one more thing”.

Schools get Apple 
kit a little cheaper, 
but not really 
cheap enough

WONDERS IF APPLE’S SOCIALLY 
CONSCIOUS AND BUSINESS SIDES 
ARE TRIPPING OVER EACH OTHER 
WHEN IT COMES TO SCHOOLS

stores – it’s just for schools. Surely lots of 

businesses and kids would benefit from one? 

It has this nasty smell of Apple thinking it 

isn’t good enough to sell outright… in which 

case, why is it good enough to sell to schools?

It means the end result feels like a limp 

gesture: ‘Here, have a few quid off, while our 

pile of money grows large enough to show up 

on a map of the Earth.’ I’d like to see Apple 

sell the new iPad and Apple Pencil to schools 

at (or even below) cost. That would knock up 

to $100 off the iPad’s price, making it highly 

competitive with Chromebooks. This isn’t 

even a bad business decision – if it tempts more 

schools to go with iPads, that’s an investment 

in people wanting more Apple products in 

the future. I know business interests make 

doing this kind of thing tough, but I believe 

people at Apple want to make the world 

a better place. Apple is their tool to do that, 

but I hope it isn’t also the obstacle.

Apple makes great specialist tools 
for teachers and kids, including 
individual user accounts on iPad.
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“Before the 
industry knew it, 
we were blowing 

people away [with 
the tech].”

Apple exec says the 

gaming capability of iOS 

has surprised people

PHIL SCHILLER

apple.com

“We want them 
to understand 

the importance 
they have for us… 
[and] that we’re 

investing in 
new Macs.”

Marketing chief says 

Apple is working hard 

to satisfy its pro users
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“The only way to 
protect your data is 
to encrypt it. There 

is no other way 
known today.”
Apple CEO is forceful 

on the benefits of 

encryption to privacy

apple.com

“The people that 
make technology 

have to make it 
for good.”

Apple software exec says 

technology “in and of itself 

is not for good”

EDDY CUE

 The MacFormat team debates the hot Apple  
issues of the day, using their iPhones of course!

SPLIT VIEW

“WHAT D’YOU THINK ABOUT EXTERNAL 

GRAPHICS CARDS ON THE MAC?”Alex says…

Alan says…

Have you seen that Apple at last introduced 

external graphics card (eGPU) support with 

the macOS 10.13.4 update?.

That bodes well. In the past, if you’re serious 

about games         you’ve really had to go down 

the PC route to keep up with demands. That 

might not be the case going forward.

True – the cost means this isn’t an option 

for everyone. You’ll also be limited to AMD 

cards – Apple doesn’t support Nvidia’s yet.

So it sounds like it’s going to be a very niche 

thing – at least for a while. Still, it’s nice to 

have this option at long last!

Speaking of cases, they work out pretty 

expensive on top of whatever card you pick – 

about £320           – but the total might be 

less than buying a brand-new Mac.

Also, you’ll only benefit from an eGPU in apps 

that use the Metal 2, OpenCL and OpenGL 

technologies, such as Final Cut Pro X.

Indeed! I’m excited to see how eGPU support 

might fit into Apple’s plans for the modular 

Mac Pro. I guess we’ll find out next year.

Yes, it opens up some intriguing possibilities 

for upgrading your Mac – as long as you have 

one with Thunderbolt 3.

 macformat.com  @macformat JUNE 2018 | MACFORMAT | 21

Siri, who let the dogs out?

Due to unforeseen circumstances, 

that witticism has been retired.

Siri...ously? tap to edit
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 To enter, you can visit our website at bitly.com/Philipsduo (web address is case sensitive).

  For full terms and conditions, go to bitly.com/Philipsduo. By sending your entry, you 

agree to these competition rules and confirm you’re happy to receive details of future 

offers and promotions from Future Publishing Limited and carefully selected third parties. 

 This competition closes on 4 June 2018. Over 18, GB residents only.

HOW TO
ENTER…

 If you want a brilliant high-quality 

display with some well thought-out 

extras, you’re in luck. That’s because 

in this issue you can win one of two 

superb displays from Philips.

The 32-inch Philips 328P6AUBREB 

received five stars and an Editor’s Choice 

award when we reviewed it last issue, 

making it one of the best displays 

we’ve reviewed in recent years.

For one thing, we loved its amazing 

10-bit display. It covers 99% of the 

Adobe RGB gamut, so it’s ideal if you 

need a screen for colour-accurate work.

It’s a big display, sitting pretty at 32 

inches diagonally, and it has a resolution 

of 2560x1440 pixels. That gives you 

plenty of space to have multiple windows 

side by side with room to spare.

But this display’s benefits aren‘t all 

in the panel. It’s equipped with a USB-C 

port and two USB-A ports, so you’ll 

have a great data hub for your devices. 

Not only that, but due to the USB-C, 

DisplayPort 1.2 and HDMI 2.0 ports, 

it’s a cinch to connect the screen to 

whatever Mac you have.

Even if you don’t need the great 

colour accuracy, this is still a fantastic 

monitor that comes with our seal of 

approval – don’t miss your chance 

to win one in our giveaway!

> THE QUESTION
We’ve got two Philips 328P6AUBREB 

Mac displays to give away. For your 

chance to win, answer this question:

How many USB-A ports 
does this display have?
A) 1

B) 2

C) 3

For more information about the 

Philips 328P6AUBREB, plus Philips’ 

full range of displays and other 

products for your Mac, visit the 

company’s website at philips.co.uk.

One of two 
incredible 
Mac displays 
from Philips!

£800

PRIZES 
WORTH
OVER

Boost your Mac use with a  
colour-accurate Philips display!
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T
hese days, your 

network is put to 

much greater use 

than simply getting 

your Mac online to browse the 

web and check email. Inevitably, 

that means enduring a lot more 

disruption if something goes wrong 

with it – no more Netflix, tunes 

won’t stream from Apple Music or 

Spotify, and you may be unable to 

access files on your networked 

storage until the problem is fixed.

But, how do you go about 

identifying the root cause of the 

problem, which could originate 

anywhere from your internet 

service provider to the location 

within your home that you’ve 

chosen to use your Mac, iPhone, 

iPad, Apple TV or some other kit?

Here you’ll learn about 

diagnosing network interference, 

kit that can boost your network, 

ways to improve security, new 

things to do with your network, 

and more. Even if your network’s 

running well right now, networking 

niggles can suddenly sneak up 

on you, so hold on to this guide 

to keep yourself connected.
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Troubleshoot your current setup
Problems getting on to the internet 
or your own network? Start here

our network can be neatly 

divided into two zones: inside 

and outside. The outside refers 

to the wider internet, delivered to your 

home through your phone or cable 

connection, while the inside is where 

all your networked devices reside – 

whether they’re connected using Wi-Fi 

or Ethernet cabling. Bridging the two 

is your modem-router, which does the 

hard work of managing the connections 

between devices, both inside the local 

network as well as with the outside world.

When it comes to troubleshooting 

your network connection, therefore, 

you have three major points where 

problems tend to occur: your Mac or 

some other device, your router, or 

your internet connection.

 

The simple stuff
Begin by restarting your router or 

powering it off for a minute or so – this 

often clears up most problems, just like 

restarting your Mac can occasionally fix 

glitches. Speaking of which, restart that 

at the same time. Don’t take this as a 

reason to regularly power off your router, 

mind – it should normally be left on 24/7.

That will clear up some glitches, but 

not all. The guide opposite reveals how to 

use macOS’s own networking tools to try 

to determine the problem and implement 

a solution – as they tend to focus on your 

Mac, check whether your other devices 

are suffering a similar problem before 

focusing attention on your computer.

If the problem appears to affect all 

your devices, then the next port of call 

is your router. If devices can see and 

connect with each other, but not the 

internet, then the issue may lie with a 

problem outside your home (and direct 

control). The second step-by-step guide 

opposite reveals how to go about trying 

to rectify this problem – if you don’t have 

the means to connect to the internet 

another way – for example, using a 

hotspot feature on your mobile phone – 

it’s worth checking with neighbours to 

see if their broadband connection is 

down and, if not, if they’ll let you connect 

temporarily to continue troubleshooting.

FEATURE Home network guide

Worried your internet connection isn’t 

delivering the performance you expect? 

First, install SpeedTest from the App 

Store (it’s available for Mac, iOS and 

tvOS) to run a pair of tests that will give 

your connection’s upload and download 

speeds. It’s worth trying this at different 

times of day to see if performance 

changes – for example, when more 

households are connected in the evening.

You can check your current local 

network speed by opening Network Utility 

(type its name in Spotlight) and switching 

to its Info tab. Select ‘Ethernet (en0)’ for 

your wired connection – the link speed 

should be 1Gbit/s; if not, check the cables 

and verify your router supports a fast 

Gigabit Ethernet connection. Select ‘Wi-Fi 

(en1)’ to check your wireless connection. 

Here, a strong signal should deliver at 

least 200Mbps for a 2.4GHz network, 

and 350Mbps for a 5GHz connection.

For real-world benchmark results, 

try the free HELIOS LanTest tool (bit.ly/

heliostest) – you’ll need the username and 

password shown on that page to get it, 

and to use System Preferences’ Security 

& Privacy to allow the app to be installed.

Check network speed

Speedtest can help you determine the actual speed 
you’re getting from your internet connection.

There are plenty of free Mac tools available to help 
benchmark and troubleshoot your connection.
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1Log in to your router
Point your web browser at your 

router’s IP address (see the TCP/IP tab 

in System Prefs > Network > Advanced). 

Check to see if the status page indicates 

an issue with your internet connection.

3Resolve DNS issues
If your router has a connection but 

pages don’t load, your provider’s DNS 

server, which connects web addresses to 

servers, might be in trouble. Follow bit.ly/

odnsma to see if this free service fixes it.

2Ask your provider
If the connection is down but you 

can get online on your phone, check your 

service provider’s status page for outage 

reports. Its support pages should give its 

required settings, plus contact details.

3Verify IP settings
Go to System Preferences’ Network 

pane. Select your connection type and 

check an IP address has been assigned – 

if set manually, click Advanced, then  

TCP/IP; try setting IPv4 to ‘Using DHCP’.

5 Forget Wi-Fi network
If you use Wi-Fi, click Advanced, then 

the Wi-Fi tab, select your misbehaving 

network in the list and click – (minus) to 

remove it. Click OK, Apply, then the Wi-Fi 

menu bar icon and connect from scratch.

4Renew the lease
Try renewing the lease of the IP 

address given by your router. If the issue 

persists, pick ‘Using DHCP with manual 

address’; enter an unused one, leave the 

mask as is, and verify the router address.

1Check for Wi-Fi problems
Hold å, click the Wi-Fi menu bar icon 

and choose Open Wireless Diagnostics. 

Click Continue to let this tool run a series 

of tests, then click each result for a 

detailed description of what it has found.

 HOW TO Troubleshoot router problems 

2Run connectivity tests
Use Spotlight (ç+[spacebar]) to 

open Network Utility. In the app’s Ping 

tab, type your router’s IP address in the 

box and click Ping. If the packets are all 

received, the issue isn’t with your Mac.

Diagnose connection issues
A quick-fire guide to 
network troubleshooting

Home network guide FEATURE 

he first place to check your 

Mac’s connection is System 

Preferences’ Network pane. 

Select Ethernet or Wi-Fi, depending on 

which one you use. If the circle next to 

it is red (no connection) or yellow (not 

configured), the pane should provide 

info on the problem, such as a missing 

IP address (the set of four numbers 

that uniquely identify a device) or lack 

of an internet connection. If that’s not 

enough to identify the issue, read on.
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Range extender
This relays your Wi-Fi signal 

to a dead spot in your home. 

Prices start from around £15 for 

an 802.11n model that supports 

a transmission rate of 300Mbps, 

or save a little money by reusing 

an old router in bridge mode.

Bring your network bang up to date 
to boost its speed or range

O
nce upon a time, you plugged 

your Mac in to a modem and that 

was your internet connection 

sorted. These days, your network consists 

of more than just a few computers and 

perhaps a printer; now there are your 

mobile devices, smart TVs, Internet of 

Things (IoT) gadgets and other hardware 

besides to consider. If your network is 

struggling to cope with bandwidth demands 

or the places you need it to reach, now’s 

the time to look for the right upgrade to 

suit your needs and your wallet.

FEATURE Home network guide

Improve your 
infrastructure 

Mesh network
This tech is designed to extend 

Wi-Fi networks through larger 

homes. Asus has even launched 

its own mesh system (asus.com/

uk/AiMesh) that works not just 

with brand new routers but its 

existing models, too.
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Powerline adapters
Extend your network over your 

electrical circuit. You’ll need at 

least two (one goes near your 

router). Choose 1200AV models 

to maximise performance, and 

passthrough models if you need 

to keep the wall socket free. 

Some models feature Wi-Fi, too.

New Wi-Fi router
The 802.11ac wireless standard 

gives you faster wireless 

performance at greater range, 

covering more of your home. 

A new router may have other 

advantages, too – extra features, 

stronger security and so on. 

See what to look for on page 35.

Network switch
Add extra ports to your network 

for cabled devices. Ideally, use a 

switch with Gigabit ports for max 

performance. Managed switches 

have advanced features, such as 

link aggregation for combined 

throughput – useful on Macs that 

have multiple Ethernet ports.
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How your network works
Discover how your networked devices communicate with each other

ow exactly does data travel 

from one part of your network 

to another? The answer lies in 

the TCP/IP model. TCP (Transmission 

Control Protocol) is the method used 

by computers to connect over 

networks, while IP (Internet Protocol) 

is the way in which data is broken 

down into ‘packets’ of information 

and transferred. 

Each packet is labelled in such a 

way as to make it clear where it’s come 

from and what its destination is. When 

data is transferred, the TCP part of 

the process is responsible for ensuring 

the data is checked for errors during 

transmission – if errors are found, 

the data is transferred again.

This model can be broken down 

into four basic layers: Application, 

Transport, Internet and Link – see 

the explanation opposite for a basic 

breakdown of what happens on each 

of those layers.

At the local network level, your 

devices are typically linked and 

managed through a single device – 

your router – in what’s termed a 

Local Area Network (LAN). Devices are 

uniquely identified on your network by 

their IP address, which consists of four 

separate digits, each of which can be 

a number from 0 to 255. The first two 

refer to the network address and are 

almost always 192.168. The last two 

refer to the host address. Of these, 

the first number (the subnet) is shared 

between all networked devices, while 

the final number (host) is what 

uniquely identifies that device on 

the network. For example, your Mac 

might be assigned 192.168.0.2 and 

your iPhone might be 192.168.0.3.

One IP address on your network – 

often 192.168.0.1 or 192.168.0.254 – 

is reserved for your router, and this 

address is known as the ‘gateway’, 

through which all other devices 

communicate. You’ll also see 

a reference to a subnet 

mask, which is usually 

255.255.255.0 and can 

be safely ignored.

By default, 

IP addresses 

are handed out 

automatically by 

your router using 

a feature called  

DHCP (Dynamic Host Configuration 

Protocol), but you can set them 

manually for devices whose IP address 

needs to remain constant, though 

this is unusual in a home setting.

Wireless concerns
Data transferred over wires is generally 

considered secure, but data sent 

wirelessly can be intercepted, which 

is why Wi-Fi networks support various 

forms of encryption, the most secure 

of which is currently WPA-PSK2. 

One way to secure your 

internet connection on 

an insecure wireless 

network is to use 

a Virtual Private 

Network, which 

effectively creates 

an encrypted ‘tunnel’ 

through which data 

is sent and received.

FEATURE Home network guide

Virtual Private Networks (VPNs) work 
by ‘tunnelling’ an encrypted connection 
through an unencrypted network.

If you want to apply a static IP address to your Mac, select your connection method in System Preferences > 
Network, click Advanced, choose ‘Using DHCP with manual address’ and assign one that isn’t already in use.

Enjoying 
what you’ve  
read so far?

Why not subscribe –  
you’ll get a great 

 free gift, too!
p36
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1. Application layer

2. Transport layer (TCP)

3. Internet  
(or Network) layer

4. Link layer

This layer is split into three main 

elements: at the top of this layer is 

the software you’re using to access 

the internet, such as a web browser. 

Next is the ‘presentation’ element, 

where data is translated into a format 

for sending – for example, if it’s to be 

encrypted or compressed. Finally, the 

‘session’ element determines the type 

of connection made – HTTP or HTTPS 

for the web, and SMTP for email, say.

This manages how the data will 

be delivered by converting it into 

‘packets’ for sending, then making 

sure they’re safely delivered and 

reassembled at the other end in the 

correct order. It also works in reverse 

for packets received by your computer.

The lowest layer, also known as the 

network access layer, is where error 

detection and correction take place as 

the data is packaged and transported. 

It’s also where you’ll find the physical 

hardware (typically Ethernet or Wi-Fi) 

that connects your device to your 

network and, ultimately, the internet.

Networking 
terms 
explained

Home network guide FEATURE 

This is the layer that covers how 

the data will be addressed and then 

routed between devices. This means 

determining where the data is to be 

transmitted to on its route between 

your computer and its destination. 

It’s also where the actual delivery of 

data occurs, using IP packet switching, 

as described earlier.

802.11
The protocol for transmitting data 

wirelessly over different frequency 

bands, including 2.4GHz and 5GHz. 

The letter(s) after the number 

indicates a specific standard that 

determines the frequency, speed and 

range. The current standard is 802.11ac.

DHCP (Dynamic Host 
Configuration Protocol)
A network management tool used by 

routers to automatically assign unique 

IP addresses to each device that’s 

connected to a network.

DNS (Domain Name System)
This is a naming system that translates 

user-friendly domain names – such as 

apple.com – into their actual public IP 

address (17.178.96.59 in apple.com’s 

case), making it easier for humans to 

browse the web. A DNS server supplies 

this information, acting as a kind of 

‘telephone book’ for the internet.

IPv4 and IPv6
These are different versions of the 

Internet Protocol (IP) standard for 

routing internet traffic using IP 

addresses. IPv4 remains the most 

common, but IPv6 offers a greater 

pool of addresses and should eventually 

replace it – at least on the internet.

Public IP address
The IP address that identifies a 

website or your own network to the 

internet. Your own public IP address 

is allocated to you by your internet 

service provider. Each device on your 

network is then allocated a private 

IP address by your router.

Noise
The amount of interference affecting 

your device’s Wi-Fi signal due to range 

and other devices. The greater the 

noise, the more likely you’ll encounter 

connection or performance problems.
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Fix congestion issues
These days, many wireless networks 

overlap due to their number and 

extended range, which can cause 

interference that manifests with poor 

performance and connection issues 

at shorter than expected ranges. Add 

in an ever-growing number of devices 

trying to share a single channel and 

you can see how problems can occur.

If you have an 802.11ac router that 

can broadcast on the 2.4GHz and 

5GHz bands, which are divided into 

several narrower channels, try 

moving some devices onto the less 

crowded and congested 5GHz band, 

particularly those close to the router. 

2.4GHz networks also transmit 

over several overlapping channels – 

1 through to 11 in the UK – and moving 

your network to a less crowded one 

can also have a marked impact on 

performance. Use Spotlight to find 

and open Wireless Diagnostics. 

In that tool, choose Window > Scan. 

Use the summary page to see which 

channel is recommended under 

‘Best 2.4GHz’, then use your router’s 

configuration utility to switch it to 

broadcast on this channel.

Wi-Fi 
frequency
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Network issues
Five problems that commonly afflict 
home networks, discussed and solved

ccessing files from PCs 

(running Linux or Windows) 

ought to be straightforward, 

but sometimes the connection doesn’t 

work in one or both directions. If you’re 

struggling to connect your Mac to a PC’s 

shared folder, open System Preferences’ 

Network pane, select your connection, 

click Advanced > WINS, and select your 

Windows PC’s workgroup if necessary.

If your PC doesn’t show up in Finder 

under Shared, press ç+K to open the 

‘Connect to Server’ dialog. Type smb://

pcname or smb://192.168.x.y, 

substituting your PC’s name or IP address 

to see if you can connect to it manually. 

If asked for login details, use those you 

use to sign in to the PC; if it’s a Microsoft 

account, omit the @email.com part.

If it’s just one specific PC you can’t 

connect to, verify it’s sharing at least one 

folder, and whether other computers can 

connect to it without any problems.

If your Mac can connect to one PC but others work 
fine, the problem lies with that specific PC.

FEATURE Home network guide

Fix Apple TV streaming issues

Access shared 
folders on a PC

edia streaming issues can 

be traced to poor network 

performance, often linked to 

a weak Wi-Fi signal. If your Apple TV 

is located in a different room to your 

router, that’s likely to be the problem. 

If the device is connecting using the 

5GHz band, try switching it to the 2.4GHz 

band, which performs better at longer 

ranges. Failing that, either add a range 

extender to boost the signal to where 

your Apple TV is sited or invest in 

powerline adaptors, which allow you to 

connect your devices to your network 

using Ethernet cable, carrying the 

connection between rooms using your 

electrical circuit. Wired connections are 

typically faster and stabler than wireless.

If your router is nearby and you’re 

convinced the signal should be strong 

enough, there may be congestion from 

other Wi-Fi networks – refer to the tip on 

the left to change the channel and fix this.

Your internet connection’s speed will 

also affect streaming from outside your 

local network. 4K video requires a lot of 

bandwidth – Apple recommends 25Mbps; 

with too little, Apple TV may stream as a 

lower quality. However, we’ve found that 

you can force it to use 4K by turning off 

Quick Start in Settings > Apps > iTunes 

Movies and TV Shows.

In AirPort Utility, you can set Apple’s routers 
to broadcast a separate 5GHz network.



Save energy by  
turning off your router
A modem-router is designed to be 

left on 24/7. Switching yours off 

may save a small amount of power, 

but when you switch it back on it 

will take time to renegotiate your 

download and upload speeds. Leave 

it on for fast, stable performance.

Hide your network’s SSID
It’s said disabling the broadcast of 

the SSID (the network’s name) can 

help to secure your network, but 

network traffic can still be revealed 

with software that detects it.

Enable MAC address 
filtering on your network
It also seems a good idea to restrict 

access to your network to known 

devices, identified by their MAC 

addresses. But hackers can easily 

scan for and ‘spoof’ them.

All free Wi-Fi hotspots 
are dangerous
Not true. The key thing is whether 

the hotspot has encryption applied 

and that it’s WPA2-PSK. If it is, it’s 

reasonably safe to use. However…

Encrypted Wi-Fi hotspots 
are safe to use
Not quite, given the KRACKS 

vulnerability (see the next page). 

Disable all services in System Prefs’ 

Sharing pane before connecting, 

and use a VPN such as hide.me to 

add an extra layer of encryption.

Networking 
myths 
disspelled

Check to see if your router supports a backup 
mobile broadband internet connection.

2Delete and restart
Also select com.apple.wifi.message-

tracer.plist and preferences.plist. Drag 

all five files to a folder on the desktop. 

Restart the Mac, then switch Wi-Fi back 

on and see if your problem is resolved.

1Locate preference files
Turn off Wi-Fi. In Finder, go to /Library 

/Preferences/SystemConfiguration and 

select com.apple.airport.preferences.

plist, com.apple.network.eapolclient.

config and NetworkInterfaces.plist. 
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Completely reset Wi-Fi configuration

Back up your connection

Can’t connect in the kitchen

 
orking from home and 

suffering from a flaky 

internet connection that 

can’t be upgraded? Investigate using 

a backup connection in the form of 

mobile broadband. First, check with 

your chosen service provider that 

you’re in a good signal area. Second, 

see if you’re able to ‘tether’ your iPad 

or iPhone – Apple calls this Personal 

Hotspot (see bit.ly/prshtspt) – allowing 

use of its connection in emergencies.

If not, consider investing in a 

backup 3G/4G modem – some routers 

allow these to be plugged in to their 

USB port to use as a backup-only 

connection when broadband is down.

Remember to limit your usage, as 

you’ll have a fixed quota of data and 

If your devices have 

trouble connecting in a 

specific room that isn’t 

related to how far you 

are from the router, the 

likely culprit is network 

interference from other 

equipment, such as older 

cordless phones or even 

your microwave oven. 

This tends to affect the 

2.4GHz band most, so 

switching to the 5GHz 

network may help, though 

that band’s shorter range 

may itself pose a problem.

If that doesn’t work, 

consider updating your 

cordless phone to a newer 

DECT model (make sure 

it’s DECT 6.0, which 

avoids interference with 

Wi-Fi by using the 1.9GHz 

band). Otherwise, leave 

your kitchen while using 

the microwave. Also test 

other wireless gadgets –

radio-controlled cars, for 

example – and cheap wall 

chargers by switching 

them off. If your Wi-Fi 

signal magically improves, 

you’ve found the culprit.

bandwidth to play with – perhaps 

use it mainly to warn others you’re 

currently experiencing an outage, or 

to investigate the likely cause of the 

problem – and to get your broadband 

provider’s contact information!

Avoid using any Wi-Fi hotspot that doesn’t have 
a padlock at the right end of its row – it’s risky.
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Beef up network security
Make sure your network is protected from outside threats

ust how secure is your network? 

At the very least you should be 

protecting the Wi-Fi side of things 

with WPA2-PSK encryption. This is the 

latest Wi-Fi security measure, scrambling 

your data and protecting it using a 

pre-shared key (PSK), which is network 

speak for a password. But that only 

scratches the surface of what you need 

to do. Read on for other tips you should 

employ to close the door on hackers and 

other unwanted intruders.

Update your router
The recent discovery of the KRACK 

vulnerability has shaken Wi-Fi networking 

to its core. Familiarise yourself with what 

it is at krackattacks.com. Step one is to 

visit your router’s homepage and see if 

a firmware update has been released 

that specifically addresses this problem – 

if you have an AirPort Express, Extreme 

or Time Capsule, use Spotlight to open 

AirPort Utility (or download the iOS 

version), which should prompt you with 

a firmware update – at least version 7.7.9 

for 802.11ac models, or 7.6.9 for 802.11n.

You also need to update all your Wi-Fi 

devices. Apple has already patched OS X 

El Capitan, macOS Sierra and macOS High 

Sierra, and iOS 11.1. You can read more 

about what’s in each of Apple’s security 

updates at bit.ly/applesecupd.

Did you know your router might be 

open to access from the internet? First, 

sign in to its configuration utility in your 

web browser and, if you haven’t already 

done so, change the default password 

to something more secure. Now go to 

whatismyip.com – see your public IPv4 

address? Type this into your browser 

and see if this takes you to your router 

configuration login page. If it does, hunt 

through it for a ‘remote access’ option 

and disable it to lock out hackers.

Who’s on your network?
Install Who Is On My WiFi from the Mac 

App Store (free, bit.ly/wiomw) or Fing for 

iPad and iPhone (free, bit.ly/fingios) to 

see a list of devices – wired or wireless – 

currently connected to your network. 

Label those you recognise by IP address 

and mark them as known, and investigate 

the unknown devices to verify they’re 

legitimate. Keep checking back for new 

devices. If nothing else, it’ll remind you 

how many connected devices you own!

Another way to protect yourself is to 

turn on your router’s guest network, if it 

offers one. This gives guests internet 

access only. Be sure to protect it with 

WPA2-PSK and give the password to 

friends to use without exposing the 

rest of your network to them.

Check whether your shop-bought 

router supports a feature called VLANs 

(or ‘interface grouping’). This segregates 

your network via Ethernet port or Wi-Fi 

network, allowing you to set up isolated 

networks for specific devices. It can be 

complicated to implement, and isn’t on 

Apple routers or many supplied by ISPs, 

so a guest network’s often more suitable.

Another option is to close the virtual 

‘ports’ that route data from apps and 

services between networked devices and 

out on to the internet. If your router has 

UPnP (Universal Plug and Play) turned on, 

apps can open the ports they want, which 

can be risky. Managing port forwarding 

by hand is complicated, but periodically 

check your router’s admin tool to see 

which ports have been opened, removing 

any you don’t recognise or no longer use. 

It’s wise to cross-reference Apple’s list of 

ports used by its software at bit.ly/aplpt.

One way to tighten security is to give visitors limited access to your network by setting up a guest network. 
This provides people with access to the internet, but things like printers and storage are cordoned off.

Discover how many devices are connected to 
your network, whether over Wi-Fi or Ethernet, 
with a free app like Who Is On My WiFi.

FEATURE Home network guide



1Centralised file sharing
Shared folders on your Mac are only 

accessible while your computer’s turned 

on. See if your router has a USB port 

that enables a hard drive to be shared 

so you can provide a resource that’s 

always on and available to your family.

4Set up a media server
Copy your music, movies and other 

media to a central location, then set up 

iTunes as a server using Home Sharing 

(see bit.ly/hmshrng), or choose a third-

party option with broader support, such 

as plex.tv, to stream over the internet.

2Add network storage
NAS drives give you networked 

storage, and many can do more, such 

as run a media server or personal cloud. 

Get one with multiple bays so its capacity 

can grow. AirPort Extreme/Time Capsule 

allow USB expansion – see bit.ly/airdisk.

3Share peripherals
Why buy printers for everyone when 

you can share one? If you don’t have one 

with Wi-Fi, Ethernet or AirPrint, see if you 

can connect a USB printer to your router 

and share it through that. Apple’s AirPort 

devices allow this – see bit.ly/apprint.

5Remote access
On your Mac at home, turn on Back 

to My Mac in System Preferences’ iCloud 

pane (see bit.ly/bck2mac) and you can 

connect securely over the internet from 

your MacBook to grab files and even 

remotely control your Mac at home.

5 THINGS to do with your network 

Know what you need
> In the market for a new router? 

Start by making sure it supports 

802.11ac for the latest wireless 

technologies, including faster 

connections at the same distance.

Check the router’s AC rating. 

The higher the figure, the faster it 

is, but note the number is a combo 

of the maximum 2.4GHz and 5GHz 

Wi-Fi speeds, specified in Mbps – 

megabits per second. Detachable 

antennas can help you direct the 

signal to where reception is weak.

Look for a model with a built-in 

modem to reduce clutter. Make 

sure it’s compatible with your 

internet connection – that means 

ADSL for regular broadband, VDSL 

for fibre-optic or DSL for cable.

Also, make sure it has sufficient 

Ethernet ports for your needs, and 

that they’re Gigabit Ethernet if you 

need them to reliably handle 4K 

streaming. Finally, pick a model with 

USB ports for expansion options, 

such as sharing printers and hard 

drives over your network.

How to pick 
a router
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T
hese days, you’re missing a 

trick if you’re only using your 

network to browse the web, 

send an email and perhaps share 

a file or two. Networking has an 

ever growing list of possibilities, and 

by choosing the right hardware you 

can save both money and space in 

your home, too. 

Other network additions can help 

improve the quality of your life while 

making sharing that bit simpler and 

easier, while a feature that’s built in to 

macOS makes it easy to access your 

computer from wherever you are.

Here are five ways in which you 

can make better use of your network.

Check out our 
mesh routers 

group test 
p90
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 Understand iOS gestures

EDITED BY JO MEMBERY 

 When you see a shortcut like 

ç+å+C, hold all but the 

last key, then press that one.

 ç is the Command key, 

which is also labelled cmd.

 å means the Option key, 

labelled alt or opt.

 ≈  means the Control key, 

labelled ctrl, and shown as ^ 

in shortcuts in the menu bar.

 ß  is the Shift key, which is 

typically just labelled shift.

 ∫  means the Delete key, 

which deletes to the left of the 

insertion point. Press ƒ+∫ 

to delete to the right.

 † is the Tab key, which shifts 

the focus between some 

controls in windows and web 

forms. Turn on Full Keyboard 

Access in System Preferences 

to jump between all controls.

What’s inside 

40-41 
NEW SYSTEM 

FEATURES    
 Do more with your Mac, 

iPhone, iPad and Watch

42-44
TURN PHOTOS 

INTO PAINTINGS 
 Use layers and brush tips 

to mimic watercolours    

45 
REPLACE  

MAC APPS 
 Change the default 

apps on your Mac

46-47
IMPROVE 

SECURITY  
 Make life hard for  

online fraudsters

48-49
SHARE FILES 

 Collaborative working

50-51
MAKE A RINGTONE 

 Transform GarageBand 

compositions to ringtones

52
TEMPLATES 

IN PAGES 
 Create custom stationery

53
IDENTIFY FONTS 

 Use WhatTheFont 

to identify typefaces

54-55
APPLE WATCH 

FITNESS FOCUS 
 Keep healthy with the 

help of Apple Watch’s 

Activity and Health apps
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 Master Mac keyboard shortcuts

 A tap is a brief contact of 

(usually) one finger on your 

device’s screen.

 To drag is to move a finger 

across the screen to scroll 

or pan around content.

 Swipe means move one or 

more fingers across an item 

or the screen, then let go. 

 

 A flick is like swiping, but it’s 

quicker, and is often used to 

scroll content more quickly.

 Pinch means move two 

fingers together or apart, 

usually to zoom in or out.

 Touch and hold means lightly 

rest your finger on an item 

and wait for a reaction.

Your in-depth guide to 
getting more from 

your Apple kit

NEW 
IDEAS

USE iCLOUD  
TO SHARE 

FILES
p48



 Arguably 
the most 

important 
change is 
designed 

to protect 
your privacy

APPLE SKILLS macOS/iOS/watchOS
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New features from Apple
Make sure you don’t overlook these changes in macOS, iOS and watchOS

With the latest minor updates 

to its Mac, iPhone, iPad and 

Watch operating systems, 

Apple has added brand-new 

features, and tweaked how some existing 

ones work. Arguably the most important are 

changes to the behaviour of AutoFill in Safari, 

which might at first seem to make the feature 

less convenient. However, this alteration is all 

about balancing convenience and data privacy, 

and has come about as a consequence of 

some websites and online advertisers abusing 

features like AutoFill to acquire data through 

forms before you explicitly submit them.

Remember the recent controversy over 

Apple imposing performance limitations on 

certain iPhone models when their battery 

reached a certain condition? (See MF #323.) 

With the iOS 11.3 update, you gain control over 

that inhibitor, though by turning it off you run 

the risk that your phone will restart at an 

unwelcome moment – during a call, say.

There’s much more to tell you about, 

so let’s get to it. ALAN STONEBRIDGE

Genius tip!
 macOS 10.13.4 

introduces support 

for external graphics 

cards. Apple’s list of 

recommended chassis 

and cards is at bit.ly/

m10134egpu. Check 

support with your apps’ 

developers; some issues 

have been reported. 

 HIGHLIGHTS IN macOS 10.13.4 

1 Safari tab navigation tweak
Key combos ç+1 through to ç+8 still 

switch to corresponding tab numbers (from the 

left). Regardless of how many tabs are open, 

ç+9 now switches to the rightmost one.

2 Safari’s AutoFill is cautious
AutoFill no longer populates forms when 

you land on a page. It’s intentionally done to 

counter nefarious data acquisition. Click in a 

field and pick an identity to enter in the form.

3AutoFill security
Also with your protection in mind, if you 

interact with a password or bank card field on 

a page that isn’t using an encrypted server 

connection, Safari’s search field warns you.

4 Sort your bookmarks
Press ≈+ç+1 to reveal the bookmarks 

sidebar. In it, ≈-click on a folder. In the Sort 

menu you’ll find new Name and Address 

options. Your choice applies only to that folder.
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 HIGHLIGHTS IN iOS 11.3 

1 Check iPhone battery health
Go to Settings > Battery > Battery Health 

(Beta) to see how much of its original capacity 

the battery can hold. Below might be mention 

of performance issues – see bit.ly/batthlth.

2App update details
You need no longer tap Update next to 

an app in the store’s Updates tab to see if it‘ll 

download over the mobile network (150MB 

max); tap ‘more’ to see the update’s size.

3Apple Music curated videos
Plenty of artists still make great music 

videos (we love OK Go’s). If you have an Apple 

Music sub, in Music go to Browse > Music 

Videos to explore curated video playlists!

4 Sort App Store reviews
Don’t overlook this improvement when 

investigating apps: next to Ratings & Reviews 

on an app’s page, tap See All, then ‘Sort by’ to 

pick most helpful, favourable, critical or recent.

5 Sharing web pages in Mail
When you share a web page from Safari 

to Mail, if that page can be displayed by Safari’s 

Reader feature, its contents are inserted into 

the message instead of just the page’s address.

6 Smart Invert works better
This is more judicious than its pre-iOS 11 

equivalent. It’s located in Settings > General > 

Accessibility > Display Accommodations > Invert 

Colours, and now works in Mail and Safari, too.

watchOS 4.3
Apple Watch also gets 

neat tweaks. Here are 

the best new features

1HomePod 
control

Open the Music app and 

tap the words at the top 

left until you reach the 

top level of the app, 

then tap ‘On iPhone’. 

Pick something to play, 

tap the AirPlay icon and 

choose your HomePod.

You can skip tracks 

and volume by using 

the app’s on-screen 

controls, or turn the 

crown while on the Now 

Playing screen to alter 

HomePod’s volume.

2 Bedside 
mode

This mode, also called 

Nightstand mode, is 

now available when 

Watch is connected to 

power and in portrait 

orientation, not just 

landscape. The feature 

can be turned on in the 

Watch app on iPhone, 

in My Watch > General. 

3The Siri 
watch face 

This face now shows 

your progress towards 

closing Activity rings, 

and when Apple Music 

mixes you’ve synced 

(in Watch > My Watch > 

Music) are updated.
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1

2

3

6

2Create a preliminary sketch
Go to Layer > Duplicate Layer. Click OK. Choose Image > 

Adjustments > Desaturate, then Filter > Filter Gallery. In the 

Artistic folder, choose Coloured Pencil. Set Pencil Width to 2, 

Stroke Pressure to 2 and Paper Brightness to 50. Click OK.

1Locate the brushes
Open an image that features a colourful subject. Select the 

Brush tool (B) from the Tools panel. In the options bar, click on 

the Brush Preset picker. Click the cog icon and choose Legacy 

Brushes. Click OK to restore the Legacy brush set.

 HOW TO Create realistic watercolour brush strokes 

2

Brush Preset 
picker
This menu 

enables you to 

switch brush tip. 

You can change 

the Size and 

Hardness of the 

tip from here.

3

The cog icon
Once you’ve 

opened the 

Brush Preset 

picker, click this 

cog icon to load 

in collections, 

such as the Wet 

Media Brushes.

Turn photos 
into paintings
How to use layer masks and brush 
tips to mimic a watercolour look

IT WILL TAKE

 15 minutes

YOU WILL LEARN

 How to build up 

washes of colour and 

detail by applying 

brush tips to 

layer masks

 

YOU’LL NEED

 Adobe Photoshop CC 

and a colourful photo

Photoshop’s Filter Gallery is 

packed full of filters designed 

to mimic artistic paint effects, 

such as the Watercolor filter.

You can modify filter properties, but your 

digital art will still look like it has been created 

by a filter, rather than by an artist’s manually 

placed brush strokes. Here, we’ll show you 

how to create a unique hand-painted effect.

By placing semi-transparent brush strokes 

on a layer mask you can gently reveal a 

photograph’s colours and tones as washes 

of colour. When brush strokes overlap they 

create stronger colours and reveal more detail 

from the original photo. This process results in 

a more natural-looking watercolour effect.

In Photoshop CC 2018, Adobe has hidden 

the brushes best suited to this task, to simplify 

the Brush Preset picker. So we’ll start off by 

showing you how to restore those to get the 

required brushes and then use them to create 

a watercolour look. George Cairns

1

Brush tool
Click on this 

icon in the Tools 

panel to access 

the brush tool. 

You’ll then be 

able to modify 

brush properties 

such as opacity 

in the options 

bar at the top.
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Genius tip!
 Make sure that you 

click on the black layer 

mask before painting 

over the photo. If you 

accidentally click on the 

photo layer, you’ll paint 

white or grey strokes 

onto your picture.

Jargon buster
 Layer masks use 

greyscale tones to hide 

or reveal details on the 

adjacent image layer. 

Black strokes hide the 

corresponding parts of 

the photo. White strokes 

reveal image detail.

4

5

4Grab a textured brush
Press B to use the Brush tool. In the Brush Preset picker, 

go to the Legacy Brushes folder. Open the Wet Media Brushes 

folder – In older versions, access these from the Brush Preset 

picker’s gear icon. Choose Watercolour Light Opacity. 

3Add a layer mask 
In the Layers panel, click on the original Background layer 

and press ç+J to duplicate it. Drag the ‘Background copy 2’ 

layer’s thumbnail to the top of the layer stack. Choose Layer > 

Layer Mask > Hide All. The black mask hides the adjacent photo.

4

Layer mask
Paint white 

strokes on a 

black layer mask 

to reveal colour 

and detail from 

the attached 

photo layer. 

Grey strokes 

enable you to 

build washes of 

natural-looking 

watercolour. 

5

Paint effects
A single stroke 

creates a light 

wash. When the 

strokes overlap 

you get stronger 

colours, as with 

real watercolour 

paints and 

brushes.

6

Foreground
When painting 

on the mask, 

make sure the 

foreground 

colour is white. 

If it isn’t, press 

x to toggle 

between black 

and white. 
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10Create a paper texture 
Choose Layer > New > Layer. Click OK. In Edit > Fill, set 

Contents to 50% Grey. Click OK. In Filter > Noise > Add Noise, set 

Amount to 120%, tick Monochromatic and click OK. In the Layer 

panel, set the blending mode to Overlay and opacity to 40%.

8Paint buildings 
Select the Oil Medium to Large tip. Set its size to 100 and 

opacity to 40%. This produces a rectangular stroke that suits 

architectural shapes. Apply overlapping strokes on the mask to 

again reveal colour and detail from the attached photo layer.

6Overlap strokes 
Spray more strokes to restore colour to the sky. The 40% 

opacity tip produces grey strokes on the mask. When these 

overlap it creates whiter strokes, which create stronger washes 

of colour, resulting in a more natural-looking watercolour effect.

9Paint in finer details 
Select the Rough Round Bristle tip. Reduce its size to 17 

and drop opacity to 30%. Brush small white strokes on the layer 

mask to reveal the texture and colour of key subjects. Brush 

over important areas multiple times to create stronger colours. 

7 Finish the sky 
Keep spraying to reveal more colour and detail from your 

photo’s sky. Leave the edges of the photo unpainted to give your 

artwork a more realistic ‘work in progress’ look that you don’t 

get by simply slapping on a filter.

5Paint on the mask 
Set the brush size to 300 and the Opacity slider to 40%. 

Click on the black layer mask’s thumbnail to target it. Press D 

for a white tip. Spray the white brush tip over the sky in a single 

stroke to reveal a wash of blue from the attached image layer.

 HOW TO Create realistic watercolour brush strokes 
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Override your default apps
Make your own choices of web browser, email client, calendar and more

IT WILL TAKE

  5 minutes

YOU WILL LEARN

  How to override the 

default apps used for 

the web, email and files

YOU’LL NEED

  Alternative apps 

you want to use

It’s heresy, we know, but 

sometimes Apple’s way isn’t 

the best way for everybody all 

the time. Your favourite sites 

may shun Safari, or you might want to sync 

with web browsers on PCs. You might want 

features Mail can’t provide, or to match the 

apps you use on iPhone. Or you might need 

more PDF power than Preview can provide. 

The good news is that you can change 

the default handlers for websites, email and 

files of all kinds. The bad news is that it isn’t 

always that obvious how you go about it. 

We’re here to help. In this tutorial, you’ll 

discover how to replace Safari with Chrome, 

say goodbye to Mail, set the default for 

calendars, and change the default apps for 

handling particular kinds of files. And if you 

change your mind and want to go back to the 

way things were, all you need to do is follow 

these steps again and specify Apple’s apps. 

Carrie Marshall

HOW TO Change Apple’s default apps on your Mac > 

4Open in an app once
There are several ways to change 

what files open in which apps. For a  

one-off override that doesn’t actually 

change the default for all files of the 

same type, simply ≈-click on the file, 

choose Open With and select the app.

1Sayonara, Safari
To change the default web browser, 

download your preferred alternative, 

then go to System Prefs > General and 

look for Default Web Browser. Click on 

this pop-up to select the one you’ve 

downloaded as your new default browser.

5Always open in an app
Alternatively, if you want a particular 

kind of file to open in a specific app every 

time – PDFs in Adobe Reader instead of 

Preview, or images in your preferred 

editor, for example – ≈-click a file of 

that type and choose Get Info.

2No more Mail
This one’s odd, because the setting 

for email isn’t in System Preferences. To 

change the default email client you need 

to open the Mail app’s own Preferences 

window, where you’ll find the option to 

select another app on the General tab. 

6Edit the default
Towards the bottom of the Info 

window, you’ll see a section marked 

Open With. Click the arrow to expand 

that section and select the app you 

want macOS to use to open all files 

of this type, then click Change All.

3Go Google
If you want to use Google Calendar, 

open Calendar’s prefs and click Accounts. 

To set where events are made by default, 

whether it’s iCloud, Google or elsewhere, 

go to Calendar > Prefs > General and use 

the Default Calendar App pop-up.
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Protect your identity online
Make life hard for online fraudsters with our security tips

IT WILL TAKE

  15 minutes

YOU WILL LEARN

  The tricks to keep 

spammers, scammers 

and trolls at bay

YOU’LL NEED

  A Mac or 

an iOS device  

The online world is complex 

and full of risks for the unwary. 

But that doesn’t have to be the 

situation for you, as long as you 

follow some basic guidelines and stay aware 

while you surf, search and share. 

This tutorial is about minimising the 

personal data that you put out into the world. 

The principle is simple: share what you want, 

when you want, where you want – but nothing 

more. Many sites ask for personal information. 

If your account gets compromised, someone 

could use that data to access other online 

accounts or even steal your identity. It’s not 

just spammers; trolls looking for ways to 

harrass people will happily trawl through 

someone’s post history looking for clues about 

their location, employer, friends and more.

This doesn’t mean you have to become 

a social hermit – it’s about being careful. The 

first tip is to set up two-factor authentication 

everywhere that offers it, so when you log in 

from a new device you’ll get a verification 

code on a trusted one. Keith Martin

HOW TO Stay safer online  

1Online quizzes
If an online quiz asks for personal 

information – the street you grew up on, 

first pet’s name, grandmother’s name, 

stuff like that – then either close that tab 

or lie. Those are classic ‘open sesame’ 

security questions.

2 Fake birthday
Don’t use your real birthdate in web 

forms except for banks, credit checks and 

other official sites. Make one up, but 

remember it in case it’s needed for a 

password reset. Using ‘1 April’ is good, 

unless that is your birthday!

3Type links yourself
If you want to check an online 

account for any reason, use your own 

bookmarks, type the address manually, 

or use a search engine. Never use a link 

you found an email in case it’s actually 

well-disguised spam.
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CONTINUED… Stay safer online 

4Shun spam links
A random email offers a link? Leave 

it alone. If you aren’t sure it’s bogus, 

hover over the link (Mail for Mac) or hold 

a finger on it (Mail for iOS) to see the true 

destination and carefully check it. If it  

isn’t what you expect, trash the email.

5Remote images
Auto-loading remote images in 

emails shows you’re a potential spam 

target and logs your rough location. 

To disable remote content in Mail for iOS, 

go to Settings > Mail. In Mail for Mac, go 

to Mail > Preferences > Viewing.

6User names
When picking a username don’t 

include personal info, such as town or 

birth year (for example, Andy-Brighton 

or Jimbo87). That tells someone 

personal info even if they can’t see 

anything else in your account.

7Share only with friends
Don’t leave your social media 

profile open for the world to see. If you 

do choose to keep your posts public, 

always keep this in the back of your mind 

when posting and don’t share anything 

that’s identifiably personal. 

8Employer names
In social media profiles, we often 

give details of where we work. Outside 

of professional networking sites like 

LinkedIn, this isn’t necessary. Consider 

removing it from your personal account 

profile. Use a generic description instead.

9Erase private info
Before you post an image anywhere, 

stop and think: does it contain anything 

you shouldn’t share? You can use the 

Markup tools in iOS to paint over things, 

but watch out for the highlighter – it isn’t 

entirely opaque.

10Location metadata
On iOS, ImagExif (£1.99, bit.ly/

imagexif) adds a Share sheet action that 

strips out location data from pics before 

you post them. In Preview on a Mac, 

choose Tools > Show Inspector, pick the 

GPS tab and click Remote Location Info.

11Apps and access
Which apps can use your iPhone’s 

camera, mic and other sensitive things? 

Browse the categories in Settings > 

Privacy and check. You will almost 

certainly have granted apps more 

access than they need for normal use.

12Better passwords
Don’t reuse passwords! Safari and 

the keychain feature can generate and 

autofill complex passwords. To prevent 

data theft, Safari in iOS 11.3 and version 

11.1 for Mac do not autofill forms when a 

page loads; you must explicitly request it.
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Share files over iCloud
Make life easier with these handy tips for sharing files with other people

IT WILL TAKE

  15 minutes

YOU WILL LEARN

  How to share files in 

macOS, iOS and iCloud

YOU’LL NEED

  A Mac or an 

iOS device 

The features Apple has 

added to iCloud have been 

so numerous that many have 

arrived unnoticed. That’s a 

shame, as just a little time spent getting to 

know how to use them will reap rewards. 

Take, for instance, the feature added in 

macOS Sierra that allows you to specify that 

files stored in your Documents and Desktop 

folders are hosted in iCloud and only those 

you use most often are stored locally on your 

Mac (set it up in System Preferences > iCloud > 

iCloud Drive > Options). The others can be 

downloaded when you need them, but when 

you don’t, the storage space on your startup 

disk is freed up. This brings macOS closer 

to iOS, where iCloud Drive’s contents are 

stored on Apple’s servers until you need them.

There’s a raft of features in iCloud that 

enable you to collaborate on docs, including 

granting access rights to anyone or just 

contacts you specify, and setting permissions 

to allow other people to edit or just read files. 

Here’s how to use them. Kenny Hemphill

HOW TO Share iCloud files with other people > 

1Select your file
In iOS, open the Files app, tap iCloud 

Drive, then Select. Choose the file you 

want to share. Open the Share sheet 

and tap Add People (bottom row). Pick 

how to share, then type the recipient’s 

email address or phone number.

2Add people
In macOS’s Finder, browse to the file 

in iCloud Drive, ≈-click on it and choose 

Share > Add People from the menu. 

Choose a method to share the file, and 

type the email address or phone number 

of the person you want to share with.

3Add people using iCloud
Sign in at iCloud.com and open 

iCloud Drive. Find and click on the file to 

share, then click the toolbar’s Add People 

button. Choose Email or Copy Link and 

click Share. Type in an email address for 

the recipient if you’re sharing by email.
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HOW TO Set access permissions for files in iCloud Drive >

HOW TO Tag files in iCloud Drive > 

1Share options
In iOS, after choosing a file to share 

and tapping Add People, click Share 

Options at the bottom of the panel. 

Here, set access rights (anyone or just 

explicit invitees) and whether they have 

permission to edit or only view the file.

2Access and permissions
In macOS, follow the process for 

sharing and, after choosing Add People, 

click on the arrow to the left of Share 

Options. Use the pop-up menus to set 

access rights and view/edit permissions 

for the specified file and people.

3Permissions in iCloud
At iCloud.com, follow the steps for 

sharing and, after clicking Add People, 

click Share Options, pick the access and 

editing rights you want from the pop-up 

menus, then click Share to close the 

sheet and return to iCloud Drive.

1Tag a file in iOS
In iOS, select a file in Files > iCloud 

Drive, then open the Share sheet. At the 

top of the sheet, tap +Tag. Tap an existing 

tag to add it, or tap Add New Tag, type a 

label for it, tap a colour swatch, then tap 

Add Tag. Tap Done or outside the panel.

2Add a tag in macOS
In Finder, select a file that’s stored in 

iCloud Drive and press ç+I to show 

the Info window. Click in the Add Tags 

box at the top of the window and choose 

a tag from the menu, or type a new one 

and press ®. Close the Info window.

3Another way in macOS
Or, ≈-click on a file, then choose a 

tag lower down the menu, or choose Tags 

to pick from a longer list or create a new 

tag. Up to seven shortcuts can be listed 

in the contextual menu, which you can 

set in Finder > Preferences > Tags.

Collaborating in real time

Pages, Numbers and Keynote allow several people to work on a document at 

one time. When you open one of these apps, its document manager displays 

recently edited documents, including those edited by people you’re sharing with. 

In the document, click on the head and shoulders icon to see who is working 

on it. When multiple people are working on a document simultaneously, each is 

represented by a different coloured pointer. Edits are shown in real time. To see 

changes made by a specific person, click on the coloured dot next to their name.

iWork apps allow multiple people to work at once 



APPLE SKILLS Mac software

50 | MACFORMAT | JUNE 2018  macformat.com  @macformat

Make a ringtone 
Transform compositions, or other music on your phone, into ringtones

IT WILL TAKE

  15 minutes

YOU WILL LEARN

  How to use 

GarageBand to mix 

and export ringtones

YOU’LL NEED

  An iOS 11 device, 

GarageBand 2.3 or 

later, a song to use

The idea behind a ringtone is 

blindingly obvious – it’s to get 

your attention, alerting you 

to the fact someone wants to 

speak to you. The tiny snag is that an awful 

lot of people never change their ringtones. 

That means when one phone goes off, you’ll 

sometimes see dozens of people reach for 

their phone, before realising the call isn’t 

actually for them.

When you’re equipped with an iPhone and 

GarageBand, however, you can ensure this 

never happens to you by creating your own 

individual ringtone. And you don’t need to be 

a synth master to do so – you can make use of 

pre-made loops and smart instruments that 

do much of the work for you.

If you’ve been following this series of 

tutorials so far, you’ll already have a song 

ready, containing several tracks. If not, check 

out ‘Make some noise’ on the opposite page, 

to create something that will enable you to 

delve into our walkthroughs on mixing, export, 

and ringtone assignment. Craig Grannell

HOW TO Load and preview your song 

1Use iCloud
If you composed your track on an 

iPad, but want the ringtone on your 

iPhone, now is the time to transfer it 

across. Assuming you’re signed into 

iCloud, you should be able to see and 

download the song on your iPhone.

2 Install kits
GarageBand will recognise if the 

track uses instruments and loops from 

the Sound Library that aren’t installed. 

If you see a Missing Sound dialog box, 

tap Sound Library and download the 

relevant kits to your iPhone.

3 Play your track
When you’re done, open your track 

and play it. Don’t use headphones – at 

this point, you must think about how 

this potential ringtone works in the real 

world, just with your iPhone’s speaker, 

possibly buried deep in a pocket.
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HOW TO Fine-tune and mix your ringtone 

HOW TO Export your ringtone 

1Adjust the tempo
You may discover your track feels a bit 

too urgent and stressful, or, conversely, 

boring and slow. In the Settings menu 

(spanner icon), tap Tempo and try 

experimenting with different values.  

(You can always change it back.)

2Mix your song
In Tracks view, drag the separator 

bar rightwards to reveal mixing controls. 

Play your track and adjust volume levels 

to ensure the end result sounds good 

and isn’t muddy or messy. Mute entire 

tracks if need be.

3 Edit track settings
Also try adjusting individual tracks – 

select one and tap the Track Controls 

button. Scroll down and you’ll see EQ 

effects for changing bass and treble 

levels, and also master effects. Typically, 

keep reverb low or off.

1 Share your song
When you’re done editing, return to 

the My Songs browser. Tap Select and 

then your saved song. Tap the Share 

button to bring up the Share Song sheet. 

Select Ringtone to begin the process of 

exporting your song.

2Name your ringtone
In the Export Ringtone sheet, tap 

within the name field and name your 

ringtone. Tap Export. GarageBand 

will mix down your song within a few 

seconds. Tap Use Sound As, and then 

assign your ringtone accordingly.

3 Reassign ringtones
You can later change a ringtone 

assignment in Settings > Sound & Haptics 

> Ringtone. Oddly, removing tones only 

seems possible in the Export Ringtone 

sheet. Tap Your Ringtones, then Edit, one 

of the red minus buttons, then Delete.

Make some noise 

GarageBand offers other paths to creating ringtones. You can create a new 

audio track with a voice recording of you bellowing ‘Answer your phone’. If you 

prefer something a bit subtler, tap the Loops button and use Apple’s sounds. 

From the Music tab, you can even drag any (non-copy-protected) song that’s 

stored on your iPhone to a track; trim whatever you import by tapping the audio 

region and dragging its ends. Match the tempo with the original song on new 

tracks and you can add sounds over the top to make your own personal remix.

Create songs from any audio source 
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Create templates in Pages
Create your own custom pages and use them as templates

IT WILL TAKE

  10 minutes

YOU WILL LEARN

  How to customise 

stationery in Pages

YOU’LL NEED

  Pages for    

iOS or macOS

Pages is a great document 

creation and editing tool, but 

chances are you’re probably 

working a little harder than 

you need to be. If you find yourself putting 

the same things into document after 

document, it’s time to create a template. 

You can’t save a document created on iOS 

into the same device’s template library, as you 

can on a Mac, but you’ll see it’s possible to 

create complex ones on the Mac and then copy 

them over to your iPad. We’ll use iCloud for 

this, but Mail works too. However, there’s a 

workaround when there’s no Mac to hand.

You can create a standard layout on iOS, 

save it and then duplicate the document when 

you want to use it. That leaves the original 

untouched and a new copy that contains all the 

bits you want. In this tutorial, you’ll learn how 

to add crucial elements, such as headers and 

footers, how to add images and shapes, and 

how to add effects to images. Carrie Marshall

HOW TO Personalise your stationery > 

4Add an image
Tap the + to add an image, table, 

shape or chart that’ll appear on every 

page. Select an image on the page and 

tap the brush to open the inspector, 

where you can adjust transparency and 

other effects to get your desired result.

1Pick your page
In Pages, create a new document and 

then tap on the three dots at the top 

right. Choose Document Setup and you’ll 

see the screen shown here. To edit the 

header or footer, tap in the appropriate 

space, or you can leave this blank.

5Save and copy
Return to the main editor, add 

whatever bits you like and then save 

everything by tapping Documents at 

the top. To use your document as a 

template, hold a finger on its icon for 

a moment, then tap Duplicate.

2Add numbers
When you tap in one of those boxes, 

you’ll see that Pages offers to handle 

page numbering. You can choose the 

format and then add any additional text 

you like. You can also format the text 

here by tapping the toolbar icons.

6Do more on a Mac
You can use templates created on 

your Mac on your iOS device: choose 

File > Save as Template and save to 

iCloud. In Pages on iPad, tap Browse 

instead of Recents and you should see 

the template. Tap on it and then Add. 

3Change the paper size
If you tap the icon in the top-right 

corner, you can adjust the paper size. 

Pages gives you a choice of Letter or 

A4 in portrait or landscape mode. 

You can drag the on-page guides to  

adjust the page’s margins.
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Identify fonts
Use WhatTheFont to quickly find fonts

IT WILL TAKE

 5 minutes

YOU WILL LEARN

  How to use 

WhatTheFont to 

figure out the fonts 

used in any artwork

YOU’LL NEED

  iOS 10 or later, 

WhatTheFont

Whether you’re a jobbing designer, someone 

who enjoys working on flyers for a local club, 

or just a typography aficionado, you may at 

times spot a font you desperately want to 

identify. If you’re armed with an iOS device, WhatTheFont 

(free, App Store) can help.

As shown in the walkthrough, this app can figure out 

where text is within an image, and will analyse the typeface 

of a word to provide you with a list of possible font matches. 

But it also has features we didn’t have room for in the 

steps below. First, you don’t have to shoot a photo – the 

button left of the camera shutter lets you load an image 

already on your device (including ones that you’ve saved 

from Safari or Mail). Also, if your image is a bit skew-whiff, 

tap the rotate button to open a tool that adjusts rotation. 

Finally, if you don’t fancy waiting for the app to locate all of 

the text in your image, tap the selection button and drag out 

a region yourself for it to check. Craig Grannell

HOW TO Use WhatTheFont >

1 Take a photo 
If possible, make sure the target 

artwork is well lit and flat, and then take 

a photo of it with WhatTheFont. The app 

will then analyse the artwork and attempt 

to outline areas of typography that it 

finds. Tap one of these to select it.

2 Identify threads
If your selection doesn’t contain the 

entire word, you can resize it. Otherwise, 

tap the right-facing blue arrow to list 

possible matches. Note that you may not 

find the exact font, but should at least 

get something similar.

3Add your own text
Tap the area to the left of the pencil 

icon and you can type your own text, 

seeing how it looks in all the listed fonts 

to find which is the best match. Tap any 

single font to isolate it on the screen, 

with a link to get it from MyFonts.
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The three 
rings are 

useful activity 
indicators, no 

matter how 
much you’re 

into fitness
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Keep fit with your Watch
Make the most of Apple Watch’s built-in fitness tools

IT WILL TAKE

  10 minutes

YOU WILL LEARN

  How to tweak your 

Move goal, use the 

Workouts app, and 

analyse your data

YOU’LL NEED

  An Apple Watch,  

an iPhone 

Apple Watch has always been 

a health and fitness device as 

much as anything else, but 

Apple has been careful to make 

sure that those features were accessible to 

everyone, not just gym rats or runners.

Its status as your healthy conscience starts 

with the Activity rings – three measurements 

to keep an eye on, no matter how much you’re 

into fitness. The Stand goal (blue) is designed 

to push you into standing up and moving 

around for at least one minute per hour, and 

to reach that target 12 times per day. 

The Exercise goal (green) pushes you to do 

30 minutes of semi-vigorous exercise per day. 

Again, than doesn’t mean a half-hour jog – 

if you walk briskly, it will usually count, and 

that adds up over a day easily… provided 

you’re doing enough of it.

You can’t adjust these goals at all (raising 

or lowering them to suit you), because they’re 

all about getting you to meet a recommended 

minimum health standard – it’s great if you do 

more, of course, but the important thing is 

consistently reaching that milestone.

The last goal of the three Activity circles 

is Move (red), and this one’s more about 

traditional fitness – it counts calories burned 

over the day. You can adjust this as much as 

you want, so you can decide that you’ll have to 

go for a five-mile run (or an equivalent) to get 

to the target you’ve set yourself.

Working out
When you do more intensive exercises, your 

Watch can still be your partner – use the 

Workouts app and it will record data such as 

your heart rate, how long you exercised for, 

and how many (estimated) calories that period 

of exercise burned. All that data is fed to the 

Health app on iPhone, to browse through later.

The Health app can draw data from places 

other than your Apple Watch. A heart rate 

monitor chest band, such as the Polar H10, 

will provide more accurate heart readings 

than the Watch, for example. You can also get 

home gym equipment that sends information 

about your exercise to its companion app, 

which can then pass it onto the Health app –

when you open the accessory’s app, it will 

ask for permission to do this. 

You can also add other info that might 

affect how you interpret your exercise data, 

such as inputting blood glucose levels, so you 

can cross-reference when that’s had an affect 

on your fitness over time. Matt Bolton

HOW TO Keep up with your targets > 

1 The basic Activity rings
To be able to keep up with your daily 

goal progress, you can add the rings as 

a complication to any watch face. You’ll 

get a notification when you hit one. You 

can get specifics by opening the Activity 

app; tap the complication to do so. 

2 Change the Move goal
The Stand and Exercise goals are 

fixed, but you can change the Move goal 

to push you to burn more calories each 

day. In your Watch’s Activity app, firmly 

press the screen, then tap Change Move 

Goal. Set a new goal, then tap Update.

3 Get competitive
In the Activity app on your iPhone, 

tap the Sharing tab at the bottom. Here, 

you can invite friends to share their 

activity progress with you – you’ll know 

when they do workouts or hit goals, 

spurring you on to raise your game. 
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HOW TO Use the Workouts feature > 

HOW TO Make more of the Health app > 

1 Start a workout
Open the Workouts app on your 

Watch, then tap the appropriate workout 

(such as Outdoor Run). You can set a 

target – time, distance or calories – by 

tapping the three dots, or just tap on the 

row. You can also use Siri (see below).

2Workout controls
Once you start a workout, a glance 

at your wrist shows how you’re getting 

on, including your heart rate. Swipe left 

to right to get controls to pause or end 

the workout, to start a new session, or 

lock the screen for swimming.

3Once you’re finished
Once you end the workout, you get 

a little summary of your stats. You can 

name the workout, which can be useful 

if you want to look over the data in the 

future and know that you were cycling 

a particular route, for example.

1Add a workout manually
If you exercised without your Watch on 

(or if you just forgot to start a workout), 

you can add data for it in your iPhone’s 

Health app. Tap Health Data > Activity, 

than scroll down and tap the Workouts 

bar. Tap the plus button at the top right. 

2 Inputting workout info
This brings up a screen where you 

can choose a kind of exercise, from a 

longer list than is shown in the Workouts 

app. You can enter calories burned and 

distance, but both are optional. Set the 

length of the workout, then tap Add. 

3View in the Health app
Obviously, the Activity app tracks 

your fitness, but the data feeds through 

into the Health app too. Try tapping 

Health Data > Heart, and look at the 

graphs over time to see if exercise is 

lowering your heart rate over time.

A little help from Siri 

You don’t have to go tapping around on your Watch to start a workout – just 

tell Siri what kind you’ll be doing. “Hey Siri, start an outdoor run” will start an 

open-ended Workout of that kind, for example. You can also set the target, 

though: say the same thing as above, but say “to 10 miles” at the end, and the 

workout will have that included. Siri also uses its predictive powers to help you 

reach your Move goals – towards the end of the day, the Siri watch face will 

suggest something like: “A 20-minute brisk walk will help you reach your goal”.

Get a hand from your fitness assistant 
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Are unsigned apps safe to use?
will cause macOS’s Gatekeeper feature to 

refuse to run the app, if ‘Allow applications 

downloaded from’ in System Preferences’ 

Security & Privacy pane is set to one of the 

first two options. (For protection, avoid 

selecting the third option – Anywhere.)

Apps can be signed at the time they’re 

compiled from source code. If an app is not 

signed, Gatekeeper will stop it running in case 

it is (or has been) altered by malware. You 

can’t sign precompiled apps yourself, but you 

can bypass Gatekeeper’s protection to run 

one: ≈-click its icon in Finder, choose Open, 

then Open again in the confirmation dialog. 

Beware that this leaves the app open to 

tampering, leaving your Mac vulnerable – 

be extremely cautious of allowing this.

Q
Why are some major apps, such 

as HandBrake and the GIMP image 

editor not signed? Are they safe?

by J A C K  F O L E Y

A
Code signatures are used by macOS 

to tell whether apps have been 

altered since they were signed, either 

by accident or interference from malware. 

They don’t fit well with open-source software.

To sign an app, developers must register 

with Apple and pay an annual subscription 

to have it issue code signatures for their 

software. Each signature applies to the entire 

contents of its corresponding .app bundle – 

the icon that appears in Finder. Once signed, 

the slightest change to the bundle’s contents 

58 | MACFORMAT |

Our resident genius 
solves your Mac and  

iOS problems

EXPERT 
ADVICE

A tool like Objective-See’s 
What’s Your Sign? gives more 
detailed info about signature 
problems with pre-built apps.



 

iOS software GENIUS TIPS

iOS software 
Swipe away your touchscreen troubles and 
rekindle your love of Apple’s mobile devices

iOS software 
quick-fire 

questions 
What’s best to 

free up storage 
on my iPhone?

> In Settings > General > 

iPhone/iPad Storage 

there’s a detailed 

breakdown of how 

space is being used, 

listed by purpose. 

Below that, iOS may list 

recommended actions 

you can take, each 

with an estimate of the 

amount of space it could 

save. Offloading unused 

apps – a new capability 

in iOS 11 that enables 

you to remove an app 

but keep its docs and 

data on your device – 

and making use of 

iCloud Photo Library are 

usually the best options.

How can I 
customise my 

iPhone’s keyboard?
> Two popular apps are 

SwiftKey, which offers 

in-app purchases, and 

Google’s Gboard, which 

is free but encourages 

you to use Google 

Search and to provide 

usage data. Both have 

an extensive choice of 

localised layouts, easy 

access to emoji, and 

support using your 

own custom layouts.

Can I roll back my version of an app?
However, you may still have copies of much 

older versions of iOS apps available on your 

Mac from before that time, when you were 

using an older version of iTunes.

Previous versions of iTunes stored copies 

of iOS apps under Mobile Applications within 

iTunes’ library folder. If you can’t find any 

there, have a browse through your Time 

Machine backups and you might find some. 

They will have the file extension .ipa.

Installing those apps from your Mac onto 

an iOS device may seem impossible now that 

your iTunes library has no Apps category. 

However, even the latest iTunes can install  

an .ipa file on a connected iOS device.

In Finder, drag and drop the .ipa file for the 

app you want to reinstall onto your device’s 

icon in iTunes’ left pane. The biggest snag with 

this is that the only apps you can do this with 

are those downloaded directly to your Mac 

before iOS 11 was released last September. 

However, some won’t be 64-bit and so will be 

incompatible with iOS 11, or they may have 

other compatibility issues with it.

Apple still provides iTunes 12.6.3, which 

can manage iOS apps, at bit.ly/itunes1263.
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Q
Now that iTunes on the Mac no 

longer stores and manages iOS 

apps, how can I downgrade to 

an older version of an iOS app?

by T I M  F U S S E L L

A
iTunes 12.7 and later can’t download 

iOS apps or manage those that are 

installed on iOS devices. Further 

complicating matters, for a while iTunes has 

not synced apps downloaded on iOS devices 

back to the Mac; with iOS 9, Apple introduced 

a set of techniques called ‘app thinning’ to 

save bandwidth and storage by downloading 

only what is necessary for the device you’re 

using, which would prevent you transferring it, 

say, from an iPad to a Mac and then an iPhone.

Though iTunes can’t 

access the App Store 

any more, it can install  

.ipa files on iOS devices

 macformat.com  @macformat

You can drag and drop .ipa files, 
which are iOS apps, from Finder 
onto your iOS device in iTunes’ 
sidebar to install them on it.
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macOS 
Invaluable insights into irritating issues 
with the inner workings of your Mac
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Why won’t iCloud 
Drive keep large 
files on my Mac?
>  It’s due to Optimise 

Mac Storage in iCloud 

Drive’s preferences. 

When turned on, 

it allows macOS to 

remove local copies 

of files stored in iCloud 

Drive and not used 

recently, if it needs 

extra space. Their icons 

remain in place, and 

copies of the files are 

kept on Apple’s server. 

They will redownload if 

you try to open them.

How can I preview 
a folder of files?

> The preview in Finder’s 

Column view is often 

too small. Instead, you 

can select the files to 

inspect and press the 

spacebar to open Quick 

Look; use its buttons or 

the arrow keys to step 

through the files. Many 

common types can be 

viewed this way due to 

plugins provided by 

macOS or with apps.

My App Store is broken!

macOS 
quick-fire 

questions 

recent backup of the internal drive, in case 

you need to restore files from there.

If you kept a copy of the ‘Install macOS 

High Sierra’ app, open it to install High Sierra 

again over the top of itself. There’s no need to 

erase the disk, and your current data will be 

retained. The installer will fix problems with 

system files that may be your trouble’s cause.

If you no longer have the installer, because 

the only way to obtain it is from the Mac App 

Store, your current installation can’t download 

a fresh copy while the problem persists. In this 

case, hold ç+r at startup to enter Recovery, 

then choose the ‘Reinstall macOS’ option. 

If that doesn’t fix the problem, you can 

hold ç+å+r at startup; the option to install 

macOS then installs the latest version for your 

Mac, even if it’s newer than what you’re using.

Q
Since upgrading to High Sierra, 

I can’t download or update apps 

from the Mac App Store, and I 

don’t receive any system updates either. 

How can I get these to work again?

by D E N N I S  O A T E S

A
Check in System Preferences’ iCloud 

and App Store panes that you’re 

signed in using your correct Apple ID. 

Also confirm in the latter that your Mac is at 

least set to automatically check for updates. 

If those are correct but the store still isn’t 

working, try signing out of it and iCloud and 

signing in again. The underlying cause is most 

likely that your upgrade to High Sierra didn’t 

work correctly and needs to be repeated. 

Before doing so, ensure you have a good 

The good old trick of signing out of the 
Mac App Store is a good starting point if the 
store doesn’t show app and system updates.

 macformat.com  @macformat
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1The Versions browser
If an app supports Versions, its File 

menu will contain a ‘Revert to’ submenu. 

Open a doc and choose File > Revert to > 

Browse All Versions. The browser shows 

the current version on the left; go to the 

part from which content is missing.

2 Find what’s missing
Click the right window to bring the 

previous version to the front, then scroll 

to the relevant part of the doc. If what’s 

missing isn’t in this version, step back 

through older versions. When found, 

select the text and press ç+C.

3Bring it back
Click the current version on the left 

and place the insertion point where the 

missing content should go. Press ç+v to 

paste it there. To leave the browser, click 

the Done button at the foot of the screen. 

Press ç+s to save this as a new version.

 HOW TO Recover lost content using Versions 

Why does Disk 
Utility’s First Aid 
feature warn about 
overallocation?
> Disk Utility may report 

overallocation on APFS 

disks that contain more 

than one volume, when 

the total size of volumes 

exceeds drive capacity. 

This is normal for APFS, 

and is a warning rather 

than an error.

How can I remove 
a file from my Time 
Machine backups?
> With your backup drive 

connected, open Time 

Machine (from its menu 

bar icon or by opening 

the app in /Applications). 

Locate and select the 

file, then click the cog in 

the toolbar and choose 

‘Delete all backups of’. 

Don’t delete items using 

Finder or Terminal; 

doing that could make 

your backups unusable.

macOS 
quick-fire 
questions 

 macformat.com  @macformat

Photos take up unexpected space
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drive, say, these are normally 4KB, but on 

a memory stick they can be 32KB or more.

Your software may also be adding 

thumbnails, as extended attributes, which 

aren’t included in Finder’s counts. When you 

copy files to a memory stick, those thumbnails 

are copied into hidden files, and can add up to 

a significant amount. Many image-processing 

apps can disable the addition of preview 

images, which are often unnecessary on Macs. 

To save storage, make use of this feature.

Q
When I check the size of a folder 

of photos, Finder might show it 

as using 100MB. When copied to a 

USB memory stick, it shows up as requiring 

more space – perhaps even 110MB. Why?

by I A N  D A V I D S O N

A
There are two reasons for memory 

sticks appearing to use more space. 

The size of storage units used on 

flash memory can waste space. On a hard 

A file that‘s under 1KB might 
use 4KB on a startup disk, 
but 33KB on an ExFAT-
formatted memory stick.

Thumbnails are traditionally 
added as resource forks. 
You don’t need them now 
due to Quick Look previews.
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Mac software 
Shine a spotlight on sagacious solutions 
to your most maddening Mac maladies

Mac software 
quick-fire 

questions 
How do I download 
4K films in iTunes?
> Although you can buy 

4K films on your Mac or 

iOS devices, Apple TV 4K 

is the only Apple device 

that’s currently allowed 

to download or stream at 

that quality – not even 

Retina 4K or 5K iMacs 

allow it. HDR content is 

supported on second-

gen iPad Pro models and 

iPhone X, 8 and 8 Plus, 

but at 1080p quality.

 

 

 

 

 

 

How can I reduce 
the amount of space 
used by Messages?

> In Messages, ≈-click 

a conversation in the 

left pane that you know 

contains media or other 

files. Choose Details from 

the contextual menu; the 

popover that appears 

displays all media and 

files exchanged in that 

conversation. You can 

hold ç and click multiple 

items to select them, 

then ≈-click one of your 

selections and choose 

to delete those items.

Library folder that was just revealed. Select 

the folder named Calendars, which contains 

all your local calendars. Navigate back through 

time until the missing calendars’ files appear. 

Select them and click Restore. When you get 

back to the desktop, reopen the Calendar app.

If you don’t have a Time Machine backup 

of your old Mac, only a copy of what was on 

it when you upgraded, perform the same task 

manually by copying and pasting files from 

that into your account’s Calendars folder.

There are advantages to putting your 

Calendars in iCloud, most notable being easy 

access to them on all your devices. Although 

the local backups you make of your Mac will 

include your calendars, you should ensure 

that you keep offline backups of them; iCloud 

itself shouldn’t be treated as a backup as 

changes, including damage to files, will 

propagate across all devices you connect to it.

Missing calendars

Calendars that are stored solely 
on your Mac rather than in iCloud 
are held in the Calendars folder 
in your account’s Library folder.

Q
When I replaced my old iMac, the 

shop transferred all my data to my 

new one. Several colour-coded 

calendars have disappeared in the process, 

and I can’t find them on the new Mac. I don’t 

use iCloud. Where have they gone?

by P E T E R  W H I C K M A N

A
Data for calendars is stored in  

~/Library/Calendars, ~ meaning your 

account’s Home folder. When the 

shop migrated the contents of your old Mac 

to the new one, that data should have been 

copied across and appear in this folder.

If you have a recent Time Machine or other 

backup of your old Mac, you should be able to 

restore the calendars from it. Quit Calendar, 

If you back up using Time Machine, open that 

app, browse to your Home folder, press ß+ç+. 

(full stop) to reveal hidden items, and open the 



Q
When I import video clips from my 

camera’s SD card to iMovie on my 

iMac, their dates and times are set 

to that of the import, not when they were 

shot. Is this a bug?

by D A N I E  F O U R I E

A
Normally the date stamp of each clip 

is set by the camera at the time of 

shooting, but some people using 

recent versions of iMovie have complained 

of the problem you describe.

Mac software GENIUS TIPS

Video file size discrepancy
Check your camera’s documentation to 

see if this is an option you need to set. Also, 

verify that the camera’s date and time are 

correct. If the camera is setting the info 

correctly, you may be able to work around 

problems in iMovie by changing the way you 

import clips. Rather than going straight from 

the SD card, copy to a folder on your Mac, 

and import them from there into iMovie.

If that doesn’t resolve the issue, iMovie 

provides an easy way to adjust clip dates and 

times – look in its Modify menu.

How can I stop 
Keynote saving 
huge versions?
> You can’t, and the more 

you save your work, the 

more will be saved. Delete 

individual versions in the 

Versions browser. 

VersionsManager (free 

with in-app purchases, 

corecode.io) gives better 

control, including deletion 

of many versions at once.

How do I know 
which Photos library 
I’m currently using?
> Photos can create and 

manage multiple libraries, 

but opens one at a time. 

The one in use is listed in 

its General preferences. 

To switch libraries, hold 

å when opening Photos 

from Finder, then choose 

one. That which is labelled 

System Photo Library is 

the only one you can use 

with iCloud Photo Library.

Mac software 
quick-fire 
questions 

If date stamps on video clips are incorrect 
after importing into iMovie, you can correct 
them using a command in the Modify menu.
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Q
When I open Mail, I often see 

a message that it’s saving 

over 800 drafts, taking up 

almost 3GB. I don’t have any drafts, 

so why does this appear?

by I A N  S L E I G H T H O L M

A
Open Mail’s preferences and 

click the Accounts tab. For each 

account that’s listed here, check 

which mailbox is set as the location for 

storing draft messages. Normally this 

will be a dedicated Drafts mailbox within 

the corresponding account. Using this 

information, you’ll need to compare the 

contents of those mailboxes in Mail with 

the corresponding locations in Finder.

Open a Finder window 

and press ß+ç+G, type 

~/Library/Mail and then 

press ®. In the location 

that opens, dig through 

the folders to find the files 

that correspond to each 

email account’s drafts 

mailbox (if that’s listed as 

Drafts in Mail, it’ll be called Drafts.mbox, 

for example.). That’s the one that should 

contain your unfinished messages. If you 

have none, there’ll only be Info.plist here; 

otherwise, you have drafts after all.

If a repair is needed, quit Mail, shut 

down any other Macs or iOS devices that 

use the same email account, and ensure 

you have a recent backup. Reopen Mail. 

In Mailbox > Erase Deleted Items, choose 

the account the problematic mailbox 

belongs to. Select the Drafts mailbox in 

the left pane and then choose Mailbox > 

Rebuild. That should clear out any old 

crud left there, and hopefully your Mac 

won’t keep saving drafts.

Phantom drafts

Mail’s preferences show the location of the Drafts mailbox for each 
account, which should correspond to an item in ~/Library/Mail.



Browsing the web may seem simple, 

but you can do so much more with the 

help of a few handy extensions and web apps. 

With a couple of clicks, you can soup up Safari and 

do things that weren’t possible before.

You can install extensions that cover all manner of tasks, 

from improving your reading experience and saving interesting web 

content to improving your productivity and keeping you safe and secure.

Even better, you don’t have to pay a penny for the privilege, as Safari 

extensions are free to install from Apple’s website.

And that’s not to mention web apps, which are a great way to work with your 

colleagues or family right from your browser. You can even use them to play 

games and revisit old versions of the classic Mac OS from the 80s and 90s.

So join us as we run through the best Safari extensions and web 

apps the internet has to offer.
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Take Safari to the next level for free with our  
round-up of the best extensions and web apps



Y
ou may have heard about 

extensions for Safari before 

without really knowing 

what they do or how they 

work. Simply put, an extension is a small 

piece of code that enables Safari (or your 

web browser of choice) to do extra tasks 

that it ordinarily would not be able to do. 

For example, you might install one 

that lets you save pages to read later 

(with extra features beyond Safari’s 

Reading List) – particularly useful if you 

expect to struggle to get online later.

Extensions aren’t just limited to 

Safari, or just to your Mac. Other web 

browsers such as Chrome and Firefox 

have extensive extension libraries on 

offer, so if you prefer those browsers 

then you’re not missing out.

You can also install extensions for 

Safari on your iOS device, where they 
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What is an extension?

are acquired from the App Store – just 

search for the extension you want and 

download it to get started. Some iOS 

extensions are enabled from the Share 

sheet. Open up that sheet, tap More at 

the right end of a row, then turn on the 

extension in the list provided.

Other iOS extensions may require 

a different setup process – make sure 

you read the instructions on the App 

Store or the extension’s website so that 

you’re in the know. 

 

Are they safe?
You might be wondering whether it’s 

a good idea to install third-party code 

onto your Mac, especially when that’s 

combined with going online. In almost 

all cases, though, they’re safe.

When looking for extensions, it’s a 

good idea to take the same approach 

you may well take with Mac apps and 

stick to the official source. It’s called 

the Safari Extensions Gallery, and 

every extension there is signed and 

hosted by Apple, so you know what you 

think you’re installing is what you’re 

getting. Those extensions are updated 

automatically, so you’ll get the latest 

fixes without having to lift a finger.

You can download extensions 

directly from third-party developers 

on their own websites, but it’s worth 

nothing that these come without the 

security guarantee that you get with 

those hosted on Apple’s website. As 

such, you should ensure that you trust 

the developer before you download 

and install an extension this way.

3 Install an extension
When you’re ready to install an 

extension, it’s super-simple: just click 

‘Install now’ and the download will begin.

1Get started
You can download extensions from 

safari-extensions.apple.com or from 

third-party developers’ websites.

4Manage in preferences
You can disable or remove the 

extensions you’ve installed by using the 

Extensions tab in Safari’s preferences.

2 Find what you need
Use the gallery’s search field (top 

right) to search for the specific extension 

you want, or browse by category.

 HOW TO Install extensions on a Mac 

If you’re thinking of 
installing an extension, 
it’s best to stick to Apple’s 
Safari Extensions Gallery.
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TinEye bit.ly/tnymgsrch
Seen an image and want to find out 

where it’s from or who it’s by? Install 

TinEye, ≈-click the image and send 

it to TinEye, which perform a ‘reverse 

image search’ to find its origin.

WasteNoTime bit.ly/wstntmtrckr
WasteNoTime is perfect if you often get 

distracted. It tracks which websites you 

spend the most time on, can lock down 

your web access and block sites when 

you’ve been on them for too long.
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Reading material

Productivity

Save all your favourite web content with these handy extensions

E
veryday life means it can be 

hard to finish what you’ve 

started reading on your Mac. 

You’ve got to get to a class, the kids 

need looking after, or there are a million 

other things that you need to do first. 

In short, life gets in the way.

If that sounds familiar, fear not. There 

are plenty of Safari extensions that let 

you save articles (or anything you like, 

really) so that you can return to them 

later. One of our favourites is Save to 

Pocket (bit.ly/svtpckt). It lets you save 

content to a reading list, and if you have 

the app on your iPhone or iPad you can 

access it there too. It also lets you access 

this content even when you are offline.

If you just want to clip items from the 

web without forming a reading list – like 

a pasteboard of ideas – Evernote Web 

Clipper (bit.ly/vrntwb) is a good addition 

to Safari. It adds a simple button that 

you use to save anything from a web 

page to your account, and it lets you 

add highlights to clipped items so you 

can draw attention to certain areas.

Read all about it
Finding good articles to read and save 

in the first place can be difficult, though, 

with the sheer number of news sources 

out there. If your Facebook and Twitter 

feeds are clogged up with all manner 

of articles vying for your attention, the 

problem is compounded.

It might sound a little old hat, but 

you may find a solution in the form of 

an RSS reader extension. A good one is 

Feeder (bit.ly/rsstlfdr). It allows you to 

read RSS feeds from your favourite 

websites just by clicking the extension’s 

button. The extension tells you when 

feeds have updated with new stories, 

and you can just mark them as read if 

you don’t actually feel like reading them.

But with all this reading, your eyes 

might feel the strain. If you find that’s 

true when you read on your Mac in the 

evening, try out the Nightlight extension 

(bit.ly/nghtlght). It’s a quick switch to 

darken web pages – so if you’re reading 

black text on a bright, white background, 

FEATURE Do more with Safari 

There are a number of handy extensions for saving and reading web content. Evernote’s Web Clipper allows 
you to collate snippets of information gleaned from the internet, and then access it on any of your devices. 

While your Mac can be a great tool for 

getting work done, it can also be a huge 

hindrance. All those distractions right 

at your fingertips can make it hard to 

concentrate on the task at hand.

But it doesn’t have to be that way. 

With a few good extensions, you can 

keep distractions at bay and work much 

more effectively than before.

These are our top four picks. They’ll 

help you get more done and keep your 

mind focused on your browser, all with 

minimum effort.



 with Safari FEATURE 
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Todoist bit.ly/tdstqckdd
If you struggle to stay organised and 

get stuff done, try Todoist – it lets you 

quickly create and manage to-do lists. 

Note that you’ll need the (free) desktop 

app as well for the extension to work.

Shoptagr bit.ly/shptgr
If you want to make a shortlist of ideas 

before you buy, try Shoptagr. It lets you 

tag products, tells you when prices fall, 

and you can access it across devices.

Parcel bit.ly/prcltbs
Instead of having a million shopping 

sites open, Parcel can consolidate them 

into one tab. You can then sort them 

into categories and track budgets, too.

Honey bit.ly/hnycpns
Honey automatically applies coupons 

when you go to buy something, shows 

you the cheapest seller on Amazon, and 

gives you cashback on things you buy.

Bitly bit.ly/btlyshrtnxtn
Sending long, unwieldy links can be 

a pain and look ugly to boot. It’s better 

to use an extension like Bitly, which 

shortens links to a more presentable 

form. You can customise the links, too.

Genius tip! After using a 

site’s own search bar, you can 

search that site more quickly. 

Type its name and keywords, then use 

the shortcut in Safari’s suggestions.

Shopping

If your eyes need a break, Nightlight can reverse 
your display so that text becomes white on black.

RSS feeds like Feeder might now sound a bit retro, 
but they allow you to tailor what news you get. 

Nightlight can reverse the colours, giving 

your eyes a break. You can make it turn 

on automatically, or operate between 

certain hours. You can whitelist websites 

to ensure that they never get darkened, 

or tell Nightlight to ignore your current 

tab but darken other pages. It can even 

give images a darker shade.

Of course, you might want a useful 

web tool when it comes to writing, not 

just reading. In that case, make sure you 

grab the Grammarly extension (bit.ly/

grmmrlysfr). It checks your spelling, 

grammar and general style as you write, 

highlighting errors so you can correct 

them on the go.

From Mac to iOS
The problem with finding a great iOS app 

when you’re on a Mac is getting that app 

onto your iOS device. After you’ve found 

it on your Mac, you then have to search 

for it again on your iPhone or iPad.

Lookmark (bit.ly/lkmrkitns) is a great 

way to avoid that kind of problem. It’s a 

simple extension that lets you save any 

iTunes content – whether that’s a movie, 

an app, an album or something else – to 

your account in the form of a ‘lookmark’. 

Once it’s saved, you’ll get a prompt on 

your iOS device to download it. There’s 

no need to look for it again, as the 

Lookmark iOS app will take you to 

iTunes to download it.

It has a few other useful features, 

too. You can tell the Lookmark iOS app 

to only download content when you’re 

on Wi-Fi, thus saving on your data 

allowance. There’s also a paid-for version 

of the app – Lookmark Premium – which 

alerts you to updates and price drops.

Recently 
closed tabs

Accidentally closed a tab you didn’t mean to? 

Just click and hold the + button at the top-

right corner of a Safari window to bring 

back any recently closed tab. 

You can also do this from 

the History menu.

Buying stuff on your Mac can be tricky, 

and keeping track of offers, bargains and 

shortlists can give anyone a headache. 

These extensions are the antidote.
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DuckDuckGo blocks trackers and ensures you get 
encrypted connections to pages on major sites.

Built-in features
Don’t miss these shortcuts to help you browse better

Extension management
The Extensions tab in Safari’s prefs tells 

you, from a privacy standpoint, what 

your extensions can do. Also, to ensure 

you get the latest versions, ensure the 

checkbox at the bottom left is ticked.

Quick notes
There’s a speedy way to make a note 

of pages you want to look at later if you 

don’t feel you need Pocket or Evernote: 

just drag and drop the page’s address 

from Safari into Notes or Reminders.

Maximise to fit
Hold å and click a window’s green 

button and the window will resize to 

what is thought to best fit its contents. 

To force a window to fill the desktop, 

hold å and double-click a corner.

Show hidden content
If you’re using a content blocker and 

want to view something that’s been 

blocked, click and hold the Reload 

button in the search field, then choose 

Reload Without Content Blockers.

FEATURE Do more with Safari 

Customise 
Safari’s toolbar

You may find that an extension 

you’ve installed adds a button to 

Safari’s toolbar. The more buttons 

are added, the more congested the 

toolbar can become.

There’s a simple fix for that. 

Choose View > Customise Toolbar 

to remove or rearrange any button.

Also, an extension may provide 

a toolbar button but not make it 

visible for you. Use this feature to 

check what’s available – the toolbar 

is helpful to ensure you don’t forget 

about extensions you’ve installed.

You can also add buttons for 

Safari features that aren’t shown 

by default, such as one for selecting 

part of a page to keep it visible in 

Dashboard. The iCloud Tabs button 

lists tabs left open on your other 

devices, without having to scroll 

down to them in the tabs overview.

If there’s one thing you really need to 

guarantee when using Safari, it’s your 

security. It’s easy to get complacent 

when using a Mac, but they are still 

vulnerable to attacks if you don’t take 

good enough care.

A strong option is TrafficLight by 

BitDefender (bit.ly/traflght). It gives 

you real-time protection that actively 

blocks suspicious websites and those 

known for peddling malware and 

phishing attempts. It also shows you 

if a website is trying to track you.

Security and privacy extensions
If you’re not so keen on tracking in 

general, DuckDuckGo (bit.ly/safddgo) 

will be right up your street. Its search 

engine doesn’t track your browsing 

habits, and it also comes with built-in 

privacy features like encryption and 

a privacy grading system for websites.

Finally, we all know how tricky it can 

be to remember all the passwords you 

use on the web. That’s compounded 

if you use hard-to-guess passwords that 

are meant to be more secure. Luckily,  

LastPass (bit.ly/sfextlast) can help out.

The idea is that you create a single 

strong but memorable password to act 

as your master password, then LastPass 

automatically generates complex ones 

for all the accounts you use. All you need 

to do is remember the master password 

and LastPass does the rest.
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Web apps offer flexible options for working. A web app like Zenkit (pictured) can really simplify your 
workflow. This comprehensive project managing app allows you to create lists, tables, mind maps and more.

Try out web apps
No need for downloads – these apps all work in Safari

Classic Mac apps
You can even relive the days of Mac 

OS 8.6 through web apps – just head 

to VirtualDesktop.org and give it a 

spin. And if you’re done with working, 

you can take a trip down memory lane 

and play classic Mac games in Safari.

The Internet Archive has a whole 

section dedicated to old-school Mac 

games at bit.ly/macintarc, including 

Frogger, The Oregon Trail and Dark 

Castle. It also has software such as 

MacWrite for you to try, and even 

Mac OS System 6 and System 7.

W
eb apps can give you another 

great way to do more with 

your browser. If you use 

iCloud.com, Google Docs or Office 365 

then you’ll have used powerful web apps 

before. They can do an awful lot of 

different things, but they’re essentially 

Mac apps that run in your browser.

If you like image editing but shy away 

from the price of apps like Photoshop, 

there are plenty of online image editors 

that you can use for free. One of the best 

examples is Pixlr Editor (pixlr.com), which 

gives you layers, masks, clone stamps, 

selection tools and much more. If you’re 

not ultra-serious about editing your 

photos, it may be the only tool you need.

Work on the web
A lot of website management tools work 

in the form of web apps. For example, 

Big Cartel (bigcartel.com) lets you 

construct an online shop from Safari.

Web apps really excel when it comes 

to collaborative working. There’s no 

need for everyone to buy and install the 

same Mac apps – they just need a web 

browser. Web apps work across different 

platforms too, from Mac and Windows 

and sometimes even iOS and Android.

For instance, MindMup.com lets 

you create mind maps that you can 

share with colleagues. 

Another great way to use web apps 

for your work is with products such as 

Dropbox (dropbox.com). 

The web app lets you access 

and manage your files from 

any computer, so you can 

move them around, delete 

them, share them, and restore deleted 

files. You can also view a file’s version 

history and restore a particular version.

Finally, Zenkit (zenkit.com) is an 

excellent all-in-one web app that helps 

you plan a project from start to finish. 

It includes list-making and table-creation 

functions, a calendar, a mind map tool, 

and a Kanban tool – a way of improving 

and managing your workflow.

With all these different web apps, 

you may never need a Mac app again!

Web apps are essentially Mac 
apps that run in your browser, 
so they’re particularly versatile

Enjoying 
what you’ve  
read so far?
Why not subscribe –  

you’ll get a great 
 free gift, too! p36



EDITED BY LUIS VILLAZON 

Inspiring ideas for 
revamping old  

Apple kit

REUSE 
OLD KIT

y collection of vintage Macs is a 

source of constant joy to me. The 

nicest ones are displayed in the 

sitting room, discretely plugged in so that I 

can fire them up whenever we have visitors. 

“Oh, this?” I say insouciantly, “Yeah, that’s a 

working PowerBook 520. Everything on that 

shelf above it is older than the web.” 

But don’t confuse my pride with avarice; 

I am not a hoarder. To prove this (to my wife, 

mainly), I am pruning my stock of classic Macs. 

Thirteen is probably too many, especially as 

most don’t work. I’m going to keep the best 

one. Or two. (Three max!) The rest, I’ll sell. 

They’re not worth much, but it’s more 

environmentally responsible than 

dumping them. And by finding good 

homes for these computers, I can 

give others a chance to annoy 

their spouses as they 

indignantly explain the 

difference between 

obsolete junk and 

a design classic. 

Sell your vintage Mac

What’s inside 

70-73
FOND FAREWELL

 Luis decides it’s 

time for a clear-out

73
SELLING ON 

 Sprucing up old Macs 

in the hope of some 

second-hand sales

Contact us

 Email your queries 

and your questions to 

lovemac@macformat.com

 Keep up to date by 

following us on Twitter  

@macformat

 Join the conversation 

at facebook.com/

macformat

 Get the latest 

subscription offers at 

macformat.com

M
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 In 2006, Apple ditched the PowerBook line and moved to Intel processors 

for the new MacBook Pro. This laptop was originally announced with a 

1.67GHz Intel Core Duo processor, but by the time it went on sale it was 

upgraded to 1.83GHz. This was the first time Apple had boosted the spec 

between announcement and launch, and it was the first Apple laptop 

that offered a choice of processor speeds when ordering. 

It ran at four times the speed of the PowerBook G4 it 

replaced, and had a thinner, brighter screen too.

 CLASSIC APPLE KIT: MACBOOK PRO (2006)

It’s time to say goodbye 
to the obsolete junk.



  

Selling old Macs LOVE YOUR MAC

Cash in the Classic 
Old Macs hold their resale value much better than PCs
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T  
he starting point in my Classic 

clear-out is a Macintosh 512K that 

mostly works. It doesn’t actually 

start, its screen remaining stubbornly black, 

but there’s an intriguing clicking sound when 

you switch it on. This might be a fan blade 

hitting a loose wire, or it could be the floppy 

disk drive trying to dislodge decades of rust. 

This Mac might appeal to someone who wants 

to scavenge it for spare parts, or perhaps just 

wants a cheap one to use for a case mod.

Plausible deniability
To prep it for sale, I gave the outside a 

thorough scrub to get the worst of the dirt off 

it (see this issue’s How To) and replaced one of 

the case screws that had gone missing years 

ago. I deliberately didn’t open up the case, 

because there was nothing to be gained from 

that. A photo of the inside won’t help anyone 

to decide if the motherboard is working, but 

if I were to discover it’s full of rust or dead 

mice, I’d be obligated to include that in the 

description. To be clear, I’m not trying to hide 

a problem that I know is there. It’s just that the 

hassle of opening and cleaning the interior 

won’t be rewarded by increased resale value.

The exterior photography, on the other 

hand, does make a big difference to the 

salability of an item. Although I haven’t sold 

any old Macs on eBay before, I have bought 

quite a few. There is a huge psychological 

difference between seeing a photo of a Mac 

on a concrete floor, in the corner of a garage, 

surrounded by paint cans and plastic bin 

liners, and a Mac on a polished, walnut veneer 

dining room table. The photo tells a story 

of how well this Mac has been treated 

throughout its life, as well as the all-round 

upstandingness of the person selling it. 

So I cleared all the junk from our nicest 

table and photographed the Mac in a warm, 

natural light. The main image for the listing 

is a three-quarter profile shot from slightly 

above. This is a flattering angle for anyone, 

because it hides a double chin. Then for 

balance, this was followed with police mugshot 

style photos of each side, as well as the rear 

and top. I also took a close-up of the rear plate 

For sale: classic 

Mac, much used.



LOVE YOUR MAC Parts and peripherals
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Quick-fire
questions 

with all the model number information, and 

close-ups of two nasty scratches on the case.

Priced to move
I listed it on eBay as ‘Vintage Macintosh 512K 

Computer M0001D Parts or Repair 1984 

Classic Mac’. There’s a lot of redundancy in 

that description, but you never know what 

search terms people will use. My description is 

also fairly verbose, basically pointing out every 

blemish and scratch. Honesty 

is always the best policy in life, 

but this goes double for eBay 

because your most valuable 

asset is your feedback score. 

I have 100% positive feedback 

since I joined in 2003, and I’m not about to risk 

that over a few quid for a second-hand Mac. 

Now, eBay wanted me to start the auction 

at £22, and said that ‘items like this one’ 

usually sell for £45-£80. But I’m not convinced 

its algorithm correctly considers subtleties in a 

description. Like the fact that it doesn’t work, 

for example. Anyway, my main motivation was 

to get this thing out of my house, not wring 

every last penny from the sale. So I started the 

auction at 99p and added a Buy It Now price 

of £29.99. I set the auction for 10 days, rather 

than the default seven, so that it will run over 

two weekends, which is when most impulse 

buying happens. Then I clicked the List button 

and settle down for the waiting game.

Forty minutes later, my phone chimed to 

say the Mac had been sold. The buyer was 

three miles from me and collected later that 

afternoon. I got them to sign a receipt, they 

paid by PayPal, job done. Was this a fluke? Did 

I just get really lucky? The next day I prepped 

a non-starting and fairly rusty Mac SE/30 the 

Is it better to sell 
a whole Mac or 

dismantle it and sell 
as separate parts?

You will usually make 

more money by breaking 

it up. A single EMI shield 

for the floppy disk of a 

Mac SE/30 is currently 

listed on eBay for 

£10.66, and this is 

basically just a bent 

piece of foil. But it will 

take much longer to find 

buyers for each piece, 

and some components 

may never sell. If your 

main motivation is to 

clear out the garage 

or loft, selling a whole 

Mac is a better strategy.

Should I include 
the keyboard 
and mouse?

This is only worth doing 

if you are selling a 

working Mac. Anyone 

bidding on a broken Mac 

wants it for spares or 

a case mod and isn’t 

really interested in the 

keyboard. These can be 

listed separately and will 

sell quickly for £20 or so.

Honesty really is the best policy 
for eBay – your most valuable 
asset is the feedback score

You should only 
sell Mac parts 
individually if you 
place little value 
on your time!

Egregious scratches like this one won’t stop your 
Mac from selling, but make sure you point them out.

This Mac has already 
been sold at auction 
at least once before.



Polish and post LOVE YOUR MAC
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1Scrape
To remove old sticky labels, turn the 

Mac so that the sticker faces up, then 

lay a wet flannel or dishcloth on it for 

20 minutes or so. Make sure the flannel 

isn’t so wet that it’s actually dripping. 

The bulk of the sticker should come 

away with some gentle scraping from 

a blunt knife or spatula.

2Remove
Remove all four T8 screws from the 

antenna plate grille and slide it back to 

clear it. You don’t need to undo the cable, 

just fold the plate out of the way. Use a 

spudger or a flat screwdriver blade to 

pry the drive cable connector from the 

motherboard and slide the drive out. Peel 

the black tape from the cable connector.

3Scrub
More stubborn stains may need 

scouring. Start with a nylon scouring pad 

and a little soapy water. Take off as much 

as you can, then switch to isopropyl 

alcohol. This will partly dissolve the nylon 

scourer, but will rinse away and won’t 

harm the Mac. Just wipe it over with 

an alcohol-soaked cloth when finished.

 HOW TO Restore the finish on an old Mac 

Next issue!
 What can you do with 

seven classic keyboards 

after you have sold 

the computers they 

were connected to? 

Luis has not just one 

great idea, but two!

same way and listed it for the same price. 

It sold in two hours. This time I had to post it, 

but I have lots of cardboard boxes and bubble 

wrap in my garage, and eBay generated the 

barcoded shipping label for the courier, so it 

was barely any extra effort. And the buyer was 

evidently happy to pay the £7 shipping fee, on 

top of the £30 for the Mac.

Shipping disaster
Evidently, I was undercharging. I listed the 

next Mac (which starts up, but has a garbled 

screen) for £40. It also sold in a couple of 

hours. I was torn between creeping the price 

up by £10 each time until I found what the 

market would stand, and just listing the rest 

of the Macs in one go for £40 a pop. 

And then I got an eBay message from 

buyer number two. He hadn’t received his 

Mac SE/30 yet. The courier company claimed 

to have made three unsuccessful delivery 

attempts, but the buyer insists he was in for 

at least two of those days and no one rang 

the doorbell. And so began a huge saga 

wherein I had to email, phone and webchat 

back and forth with the courier and eBay’s 

courier booking service. Nothing would 

persuade them to make a fourth delivery 

attempt and instead they returned the Mac to 

me. I had to then rebook the delivery (with 

another courier company). This one delivered 

on time but, in the process, cracked the front 

bezel of the Mac, because the parcel had 

crossed the length of the country thrice and 

the packaging was giving way. I had to refund 

the buyer and claim partial compensation 

through the booking service’s insurance. 

Selling old Macs is a hard way to make a 

living. Prepping, photographing, listing and 

shipping each one takes at least three hours, 

even if nothing goes wrong. That’s better than 

minimum wage, but not by much. It is however, 

much, much better than just taking them to 

my recycling centre to be ground up and 

melted down. So far, I have found happy new 

owners for five classic Macs, and even if they 

end up as glorified iPad docks or plant pots, 

they are still being celebrated for the design 

classics they are. I consider the £145 I have 

made as a sort of rehoming fee.

Donating a percentage of the proceeds to charity is the 
right thing to do, and might make people more likely to bid.

Selling old Macs is also a 
great way to get rid of that 
huge roll of bubble wrap 
you have lying around!
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Time is running out!
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SMART GARDEN

 Be proud of your 

garden again, without 

having to lift a finger! 
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 The smart garden 

party: clever watering, 

mowing and lighting, 

and home security, too
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EDITED BY CLIFF JOSEPH 

e’ve just been through a pretty 

long, cold winter with, bizarrely, 

snow falling as late as Easter in 

some parts of the country. But 

now that the sun is finally starting to shine 

again, it’s time for green-fingered gardeners 

to roll up their sleeves and tackle a few 

outdoor chores once more.

There’s an increasing range of devices 

They say the British are a nation of 
gardeners, and there’s plenty of smart 
tech that can help you care for your 
garden now that spring is upon us

W

The smart home is 
here – live the Apple 

dream today!

LIVE 
SMARTER
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that can help out in the garden these days, 

such as soil sensors that enable you to monitor 

the health of your plants and make sure they 

get plenty of TLC. But the best garden devices 

are the ones that make your life easier, such 

as smart sprinkler systems that water the lawn 

for you, and robot lawnmowers that zip around 

the garden all by themselves. 

So here’s our guide to the garden tech 

that can do all the hard work, while you soak 

up the sun (hopefully).
If you’re in need of a bit of help in the garden, smart 
gadgets can help maintain your lawn and plants.

Contact us

 Email your queries 

and your questions to 

letters@macformat.com

 Keep up to date by 

following us on Twitter  

@macformat

 Join the conversation 

at facebook.com/

macformat

 Get the latest 

subscription offers at 

macformat.com
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APPLE HOME Smart garden

company that is emerging as the new 

gardening superpower. The original Koubachi 

sensor can still be found online, but Koubachi 

is shutting down completely at the end of 2018 

so if you want to be sure of technical support – 

and future app updates – we’d recommend 

the new version, the Gardena Smart Sensor. 

You can buy the Smart Sensor on its own for 

around £110 but, as part of its master plan for 

global garden domination, Gardena is also 

selling the sensor with a number of kits that 

include other devices, such as smart sprinklers 

and robot lawnmowers, costing 

up to £1,600.

Gardena’s products start 

at around £30 for its Water 

Computer, which is a kind of 

smart valve that connects to 

your garden hose or sprinkler 

fter the winter we’ve just 

been through, your garden 

is probably feeling a little 

under the weather, so it’ll 

take some extra care and attention to 

restore it to its former glory. 

A good starting point for any smart 

garden is a soil sensor that can measure details 

such as temperature and moisture, and send 

notifications to your mobile device to let you 

know when your plants need attention.

Oddly, while there are a number of soil 

sensors available in the US, few of them 

are currently on sale in the UK – Edyn and 

PlantLink even seem to have vanished from 

Amazon UK in recent months. Parrot made 

a Flower Power sensor a couple of years ago, 

but its website says this product is no longer 

on sale. Similar products are available online 

if you (ahem) dig about. The Xiamo Mi and 

Flower Care 2 smart soil sensors are 

both currently priced around £20.

The main option for gardeners in the UK 

is the Koubachi Plant Sensor. Koubachi has 

now been taken over by Gardena, a German 

A

Forget toiling away in the garden 
for hours, get a robo mower to 
do your dirty work for you.

Here’s how to restore your 
garden to its former glory, 
without getting your hands dirty



What about apps?
 There are dozens of 

gardening apps available, 

with one of the top rated 

being GardenTags. This 

is a social media app for 

gardeners, where you can 

share information or ask 

for advice from thousands 

of other gardeners, or use 

in-app purchases to get 

personalised advice from 

professionals such as TV 

gardener Michael Perry. 

Is it safe?
 You don’t have to worry 

too much about accidents 

with a smart sprinkler, but 

robot lawnmowers can 

potentially be dangerous. 

Check what safety 

precautions are built in, 

such as sensors that can 

spot a person nearby, 

or a child lock that can 

prevent a mower being 

activated by accident.
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Smart garden 
quick-fire 
questions 

You never know, we may 
get a dry summer again… 
It would be the perfect 
excuse to start watering 
your garden the smart way.

Explained
Mesh networking

 This isn’t a mesh net to 

protect your plants; mesh 

networking uses multiple 

Wi-Fi routers around your 

home to extend the reach 

of your network (check out 

our group test on p90). 

So, a nearby mains socket 

can connect a mesh router 

and give you Wi-Fi out in 

your garden as well.
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APPLE HOME Smart garden

system. The Water Computer doesn’t use an 

app, but it does have a small LCD display that 

shows you the amount of water being used 

and provides programming options to control 

frequency, duration and the schedule. Gardena 

also sells a more advanced kit called the Smart 

Water Control Set (around £380) that includes 

both the Water Computer and a Wi-Fi hub that 

can connect to the Gardena mobile app, which 

can be used to schedule watering sessions, 

as well as providing remote control if you 

want to check on things while you’re away.

Gardena doesn’t have the gardening 

market all to itself, though. Hozelock is a 

Birmingham-based company that specializes 

in water and sprinkler systems, and its Cloud 

Controller provides a similar hose attachment 

with an app and Wi-Fi connectivity for a more 

affordable price of around £120.

Robo crop
As for mowing the lawn, there are smart 

options that can help here, too – even if they 

are a bit pricey. A number of companies sell 

robot mowers that can zoom around the 

garden and trim the lawn all by themselves, 

while you put your feet up and supervise 

with the aid of a nice, cool drink. 

These robo mowers have been 

pretty expensive in the past, 

generally starting at around 

£1,000 and going beyond the £2,000 mark for 

high-end models designed for large gardens. 

The leading company in this field is 

Robomow, which recently launched a couple 

of more affordable models for smaller gardens. 

The RX12u costs £599 and is ‘smart’ in the 

sense that it has built-in sensors that enable it 

to detect the edge of the lawn and to navigate 

around obstacles while trimming it. 

If you want more control via an iOS app, 

then you’ll need to step up to £849 for the 

RX20u model, which can be programmed 

with a mowing schedule and can split your 

garden into a series of zones for individual 

attention. There’s also a remote control 

feature that lets you ‘drive’ the mower 

from the comfort of a deck chair.

Bosch also makes a range of robotic 

mowers, but they are a little more expensive, 

starting at £799.99 for the auto-navigating 

Indego 350, or £899.99 for the app-controlled 

350 Connect model. And, of course, Gardena’s 

in there too, with its Sileno mowers, which 

start at around £650. However, Gardena, as 

mentioned earlier, has a master plan to link all 

its garden gear together via its app, so that 

you can mow the lawn, check soil conditions, 

and turn on the sprinkler using just that 

app. The app even works with devices 

from other companies too, such as 

Netatmo’s Presence security camera. 

So, while Apple, Amazon and 

Google battle it out for 

control of the smart 

home, it looks like 

there’s another 

battle for our 

smart gardens 

coming up in 

the future too.

Smart garden 
quick-fire 

questions 

In August 2017, Gardena teamed up with 
Netatmo to enable its app to control more 
than just its own garden gadgets.
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What about security?
 Most security cameras 

are designed for indoor 

use, but there are a 

number of outdoor 

cameras that can be used 

to keep an eye on your 

garden, too. Netatmo’s 

Presence (£250) cleverly 

combines a powerful 

floodlight with a concealed 

security camera, while 

Netgear’s Arlo Pro 2 is 

more expensive (£579) 

but includes two weather-

proof cameras for indoor 

and outdoor use, and 

even a powerful siren 

to scare off intruders.

 

What about 
the weather?

 The weather is becoming 

increasingly unpredictable 

these days. To keep an 

eye on things while you’re 

away, you could invest in a 

sensor, such as Netamo’s 

Weather Station (£139). 

This device monitors 

temperature, humidity, 

and barometric pressure 

so that you can schedule 

watering and other tasks 

using remote control.

Use smart lighting to highlight your hard work

SUMMER LIGHTS

When the work is done, you can 

relax and unwind in your own 

personal oasis. To set the mood, 

Philips has launched a number of 

new smart lights in its Hue range, 

which all work with Apple’s 

HomeKit (with the aid of the Hue 

Bridge, £50). The multi-coloured 

Calla ($129.99, about £90) bollard 

light can be used to illuminate 

paths. And you can dot the Lily 

spotlights ($279.99, about £200 

for three) around your garden 

for some dramatic lighting to 

highlight your eye-catching flower 

beds. The new Hue lights will be 

available in July, with exact UK 

prices coming soon.

Philips’ latest Hue smart 
lights include Calla, 
which lights your path.
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The best tech for your smart garden 

FIVE OF THE BEST

Philips Hue Lily
($280,  
about £200)
meethue.com

 This pack of three 

multicolour spotlights 

can be placed in and 

around your flowerbeds 

to create a really 

eye-catching display – 

all controllable using 

HomeKit and Siri voice 

commands. You’ll need 

the Hue Bridge (£50) 

to use Hue lights in a 

HomeKit setup.

Hozelock Cloud 
Controller
£120
hozelock.com

 This well-established 

gardening company is 

entering the digital age, 

and its Cloud Controller 

is an affordable option for 

controlling your sprinkler 

or watering system. Just 

attach the valve to your 

tap, and the hub to your 

router for scheduling and 

remote control using the 

Hozelock app.

Robomow RX20u 

£849
robomow.com

 Robotic mowers are 

expensive, but Robomow’s 

latest models finally come 

in below the £1,000 mark, 

with the app-controlled 

RX20u coming in at 

around £849. This app- 

controlled mower has a 

two-hour rechargeable 

battery, is recommended 

for lawns up to 200m2, 

and features a child lock 

for extra safety. 

Smart Sensor 
Control Set
£320
gardena.com/uk

 This comprehensive 

kit includes a soil sensor 

to keep an eye on your 

plants, along with a water 

control that attaches to 

your taps to control water 

and sprinkler systems. 

There’s also a Wi-Fi hub 

for the Gardena app – 

which can control 

Gardena’s lawnmowers 

and other devices, too.

Green fingers? Keep them clean 
and remotely mow your lawn instead!

Netgear 
Arlo Pro 2
From £579
arlo.com/uk

 It’s a little pricey, but 

this two-camera security 

kit is ideal for use in the 

garden. The cameras are 

rated IP65 weatherproof 

for outdoor use, and 

battery-powered so that 

you can move them 

around easily. There’s a 

siren to scare intruders – 

and a HomeKit update 

on the way.
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 Awarded to a 

five-star product 

we believe is truly 

exceptional in its 

category. Given solely at the 

discretion of the Editor.

 Given to a 

hardware or 

software product 

that might not be 

the very best in its category, 

but is noted for affordability.

 Our group test 

winner gets this 

award for being 

the best of its 

kind when pitted against 

other comparable products.

 The MACFORMAT Awards

 Manifesto – our ratings explained
 Our reviews are totally 

independent; we’re not 

affiliated with Apple or 

anyone else, nor are we 

influenced by advertisers. 

You can trust us to give 

an honest assessment 

of a product’s worth.

The prices quoted for 

products are correct at 

the time of writing and are 

the best we can find from 

a reputable online dealer, 

excluding delivery. 

 A brilliant thing in all regards, 

and worth every penny

 Strongly recommended; any 

flaws are only minor concerns
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 Notable flaws; look at 

alternatives as a priority

 A waste of your money and 

everyone’s time; do not buy!
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APPLE CHOICE iOS hardware

Apple Pencil 
support works 
well; for taking 

notes, it feels 
responsive 

and accurate
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 9.7-inch iPad

 From £319  FROM Apple, apple.com/uk  

 FEATURES 9.7-inch, 2048x1536-pixel Retina display, A10 Fusion chip with M10 

coprocessor, 32GB or 128GB storage, Wi-Fi only or Wi-Fi + mobile connectivity

Take note: it now supports Apple Pencil

L
ast year, Apple introduced its 

most affordable 9.7-inch iPad to 

date – the £339 fifth generation. 

It had no bells and absolutely no whistles – its 

case even copied 2013’s iPad Air, rather than 

the thinner look of the 10.5-inch and 12.9-inch 

iPad Pro. But that didn’t matter, because it 

had a great price, was reliable, had a nice 

Retina display, and was as fast as you needed. 

For a family tablet, full of games and apps that 

make good use of a large screen, it was ideal.

A year later, that model is still more than 

good enough for that job, so we didn’t think it 

would be updated so soon – but here we are. 

The new model works with Apple’s Pencil 

stylus, and features an A10 Fusion chip 

(as seen in the iPhone 7), rather than the A9 

processor (found in the iPhone 6s). That’s it, 

bar £20 being sliced off the price, so it now 

starts at a tidy £319 for a 32GB model.

It means that, if you already have last 

year’s model and are wondering whether 

to upgrade, the answer is: not really. But if 

you’ve got an older iPad or are looking for 

your first one, let’s go into what you get here.

Pixel pinch
Perhaps the most important part of any 

tablet is its screen, and though this one’s 

2048x1536-pixel display is far from cutting 

edge, it’s really good. It’s definitely the biggest 

area of difference from iPad Pro, though. 

It lacks the Pro’s wide colour gamut – a bit 

of a shame if you have an iPhone 7 or later, 

which can take photos in that colour space. 

It isn’t the end of the world, though, since 

the screen is still bright and colourful.

You also don’t get HDR support, unlike 

on iPad Pro. Again, we prefer to have this for 

watching movies, but it doesn’t have as much 

impact on small screens as on a TV, so it feels 

like a reasonable trade-off at this price. 

The pixels don’t feel as close to the surface 

as the iPad Pro’s either, but again, this is the 

difference between mid-range and premium. 

That’s the gist – even aside from size, the Pro’s 

screen is that much more luxe across the 

board in ways that justify its extra cost, but 

the one found here is definitely good enough.

That said, there is one missing feature of 

the screen we’re frustrated about: the lack of 

TrueTone, Apple’s technology that adjusts 

the screen’s colour temperature to match the 

ambient lighting of your surroundings, so 

that white on the screen looks like a sheet 

of paper would in the same light. TrueTone 

makes an iPad so much more pleasant to use, 

especially if you’re using it before bed, and if 

you’ve ever used it, switching to a device that 

lacks it feels like a big step backwards. With 

this tablet being aimed more at families (and 

especially kids), we feel that a feature that 

helps to alleviate eye strain, especially around 

bedtime, would be a really valuable addition.

 I own a 12.9-inch 

iPad Pro and agree 

that it‘s a shame this 

model lacks TrueTone. 

If you want an iPad for 

taking notes rather 

than creative tasks, 

it’s a good choice. 

However, if you want 

the benefit of pressure 

sensitivity with Apple 

Pencil, get an iPad Pro, 

as that feature isn’t 

supported in this iPad.

Alan says…

Reviewed by MATT BOLTON



9.7-inch iPad APPLE CHOICE

> THE SPECS 9.7-inch iPad (6th-generation) 10.5-inch iPad Pro

PRICE From £319 From £619

STORAGE 32 or 128GB 64, 256 or 512GB

CHIP A10 Fusion A10X Fusion

DISPLAY RESOLUTION 2048x1536 pixels, 264 pixels per inch 2224x1668 pixels, 264 pixels per inch

DISPLAY QUALITY 60Hz refresh rate Variable refresh rate (up to 120Hz)

CAMERAS
Rear: 8-megapixel, f/2.4 aperture 
Front: 1.2-megapixel, f/2.2 aperture

Rear: 12-megapixel, f/1.8 aperture
Front: 7-megapixel, f/2.2 aperture

VIDEO RECORDING 1080p (1920x1080 pixels) 4K (3840x2160 pixels)

SPEAKERS 2 (stereo in portrait orientation only) 4 (stereo in either orientation)

BATTERY LIFE (WI-FI) Up to 10 hours of browsing/video/music Up to 10 hours of browsing/video/music 
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HEAD TO HEAD

Apple Pencil support works well. When 

you’re writing notes, it feels responsive, 

accurate and slick. Inevitably, iPad Pro has 

it slightly beat, thanks to its screen refreshing 

at up to 120 times per second, compared to 

60 here. So, sketching with fast movements 

reveals a tiny bit of lag in the lines appearing 

on the screen, whereas it seems instantaneous 

on second-gen iPad Pros. It’ll only annoy if 

you’re planning to do high-level art – if that’s 

your bag, you should look at a Pro anyway.

Performance
Performance and responsiveness everywhere 

else are also great. The A10 Fusion chip isn’t 

quite as powerful as iPad Pro’s A10X, but we 

had no speed issues in web browsing, editing 

docs, gaming, or GarageBand and iMovie.

Multitasking features of iOS are well 

supported, so you can have apps side by side, 

or have one floating for quick access, without 

any slowdown. The 9.7-inch screen doesn’t 

make for a dual-app productivity powerhouse, 

but we found it fine for researching in Safari 

on one side and writing in a doc on the other.

Battery life is solid, due to a big capacity 

and a phone-level processor. Apple claims 

10 hours, as usual for iPads, which is fairly 

conservative in light use with the screen 

lower than full brightness. Conversely, a long 

game of Civilization VI will mean a lot shorter 

life. On standby, a couple of per cent is lost 

each day, so there’s rarely the frustration of it 

being dead when you want to watch YouTube.

Speaking of video, while the iPad is fine 

overall, its speakers are a bit weedy, and they 

work in stereo only in portrait orientation. 

Though clear enough, there’s a disappointing 

lack of oomph; another trade-off at this price.

The front and rear cameras are unchanged 

from the last model, meaning they’re fine. 

They work well enough for FaceTime, pick up 

surfaces nice and clearly in augmented reality 

apps, and image quality is decent. They’re 

nowhere near as good as what you’ll find 

in the latest phones, but they do the job.

The £319 model’s 32GB of storage is also 

solid. If you’ll primarily use the iPad to watch 

video and browse the web, and perhaps play 

a few games, that amount of storage should 

be plenty. If you’re likely to fill it with photos 

and your own videos, £409 for 128GB is a 

reasonable upgrade price.

 Pencil adds to the 
cost, and there’s 
room to improve, but 
this is still the best 
mid-range tablet.

 Great performance

 Supports Pencil

 No TrueTone display

 Speaker setup

VERDICT

The latest 9.7-inch iPad retains 
the same body used by last year’s 
model and even 2013’s iPad Air.
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Comprehensive network control

 £179.99  FROM Asus, asus.com/uk  NEEDS 802.11ac Wi-Fi 

(up to 1,734Mbps), Gigabit Ethernet, Asus AiProtection device 

security, parental controls, file and print server

W  
ell, we have to 

wonder: did the 

name come first, 

or did the design follow? 

Did one of the hardware 

engineers at Asus wake up 

from a surreal dream? 

One thing’s for sure, 

Blue Cave, with its toroidal 

cavern gouged through the 

middle, is pretty unique-looking for a router. 

As far as we can tell, there’s no practical reason 

for this design, but it certainly gives Blue Cave 

a visual edge over its competitors. 

Around the back, the design isn’t as 

radical. There’s a Gigabit Ethernet port to 

hook up to your modem, four Gigabit ports 

for other connected devices, and a USB 3.0 

(Type A) port for additional expansion. There 

is also a physical off switch and a hidden WPS 

button for easy device connection.

Snappy channnels
In terms of performance, we’ve tested routers 

with more powerful distance coverage, but 

Blue Cave’s dual radios, which broadcast on 

distinct 2.4GHz and 5GHz networks rather 

than meshing the two together, are notably 

 Blue Cave’s extra 
gimmicks make it 

more than the 
sum of its parts.

 Great throughput

 Additional protection

 Interesting design

 Some dead spots

VERDICT

snappy. We had no trouble streaming 4K video 

over Wi-Fi, and didn’t experience any notable 

lag when gaming.

What Blue Cave lacks in sheer broadcast 

strength, it makes up for by being one smart 

cookie of a router. From the very beginning, 

it shines over many of its competitors, with a 

straightforward set-up process, a super-simple 

task that you can do with the Asus Router iOS 

app. Granted, the app itself isn’t the prettiest, 

and it feels a little rough around the edges, 

but once you’re up and running, it’s thorough 

enough and is regularly updated. You can also 

control the router using Amazon Alexa.

Family management is one of Blue Cave’s 

strong points, with Asus’ AiProtection 

enabling you to collect devices into groups, 

then apply usage restrictions to manage what 

those groups are able to access and when. 

The app makes it easy to set schedules and 

to view reports on internet activity.

You can also add per-device bandwidth 

limiting, to prevent someone hogging all the 

data. In addition, there’s security built in from 

TrendMicro, which adds a layer of protection 

to everything on your network, including 

notoriously vulnerable Internet of Things 

devices. Blue Cave also makes the most of 

the various functions of that aforementioned 

USB port with built-in FTP and Samba file 

sharing, and its own print server. 

Asus Blue Cave

Asus Blue Cave is an aesthetic marvel and boasts a good 
range of features, including great security options.

APPLE CHOICE Mac hardware
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What Blue 
Cave lacks in 

broadcast 
strength, 

it makes up 
for by being a 
smart cookie

Reviewed by ALEX COX

Among the ports on the back is a USB-A port, which you 
can use to share a printer or storage on your network.



ION360 U
Stream 360° video from your iPhone

F
or generosity of 

ports, CalDigit’s 

new dock wins by a 

whisker over the previous 

best from OWC (MF #321). 

Here you get 14 ports for 

connecting peripherals and 

accessories to your Mac, 

plus a Thunderbolt 3 port 

that supplies up to 85W to a 

MacBook Pro, so it can even 

charge a 15-inch model.

The dock’s front side has 

the same USB-A and discrete 

3.5mm headphone and mic 

jacks as the non-Plus model, 

and adds a 5Gbps (USB 3.1 

Gen 1) USB-C port and an 

SDXC card reader.

On the back, 

CalDigit has removed 

the niche eSATA ports 

of the previous model 

and doubled the USB-A 

ports to four. There are 

still Gigabit Ethernet, 

DisplayPort 1.2 and 

a passthrough 

Thunderbolt 3 port (enabling 

connection of one 5K or two 

4K displays), and two new 

ports: S/PDIF optical audio 

output, and a 10Gbps USB-C 

port (USB 3.1 Gen 2) – great 

for high-speed SSDs.

The price is high, but a 

spare MacBook Pro power 

adaptor would normally cost 

 £299.99   FROM ION360, uk.ion360.com  

 FEATURES 360° photos and video, live streaming, charging case

around £100 with a cable.

However, don’t mistake 

those words and the dock’s 

compact size as meaning this 

is also an alternative to a plain 

power adaptor; the dock’s 

external power supply adds 

a fair bit of bulk to it. 

ALAN STONEBRIDGE

 Easy to use for 
photos, video and 

streaming, but image 
quality is lacking.

 Easy 360° streaming

 No image levelling

VERDICT

 Despite the price, this 
is our Thunderbolt 3 

dock of choice due to 
its generosity of ports. 

 Eight USB ports!

 A costly investment

VERDICT

CalDigit TS3 Plus
A dock with ports aplenty

 £349  FROM CalDigit, caldigit.com 

 FEATURES 14 expansion ports, up to 85W power to charge MacBook Pro

The ION360 U 
makes it easy to 
shoot 360°, but 
the price is high.

There’s a pleasing 
selection and 
arrangement 

of ports.
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T
he popularity of 

360° photos and 

videos is growing, 

and so is the associated 

list of gear. The ION360 U 

aims to stand out by being 

a 360° camera, a case, and 

a top-up battery, all in one. 

Its twin lenses capture 

half of the 360° scene each, 

and the ION360 app does a 

reasonable job of stitching it 

together. The app offers 360° 

photo (3840x1920 pixels), 

video (at 4K), and streaming 

modes; with a few taps you 

can be streaming 360° media 

live to Facebook or YouTube.

It’s easy to use, but there 

are flaws. First, there’s 

nothing included to protect 

the twin bulbous lenses or to 

mount the case on anything, 

so it’s at risk of scratches in 

your pocket, and you’ll have 

your hand looming large 

while shooting. True, you 

can buy extras that deal with 

these issues, but they really 

should be standard at this 

kind of price point. There’s 

no levelling applied to shots, 

so you need to keep things 

dead upright or you’ll get 

oddly tilted scenes. The shots 

aren’t the sharpest, but are 

okay for casual shooting.

Overall, it’s a clever idea 

and the hardware is well 

made, but a protective 

case should be included 

and image quality could 

be better. KEITH MARTIN



Mac/iOS hardware APPLE CHOICE

SC-GA10 Smart Speaker
Google finds a home with Panasonic
 £229.99  FROM Panasonic, panasonic.com 

 FEATURES Bluetooth, Google Assistant, multiroom support

P
anasonic’s SC-GA10 could be 

a game-changer: this Google 

Assistant-based wireless 

speaker can not only hold a tune like 

more traditional Bluetooth speakers, 

it sounds better than some of them.

With Chromecast built in, the speaker 

can receive audio directly from apps like 

Deezer, TuneIn, Google Play and Spotify. 

The GA10 can also merge into a wider 

Chromecast multiroom speaker network.

The speaker’s finish, from metallic base 

to fabric cover, is reassuringly premium. It’s 

also surprisingly big for a desktop speaker. 

It stands at 284mm tall and weighs 1.7kg. 

And that’s without the external power brick.

This is essentially a wireless speaker, but 

you also get a 3.5mm stereo input jack, and 

there’s Bluetooth, which may occasionally 

be more convenient than Wi-Fi or streaming 

from the internet directly. The touchpad on 

top controls volume and input selection. 

Setting up is brilliantly simple. You’ll have 

your Google Assistant online and yakking 

shortly after downloading the Google Home 

app. Panasonic’s Music Control app can be 

used for direct control, and offers bass and 

treble adjustment.

The sound of musicality
The sound stage is wider and more insistent 

than you might expect from the vertical 

design, thanks to custom diffusers spreading 

the output of the tweeters. The SC-GA10 

doesn’t just go loud, however – it has punch 

and musicality. The mid range is smooth, 

while treble is given the headroom to shine. 

It’s also fast enough for rhythmic bass. 

Inside the speaker is an ingenious driver 

stack that looks like it should be on stage at a 

Lilliputian Glasto. Two offset 2cm soft dome 

tweeters sit atop an 8cm woofer; a contorted 

bass reflex port has been tuned for richness 

and balance. The speaker can’t really 

distinguish instruments spatially, an 

inevitable consequence of its form factor.

The power output of the speaker is rated 

 A great-sounding 
Bluetooth speaker 

with an intellect 
to match. 

 Great performance

 Premium build quality

 The mic array can 

be unresponsive

 A little low on power

VERDICT

Inside is an 
ingenious 

driver stack 
that looks like 

it should be 
on stage at 
a Lilliputian 

Glastonbury

at 2 x 20W, but this rather undersells its 

performance. It can fill the average living 

room with energy and clout. 

The SC-GA10 is one of the best sounding 

smart speakers currently available. It’s 

immeasurably better than (the admittedly 

cheaper) Google Home. The problem, though, 

is that the speaker often turns a deaf ear to 

voice commands when playing music. It’s as 

if its noise-cancelling microphone array just 

can’t cope with volume.

When it won’t respond to “Hey Google” 

hails, you’ll have to fumble around for the 

on-body controls, or go to Panasonic’s own 

app, and this rather spoils the illusion of 

futuristic control. STEVE MAY

Say goodbye to remote control. Although you will have 
to speak up if your music selection is at high volume.
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  CHOICE

Cinematic shooting becomes a reality
 £129.95  FROM DJI, dji.com  FEATURES Video stabilisation, ActiveTrack subject tracking, USB port for phone charging

D
JI makes some very advanced 

camera and drone technology 

for professional film-makers, 

but its latest offering is significantly more 

affordable. Osmo Mobile 2 is a smartphone 

‘gimbal’ – a device that allows a camera to 

rotate smoothly in many different directions. 

The handle of the device contains its 

battery, which is charged over Micro-USB and 

can last for up to 15 hours’ of use A secondary 

USB port enables you to charge your phone 

from Osmo Mobile 2’s battery. 

Mount your phone using the adjustable 

and secure grip, download the DJI Go app, 

then pair your phone with the unit. You also 

have to calibrate the unit with your phone, to 

let it know where the weight is distributed. 

Osmo Mobile 2 works in basic mode with 

any camera app, but its full functionality is 

reserved for the DJI Go app. You can manually 

orient the phone in portrait or landscape mode 

(after disabling orientation lock in iOS) and 

the hardware will recognise it and react 

accordingly. Once the devices are linked using 

Bluetooth, the phone automatically turns to 

face you. Move the whole thing around and 

it maintains smooth, cinematic sweeps, 

continually adjusting to keep things balanced. 

There are several modes available –  

 An affordable way to 
get amazing cinematic 
shots on your iPhone.

 Smooth camera motion

 Copes with movement 

 Advanced controls

 App forces sign in

VERDICT

upright, underslung, flashlight and portrait, 

into which the unit switches based on how 

you position it. 

Joy to use
There’s a four-way joystick on the handle for 

precise control of the phone’s orientation, and 

a zoom control for wider or tighter framing. 

The Record button triggers the camera, and 

inside the GO app there’s a ton of options for 

video quality, active tracking, slow motion or 

time-lapse recording, pitch lock to maintain 

level during movement, and even manual 

controls for ISO, white balance and shutter 

speed. Captured media can be exported to 

various sites, as well as via a Share sheet to 

iCloud Drive, Google Drive and other locations. 

DJI highlights the Osmo 2 Mobile’s 

usefulness for self-broadcasting and that’s 

certainly one of its strengths. As a film-making 

tool, however, it’s a more serious proposition, 

with its ability to provide very smooth 

panning shots, track a subject as you move, 

and eliminate shake and sudden movements. 

The effect is almost magical, and cinematic in 

ways you wouldn’t believe from a smartphone. 

If you’re shooting with an iPhone on a budget, 

this will absolutely give your productions a 

more professional feel. HOLLIN JONES

Osmo Mobile 2

The internal motors keep 
the camera balanced in the 
different tracking modes.
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Samsonite 
Pro-DLX 5 15.6in
 £195  FROM Samsonite, samsonite.co.uk  

 FEATURES RFID-blocking pocket, 23 pockets 

> If backpacks aren’t your thing but you still 

want great protection and plenty of pockets, 

the Samsonite Pro-DLX 5 is a good choice. It’s 

incredibly spacious for a briefcase bag, with so many 

pockets you probably won’t know how to fill them 

all. The MacBook pouch is lined with foam bobbles, 

and there’s a (removable) strap if you prefer using it 

as a messenger bag.

STM Goods Trilogy
 $79.95 (about £566)  FROM STM Goods, 

stmgoods.com  FEATURES Waterproof outer 

material, 14 pockets

 

> A good MacBook backpack doesn’t have 

to break the bank. The STM Goods Trilogy 

is supremely comfortable and looks great, 

with lovely highlights and design flourishes. 

Your MacBook is held just off the bottom of 

the bag to protect it from bumps and bruises. 

Space can get tight if you like to carry a lot, 

but if you’re looking for a bargain bag with 

looks to kill, it’s hard to beat.

W  
orking on the go with your MacBook means that 

protecting it is an absolute necessity. You don’t want 

to spend a load of money on a beautiful notebook, 

only to have it bashed and bruised when you carry it around. 

To help you give your MacBook the protection it needs, 

we’ve rounded up four different bags that can help protect 

your precious computer. We’ve gone for a mix of different 

types, with backpacks, tote bags and messenger bags all 

making an appearance. So, read on to find out which is the 

best option for you and your MacBook.
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Targus City 
Smart Slipcase
 £39.99  FROM Targus, targus.com  

 FEATURES Optional shoulder strap, 5 pockets

 

> If the Samsonite is up your street but a bit 

too costly, the Targus City Smart Slipcase 

might be just the ticket. The outer padding 

is solid, although the bag is much lower on the 

pocket count than some of the other options 

in this test, so if you’re something of a hoarder 

then you might want to look elsewhere. Still, 

it’s a very affordable option if you baulk at the 

Samsonite bag’s price.

Knomo Harewood
 £199  FROM Knomo, knomobags.com  

 FEATURES RFID-blocking pocket, 11 pockets 

> The Knomo Harewood is about as stylish 

as MacBook bags get. It’s a tote bag with 

optional backpack straps, and the classy 

styling shows design was a priority for Knomo. 

However, that flair comes with a price and at 

the expense of pocket space – it’s not the most 

capacious of bags. Still, each bag’s unique ID 

could help you reunite with it if you lose it.
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Reviewed by ALEX COX

APPLE CHOICE Group test

A mesh network takes home networking 
to the next level of reach and simplicity

 

MESH 
NETWORKS

ON TEST…

 BT Whole Home Wi-Fi   £189

 Google Wifi  £329

 Linksys Velop  £399.95

 Netgear Orbi Pro  £479.99

 TP-Link Deco M5  £229.99

 Zyxel Multy X  £249
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T
here’s no question about 

it: mesh networks are 

hot right now. It’s not 

just marketing hype – though their 

manufacturers no doubt love the fact 

that they can charge a little more for 

home networking hardware. It’s a real 

change in the way networking operates 

that makes a massive difference to 

coverage and speed. 

Mesh networking is a fairly simple 

concept. Rather than relying on a 

central router, which can be difficult 

to extend, mesh uses individual nodes, 

each of which shares a signal with the 

others through what’s called a backhaul 

channel. Add a new node to your mesh 

network, and it simply joins that 

behind-the-scenes channel – as long 

as one of your nodes is close enough to 

talk to it, your network can go further. 

If you have Ethernet strung through 

your home, you’ll often be able to use 

that as a backhaul, enabling faster 

communication and freeing up radio 

space for more traffic.

Above the backhaul channel, 

typically, comes a collection of cutting-

edge Wi-Fi radios. Each member node 

of a mesh network looks after its own 

little area of space – your Mac, your 

phone, and your other devices simply 

and seamlessly connect to the node 

that has the highest signal strength 

from wherever they are.

There are some downsides, 

however. A standalone router 

doesn’t need to do between-

device intercommunication, 

so you’ll suffer slightly more 

lag with a mesh. You’ll need 

to plug in a number of devices 

around your home, marginally upping 

your power bill and tying up sockets. 

And the initial cost is quite high as 

you’re essentially purchasing a bunch 

of routers at once – although the 

difference isn’t always that extreme.

Your devices seamlessly 
connect to the node that has 
the highest signal strength

Things to consider…
What you need to know before getting started

1 Home size
Do you really need a mesh 

network? If you’re living in reasonably 

close quarters, the answer is probably 

no. Mesh networks are best suited 

to larger homes, or those built of 

particularly dense materials that 

cause Wi-Fi dead spots.

2 How many nodes?
If your Wi-Fi does need the 

range extension that mesh offers, how 

many nodes will you require? Check 

the specs of the mesh network you’re 

looking at – there’ll generally be a 

suggested range per node – and 

compare it to your home’s dimensions.

3 Current kit
If your router is currently 

working fine, don’t jump on the mesh 

bandwagon if you’re looking for speed; 

while mesh networks are efficient, 

you won’t find a big speed boost 

unless you’re currently struggling 

along on an outdated version of Wi-Fi.

4 Available sockets
Your nodes will each need 

powering, so they must be placed close 

to a power outlet. This isn’t a huge 

deal, since nodes are generally pretty 

flexible about where you place them, 

but they’ll need good communication 

with other nodes wherever they go.

5 Cheaper options
Throwing everything away 

and replacing your kit with a mesh 

network will certainly offer up results, 

but a Wi-Fi extender, or some cheap 

Powerline adaptors, may be all you 

need to quash those dead spots. 

Think carefully.

How we 
tested
 To make the test fair, 

given the differing 

number of nodes 

included with each 

system, we set up 

two nodes of each 

in matching positions, 

in a three-floor house 

with known signal dead 

spots. One node was 

then moved close to 

the front of the house 

to measure signal 

distance outdoors, 

and signal strength was 

tested from predefined 

points. Each was set up 

and configured using 

its respective iOS app.

Higher…
Ubiquiti Ammplifi  

amplifi.com

£370

 Not much tops the Orbi 

Pro’s price. Ubiquiti’s 

AmpliFi system, which 

includes a router and 

two socket-mounted 

nodes (with adjustable 

antennas), comes pretty 

close though at £370.

…or lower?
Netgear WWN3000RP

netgear.co.uk 

£19.99

 Netgear’s socket-

mounted extender isn’t 

mesh, and it’s not the 

fastest with its single 

802.11n radio, but it’s 

only £20 and will cover 

an awkward dead spot.
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 Power, in mesh, is a little relative – 

when you’re distributing the load, you 

don’t really need a lot of individual muscle. 

So while Google’s AC1200 radios might 

look ‘weak’ when compared to the AC3000 

combos of the Multy and Orbi nodes, 

there’s not a huge speed difference, even 

when loading up the network with a couple 

of 4K streams. Google’s programming and load balancing are 

top-notch, but the power dip translates into a slight lack of reach. 

BT’s many communications channels – the setup uses a 4x4 

MIMO radio combo – means it blazes along even without its own 

dedicated backhaul; Zyxel’s nine-antenna, dedicated backhaul 

setup gives the Multy X impeccable performance and reach; and 

Velop flies when talking to the wireless card of a modern Mac. 

Even the TP-Link Deco, a shred less strong in terms of numbers, 

is powerful enough.

 The set-up process is something mesh, 

in general, does well. None of the products 

tested here are particularly difficult to 

connect. Some are more involved than 

others, but the contrast isn’t huge. Linksys’ 

Velop, for example, is one of the slickest 

we’ve seen – plug it in, open the app, and 

it’s all hooked up in a couple of minutes. 

On the other hand, Google’s initial process can take a while, 

but adding additional nodes is fuss-free. The Deco, Orbi and Multy 

X use Bluetooth to create that initial connection, which simplifies 

things, and BT’s on-disc connection details and coloured LEDs 

make for a slick setup, though not every initial connection was 

as trouble-free as it could have been in our testing. The Multy X, 

in particular, put up a fight, taking an hour of fiddling and 

resetting before it finally acquiesced, despite its straightforward 

instructions and seemingly basic installation method.

 Everyone does mesh a little differently. 

BT’s solution, for example, is a bridge. 

This means it doesn’t actually do any of 

the heavy lifting – you need to hook it up 

to your existing router to manage DHCP 

and the like, then each of its nodes works 

as an access point. Netgear’s Orbi system 

has a specific node that manages routing, 

and satellite nodes that communicate with that. 

The rest can attach any node to your modem – but you’ll 

lose access to Ethernet connections you might already have 

hooked up to your current router, which might necessitate a little 

reorganisation of your network, particularly if you’re currently 

running a smart hub or a network printer. Realistically, though, 

no mesh network is particularly complex. It’s a much smoother 

ride than trying to extend a network with traditional Wi-Fi 

repeaters, but it pays to know what’s different.

 Mesh is generally app-controlled, and 

that gives you access to more than just a 

few stats. TP-Link’s Deco app gives you 

an extra layer of network-wide antivirus 

protection, which may provide some 

peace of mind, and parental controls 

are a common feature on everything 

but the Orbi Pro – though bear in mind 

that it’s slightly more business-minded than the standard Orbi, 

which features ‘Circle with Disney’ parental controls, so you 

can at least get a little deeper with your network traffic control. 

BT’s Whole Home Wi-Fi app isn’t brilliant, and TP-Link’s 

effort is a little more confusing than the others, whereas Zyxel’s 

well-designed app gives good access to its security features. Google 

and Linksys shine in this department with a pair of excellent apps. 

Neither provides a huge amount of depth or control, but for 

fire-and-forget mesh, they’re comprehensive enough. 

TEST RESULTS

TEST RESULTS TEST RESULTS

TEST RESULTS

Test 1 Getting connected

Test 3 Complexity Test 4 Security and app

Test 2 Power rating
How hard is it to hook up?

Simple Wi-Fi or something more? Because control is important

The quest for a super signal

BT Whole Home Wi-Fi   

Google Wifi 

Linksys Velop 

Netgear Orbi Pro 

TP-Link Deco M5  

Zyxel Multy X 

BT Whole Home Wi-Fi   

Google Wifi 

Linksys Velop 

Netgear Orbi Pro 

TP-Link Deco M5  

Zyxel Multy X 

BT Whole Home Wi-Fi   

Google Wifi 

Linksys Velop 

Netgear Orbi Pro 

TP-Link Deco M5  

Zyxel Multy X 

BT Whole Home Wi-Fi   

Google Wifi 

Linksys Velop 

Netgear Orbi Pro 

TP-Link Deco M5  

Zyxel Multy X 

APPLE CHOICE Group test
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 How 
do they 
compare?

 I keep considering 

mesh networking for 

our home, but our 

main computing use 

is gaming, and none of 

us want to put up with 

the latency. I think if you 

have a very large house, 

and perhaps often work 

at home, it’s more of a 

worthwhile investment. 

For our humble abode 

and video games habit, 

extenders are a much 

more appropriate and 

affordable option. 

Paul says…

curse if you’d rather keep your smart home 

bridges in one place, although a cheap Ethernet 

hub would solve that problem in a flash. While 

we love the look of the individual nodes, many 

of its rivals manage to be less conspicuous. 

There are also cheaper mesh 

networks and, as our final 

scores below show, there’s 

surprisingly little to be lost 

by investing less. 
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L
inksys’ Velop is, as far as we’re 

concerned, the top home mesh 

network on the market today – 

it’s no wonder Apple has started selling 

it through its own storefront. The 

individual nodes are elegant and don’t 

take too much surface space, the setup 

process is flawless, and the app, despite 

offering relatively few controls, is perfect for 

what Velop aims to achieve: utter simplicity. 

It also manages to top the rest of  the networks 

on offer, bar the business-class Orbi Pro, in 

terms of range and power, coping with 

whatever we could throw at it.

That’s not to say Velop is without its flaws. 

Its relative lack of Ethernet ports could be a 

The individual nodes of the Linksys 
Velop are elegant; the setup process is 
flawless, and the app is perfectly simple

Note: The final verdict scores reflect the overall opinion of a product and are not necessarily an average of the criteria listed in the table.

> THE SPECS BT Whole Home Wi-Fi Google Wifi Linksys Velop Netgear Orbi Pro TP-Link Deco M5 Zyxel Multy X

PRICE £189 £329 £399.95 £479.99 £229.99 £249

PACKAGED NODES 3 3 3 2 3 2

RADIO AC2600 AC1200 AC3000 AC3000 AC1300 AC3000

ANTENNAS 4x4 MIMO 2x2 MU-MIMO 2x2 MU-MIMO 3x3 MU-MIMO 4x4 MU-MIMO 4x4+1 MU-MIMO

ETHERNET PORTS 1 per node 2 per node 2 per node 4 per node 2 per node
3 per node,  
plus modem

DIMENSIONS 7.7 x 16.5 x 16.5cm 10.6 x 10.6 x 6.8cm 7.9 x 7.9 x 18.5cm 17.2 x 8.3 x 24.6cm 12 x 12 x 3.8cm 17 x 5 x 23cm

GETTING CONNECTED

POWER RATING

COMPLEXITY

SECURITY & APP

OVERALL

THE WINNER  
Linksys Velop
An easy-to-use and 
super-fast system

Velop’s columns use colour-coded 
LEDs to indicate their status.



Organise and quickly open apps

T
oolbox is a 

disparate 

collection of tools 

that are accessible via a 

menu bar icon. Click this 

and a collection of icons with 

descriptive names makes it 

easy to choose from version 

2.5’s more than 30 tools.

The tools are designed 

to plug gaps in macOS, and 

range from Download Video 

(drag and drop links from 

YouTube and the like) to 

adding a menu bar icon for 

swiftly switching between 

different resolutions. 

The last two updates 

have added six tools: Find 

sidebar. Items can be tagged, 

too, so you can create groups 

of apps, or categories to 

house apps, files, and folders 

for specific projects. 

There are a few issues. 

Tags must be assigned in 

Start’s preferences – you 

can’t drag items to tag 

categories when the list 

is open. Items can’t be 

renamed, which makes 

 £15.99/year  FROM Parallels, parallels.com  

 NEEDS OS X 10.10.5 or later

 £4.99  FROM Gerald Koeder, start.innovative-bytes.net  

 NEEDS macOS 10.12 or later

adding iCloud folders 

pointless (as they all end up 

named Documents). Also, 

Start can’t assign system-

wide keyboard shortcuts 

to items, nor colours to tags 

rather than just to individual 

apps. Still, most of these are 

more feature requests than 

shortcomings. Where it 

matters, Start excels.  

CRAIG GRANNELL

 What should 
be a triumphant 
update is spoiled 
by the price rise.

 A large 

selection of tools

 Price increase

VERDICT

 An efficient, 
streamlined, and 

customisable launcher 

 Open apps, files 

or folders quickly

 Can’t rename items

VERDICT

APPLE CHOICE Mac software

Duplicates, Make GIF, Clean 

Drive, Resize Image, Free 

Memory, and Screenshot 

Page. The purposes of most 

are obvious – Screenshot 

Page, say, is for capturing 

long web pages as a single 

image in your browser. 

Toolbox 2.5 also improves 

existing tools, and it’s now 

possible to assign keyboard 

shortcuts to your favourites. 

Parallels Toolbox

  
 

Tools to fill in macOS’s gaps

This is a little awkward – 

there’s no prompt to warn 

you that a key combo isn’t 

available; the shortcut simply 

doesn’t appear.

Another less welcome 

development is that the cost 

has doubled, which knocks 

some gloss off the additions. 

That’s a shame, as Toolbox 

is shaping up nicely. 

NICK PEERS

S  
tart brings a bit 

of order to your 

Mac apps. Click its 

menu bar icon (or press your 

chosen keyboard shortcut) 

and you get an alphabetical 

list of apps (assuming 

Spotlight indexing is on). 

The list can be filtered by 

typing a search term for the 

app you need. Navigate using 

the arrow keys, and click an 

app to open it. Easy.

But Start is more than 

just a list of apps. Using its 

customisation options, you 

can add files and folders, 

which then appear as 

separate categories in its 

You can now assign keyboard 
shortcuts to individual tools.

If you want specific items to stand out, 
assign them a coloured background. 

Start
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Clean up your Mac’s files

U
nlox is the name 

for the latest 

version of MacID 

(as Apple objected to the 

name). The concept remains 

the same and focuses on 

remotely locking and 

unlocking your Mac using 

your iPhone or Watch. 

Recent versions of 

macOS include a feature for 

a Watch to unlock your Mac, 

though it’s more simplistic 

than Unlox. This app gives 

you multiple options, all of 

which work over Bluetooth 

LE. The simplest is the 

facility to lock or unlock 

your Mac’s screen by tapping 

Advanced mode you can find 

by date, location, and even 

the camera that was used.

Searches are quite quick. 

When finished, Tidy Up 

provides suggestions for 

removal, showing a preview 

and the location of each file.

The problem with the 

app isn’t what it does, so 

much as the damage you 

could do with it. Tidy Up 

 £3.99  FROM Kane Cheshire, unlox.it  NEEDS iOS 11.2 or later,  

macOS 10.13, Bluetooth LE on your Mac and iOS device

 $28.99 (about £20)  FROM Hyperbolic Software,  

hyperbolicsoftware.com  NEEDS macOS 10.12 or later

doesn’t remove duplicate 

images in Photos and other 

libraries, but marks them 

for later removal. We still 

wouldn’t unleash it on an 

important Photos library, 

though. It’ll happily remove 

files from apps and Time 

Machine backups, making 

them unusable. So, use the 

app’s power with caution. 

HOWARD OAKLEY

 An efficient way 
to easily auto-lock 
your Mac’s screen.

 Great for security

 macOS now allows 

unlock via Watch anyway

VERDICT

 Tidy Up is a great  
housekeeping tool, 

but use with caution!  

 Excellent interface

 Can ‘break’ documents

VERDICT

the iPhone or Watch app. 

You can use Touch ID or 

Face ID on a phone or even 

a special pattern tapped on 

your Mac’s trackpad to do 

this. The Watch remains 

authorised as long as it’s on 

your wrist, so its app just 

needs a tap. On iPhone or 

Apple Watch, notifications 

let you know when locking 

activity is taking place. 

Unlox
Easily unlock your Mac

Unlocking is fast and 

smooth. More interestingly, 

Unlox can automatically lock 

or unlock your Mac when 

you move away or toward 

it by a specific distance. 

This is really clever and 

means you’ll never forget to 

lock your screen when you 

leave the Mac, or have to 

enter a password when you 

come back. HOLLIN JONES

K  
eeping a busy Mac 

clear of duplicate 

and unnecessary 

files can be a full-time job. 

Tidy Up 5 aims to keep your 

Mac clear of that clutter by 

seeking it out for you and 

making it easier to delete.

It dresses up a mundane  

task with a pretty interface 

that has smoothly animated 

transitions. It also provides 

honest information about 

why a search is taking time. 

You can pick from Simple 

and Advanced modes, which 

request different levels of 

detail. Simple image search 

finds identical pictures; in 

The iPhone app provides a simple way 
to lock and unlock your Mac remotely.

Tidy Up searches inside 
photo libraries and marks 
duplicates for removal.

Tidy Up 5
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An imaginative puzzle game

S
implicity is a 

laudable goal 

for an app. And 

’sodes is minimalist in its 

pursuit of podcast purity. 

The app works well in 

foregrounding the important 

things – the podcasts.

The app only subscribes 

to and streams podcasts; 

there’s no downloading 

capability, so you need to 

be happy about it potentially 

burning through your data 

allowance or always aware of 

your nearest Wi-Fi hotspot. 

Search for a podcast by name 

or address, then add it to 

your favourites and stream 

Clambering up a vine, 

it snaps. This time, there 

are four options – giant 

mushrooms, pink beasts 

with dangly tails to grab, 

and a spiky plant that might 

work as a ‘ladder’.

The difficulty quickly 

ramps up. Scenes introduce 

panels that move, multiple 

panels and multi-step 

solutions. Single-screen 

 £2.99  FROM Alike Studio, bringyouhomegame.com  

 NEEDS iOS 8 or later

scenes become complex 

webs. Sometimes the logic is 

a touch suspect, and a little 

reliant on trial and error.

Really, what you’re doing 

is testing a system. Try 

something, note its effect on 

the outcome, and figure out 

some tweaks. Even failure 

is rewarding, since Polo’s 

demise is often entertaining 

in itself. CRAIG GRANNELL

 A well-made, sleek, 
and minimal podcast 

streamer that doesn’t 
handle downloads.  

 Easy to use

 No downloads

VERDICT

 A wonderful, tactile, 
inventive puzzle game 

that is a joy to play.

 Very imaginative

 A couple of 

annoying levels

VERDICT

APPLE CHOICE iOS software

individual episodes. It’s kept 

simple, as are the controls, 

with just play, pause and 

skip back or forward (by 15 

seconds by default, which 

can be changed in Settings). 

You can reset your progress 

in an episode, or mark it as 

finished. Episodes you’ve 

listened to vanish from the 

lists. New episodes of casts 

you’ve subscribed to are 

’sodes

marked as unplayed; the 

In Progress section houses 

any podcasts that you’re 

part way through. 

The ’sodes app provides 

clean, intuitive podcast 

management, and deserves 

to be used every day. It’s just 

a shame about the lack of 

downloading, even if that 

would introduce detail to the 

interface. IAN EVENDEN

B  
ring You Home 

rethinks platform 

puzzle games by 

having you manipulate 

the environment rather 

than the protagonist.

Said protagonist is Polo, 

a blue alien who sees his pet 

kidnapped by villains who 

then disappear. In pursuit, 

Polo falls from a window, 

and lands head-first.

Fortunately for Polo, time 

then rewinds, and you can 

save his dignity and face by 

swiping down to place a cart 

full of hay; tap play and it 

breaks Polo’s fall. He then 

finds himself in a jungle. 

Bring You Home

A minimalist way to play podcasts

 £2.99  FROM Nice Boy, jaredsinclair.com/sodes

 NEEDS iOS 11 or later

Though ’sodes is bare-bones, you 
can share links to shows from it.

The Unplayed section houses new 
episodes of subscribed podcasts.

We’re not sure what’s going on here, 
bar our hero getting electrocuted.
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Artstudio Pro
An app of all trades

 £11.99  FROM Lucky Clan, luckyclan.com  

 NEEDS iOS 10 or later, Apple Pencil for pressure support

S
ome iPad art apps 

are dedicated 

painting apps, 

others are photo editors 

with painting tools. 

Artstudio Pro is both. 

The Adjust and Filters menus are reminiscent 

of Photoshop, there’s a Layers palette, and 

the toolbox includes image editing essentials, 

such as Lasso, Clone Stamp, Sharpen, Dodge, 

and Burn. Tap the paintbrush icon, though, 

and – once you’ve figured out you can access 

the Brush Editor from the brush tip preview 

(bottom left) – you have a full range of inks, 

pencils, chalks and paints, which can be 

supplemented by importing brushes in 

Adobe’s ABR and TPL formats.

The slider icon at the top right of the Brush 

Editor gives detailed control over the look and 

behaviour of each brush, including dynamic 

response to pressure when using an Apple 

Pencil, or to velocity when painting with your 

finger. Whichever you choose, the results are 

expressive and impressive.

With image adjustments comparable to 

Pixelmator and artistic versatility rivalling 

Procreate, there’s little to compete with 

Artstudio Pro except Affinity Photo (which 

costs £8 more). Like that app, Artstudio Pro 

 A good painting app 
with useful image 

adjustment features.

 Mostly neat and 

responsive interface

 Detailed brush editing

 Can feel niggly

 Some features less 

deep than others

VERDICT

If you want 
just one 

app for your 
‘art’ needs, 

Artstudio Pro 
is decent value

Reviewed by ADAM BANKS

also has a Mac version (£38.99). Thanks to 

iCloud, you can make a new file at your desk 

and start painting, then pick up your iPad, tap 

Artstudio’s Open Documents menu, and your 

work’s there. The catch is that your custom 

brushes aren’t, until you export and import 

them. We found the Mac-like nature of the 

iPad version less than helpful: not only is 

there a full menu bar – odd on iOS – but the 

File menu and Open Documents (equivalent 

to the Window menu) insist on the concept of 

opening and closing files. Since you can’t show 

multiple windows, this adds nothing to the 

separate Documents view.

Spreading itself thin
We found other aspects confusing, too, 

including the unusual way of handling layer 

masks. Some features aren’t supported fully 

enough to make them usable for serious work: 

selections lack finesse, and vector text has no 

spacing controls. Photo pros will miss basics 

like Raw editing, CMYK, channels and paths. 

Then again, Artstudio Pro’s engine coped fine 

with high-resolution files on our iPad Pro 

(although some brushes can feel small at large 

sizes), you can import and export PSD files, 

and there’s a Procreate-like screen-recording 

mode for painting demos.

If you want just one app for pretty much 

all your ‘art’ needs, don’t need advanced 

retouching tools, and are prepared to learn an 

idiosyncratic interface, Artstudio Pro is decent 

value, and its painting tools offer plenty of 

customisation. But Affinity Photo is a more 

comprehensive image editor, while Procreate 

makes painting easier. 
If the screen feels too cluttered, you can tap the 
top-right icon to hide controls while you’re drawing.

The app offers a good set of adjustments. Nonetheless, 
photo retouchers will want more than are provided.
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 Ever since the famous Bondi Blue iMac 

debuted in August 1998, Apple’s all-in-one 

desktop computer has been setting standards 

in gorgeous design and powerful performance. 

Apple’s innovation was as clear back then as it 

is today – the iMac was the first Macintosh to 

drop the floppy disk in favour of USB, and its 

colourful aesthetic set it apart as a playful 

pretender in a world of staid beige boxes.

Today, Apple is again pushing boundaries 

with the iMac, blessing all of its 27-inch models 

with a massive 5K (5120x2880) resolution and 

a wide P3 colour gamut. Add in Intel Core i5 

and i7 CPUs (configurable from 3.4GHz up to 

4.2GHz), a fast and capacious Fusion Drive, and 

powerful AMD Radeon RX graphics processors, 

and the 27-inch iMac is the desktop system to 

own. At WWDC in June 2017, Apple refreshed 

the entire range of iMacs, with discrete GPUs 

coming to all but the entry-level model, newer 

Intel CPUs, brighter Retina displays and more 

Thunderbolt 3 ports.

 An update in 2014 brought a £100 

price drop to the most affordable 

Mac, but rises in late 2016 added 

£80 back on. The mini comes with 

some interesting talking points: the 

entry-level model has a 1.4GHz dual-

core Intel Core i5 CPU and 4GB of 

memory, making it one of the lowest-

spec Macs around, with a 500GB 

hard drive and no display. 

Higher-end models come with 1TB of 

storage included (Fusion Drive and 

SSD options are available), 8GB of 

memory, a better graphics processor 

and either a 2.6GHz or 2.8GHz Intel 

Core i5 for £679 and £949. Those 

models can be upgraded to a Core 

i7, but there aren’t any quad-core 

options available at the moment. 

Expect updates in 2018. 

 iMac

 Mac mini

 Choose an iMac

W
elcome to MacFormat’s 

Store Guide, the place 

to go to find out about all 

the Apple kit that matters, whether 

you’re looking for your next iPhone 

or a powerful new desktop Mac. 

We’ve highlighted the model of 

each product that’s ideally suited to 

your needs, whether you’re a recent 

convert or a seasoned Apple user. 

So be sure to check our handy tables 

to see which Mac, iPad or iPhone is 

best for you.

We’ve also handpicked the gold 

standard in audio, storage, cameras, 

and many other categories, helping 

you complement your Mac or iOS 

device with the best accessories. 

All of these third-party devices have 

been reviewed in the magazine.

Your complete guide to the best Apple 
hardware and third-party accessories

EDITED BY ALEX BLAKE 

From 
£479

UPDATED

OCT 2014

EXPECTED

2018

 MODEL  KEY SPECIFICATIONS  PRICE

21.5-inch 
3.0GHz  
quad-core  
Intel Core i5

MEMORY 8GB of 2400MHz DDR4
GRAPHICS AMD Radeon Pro 555
STORAGE 1TB (5,400rpm) hard drive
DISPLAY Retina 4K (IPS, P3 gamut) 
ALSO Magic Mouse 2, Magic Keyboard

£1,249

27-inch 
3.4GHz  
quad-core  
Intel Core i5

MEMORY 16GB of 2400MHz DDR4
GRAPHICS AMD Radeon Pro 570
STORAGE 1TB Fusion Drive 
DISPLAY Retina 5K (IPS, P3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£1,929

27-inch 
4.2GHz  
quad-core  
Intel Core i7

MEMORY 16GB of 2400MHz DDR4
GRAPHICS AMD Radeon Pro 580
STORAGE 2TB Fusion Drive 
DISPLAY Retina 5K (IPS, P3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£2,609
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Apple tips 
From Stormfront, your 

local Apple experts

Apple Peencil 

Ellie Otley, Darryl Elkins 
Stormfront.co.uk

The 9.7-inch iPad now supports 

Apple Pencil. Setting up a Pencil 

is as simple as connecting it to an 

iPad or iPad Pro’s Lightning port 

and tapping Pair on the screen. 

There are many built-in apps that 

make use of Apple Pencil, including 

Pages, Numbers and Keynote, as 

well as the Notes app, where you 

can annotate, mark up and create 

handwritten notes.

Apple Pencil is an extra cost on 

top of an iPad, but its functionality 

is a bonus if you prefer using a 

traditional pen-and-paper approach 

to jotting down notes, or if you’re 

an aspiring digital artist and want 

to create natural and expressive 

artwork without having to make the 

jump to the more costly iPad Pro.

You can even operate the iPad 

using Apple Pencil, such as to open 

apps, select text in emails or docs, 

or type using the on-screen 

keyboard, which some people 

find more accurate than using 

their (possibly clumsy) fingers. 
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 The baby of Apple’s laptop family, 

the MacBook was updated at WWDC 

2017 to get Intel Kaby Lake processors 

and faster SSDs. Weighing in at just 

0.92kg, it’s Apple’s most lightweight 

laptop but still packs in a 226ppi pixel 

density in its 12-inch Retina display.

The MacBook is powered by an Intel 

Core M processor (configurable to Core 

i5 or i7), which doesn’t require a fan to 

keep cool, so the MacBook runs silently. 

It also features a Force Touch trackpad, 

which can trigger different responses 

as you apply more pressure. All models 

of the MacBook come loaded with 8GB 

of 1866MHz memory, which can be 

boosted to 16GB, and Intel HD Graphics 

615 – an upgrade from the previous HD 

Graphics 515 – and there are 256GB or 

512GB flash storage options. There are 

four colour options: Silver, Space Grey, 

Gold, and Rose Gold.

 Apple debuted the new MacBook Pro 

in October 2016 with an OLED strip of 

app-specific controls called the Touch 

Bar. The Force Touch trackpad was made 

larger to give more room for gestures, 

and the keyboard was also updated to 

have a second-generation version of the 

butterfly keys from the 12-inch MacBook. 

The MacBook Pro range then got a 

further boost at WWDC 2017, when both 

the 13-inch and 15-inch models had their 

processors updated to Intel’s Kaby Lake 

models. The larger of the two also had 

its graphics card upgraded to give more 

powerful Radeon Pro options.

You get two or four Thunderbolt 3 

ports (depending on the model), which 

are also compatible with USB-C devices, 

and through which you can charge the 

MacBook Pro. The 13-inch and 15-inch 

sizes remain, although the entry-level 

13-inch lacks a Touch Bar.

 MacBook  MacBook Pro

 Choose a MacBook Pro

UPDATED
JUNE 2017

EXPECTED
JUNE 2018

UPDATED
JUNE 2017

EXPECTED
2018

 MODEL  KEY SPECIFICATIONS  PRICE

13-inch 
2.3GHz  
dual-core  
Intel Core i5

MEMORY 8GB of 
2133MHz LPDDR3
GPU Intel Iris Plus 640
STORAGE 256GB SSD
Touch Bar No

£1,449

13-inch 
3.1GHz  
dual-core  
Intel Core i5

MEMORY 8GB of  
2133MHz LPDDR3
GPU Intel Iris 650
STORAGE 256GB SSD
Touch Bar Yes

£1,749

15-inch 
2.8GHz  
quad-core  
Intel Core i7

MEMORY 16GB of 
2133MHz LPDDR3
GPU Radeon Pro 555
STORAGE 256GB SSD
Touch Bar Yes

£2,349

E
N

T
R

Y
 L

E
V

E
L

U
P

G
R

A
D

E
R

H
IG

H
 E

N
D

 Choose a MacBook

 MODEL  KEY SPECIFICATIONS  PRICE

12-inch 1.2GHz  
dual-core  
Intel Core m3

MEMORY 8GB of 
1866MHz LPDDR3
GRAPHICS Intel HD 
Graphics 615
STORAGE 256GB SSD

£1,249

12-inch 1.3GHz  
dual-core  
Intel Core i5

MEMORY 8GB of 
1866MHz LPDDR3
GRAPHICS Intel HD 
Graphics 615
STORAGE 512GB SSD

£1,549

12-inch 1.4GHz  
dual-core  
Intel Core i7

MEMORY 16GB of 
1866MHz LPDDR3
GRAPHICS Intel HD 
Graphics 615
STORAGE 512GB SSD

£1,864
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 Apple always had to do something big 

for the iPhone’s tenth birthday, and it’s 

done that with the iPhone X. Sporting a 

glass back to allow wireless charging and 

a gorgeous edge-to-edge, OLED, Super 

Retina display measuring 5.8 inches 

across, it’s big news all over.

Its better cameras don’t just mean 

great photos – they allow for Face ID, 

the face-scanning technology that is the 

latest, safest way to unlock your phone 

(goodbye Touch ID and Home button).

But don’t let the new kid on the block 

overshadow the iPhone 8 and 8 Plus – 

they’re great phones in their own right. 

They get wireless charging too, plus 

revamped cameras, a new A11 Bionic 

chip, and new augmented reality tech.

All new models come in 64GB and 

256GB capacities. The pricing for the 

iPhone 8 starts at £699, the 8 Plus at 

£799 and the iPhone X at £999.

 In March 2018, Apple made a move to 

capture market share in education by 

updating the 9.7-inch iPad. It now comes 

with support for Apple Pencil, and its 

internals have been boosted too.

The 9.7-inch iPad features an A10 

Fusion CPU and M10 motion coprocessor, 

and comes in 32GB and 128GB storage 

sizes. The touch sensor in the display 

now has a higher resolution, allowing it 

to support the Apple Pencil for the first 

time. It’s also got an 8MP rear camera 

and a 1.2MP front-facing camera.

On the software side, the iPad adds 

multitasking features, which are a boon 

for productivity. You can slide a second 

app over the right side of the one you’re 

working in, then dismiss it to get back to 

work. Picture in Picture enables you to 

watch video in a corner of the screen. 

There’s also Split View, which lets you 

work on two apps side by side.

 MODEL  KEY SPECIFICATIONS  PRICE

iPhone SE 
(4-inch 
display)

CAPACITY: 128GB
PROCESSOR: A9
FACE ID No
CAMERA 12MP photos,  
4K video recording

£449

iPhone 8 
(4.7-inch 
display)

CAPACITY: 64GB
PROCESSOR: A11 Bionic
FACE ID No
CAMERA 12MP photos, 
4K video

£699

iPhone X  
(5.8-inch 
display)

CAPACITY: 64GB
PROCESSOR: A11 Bionic
FACE ID Yes
CAMERA 12MP photos 
(dual-camera), 4K video

£999

 MODEL  KEY SPECIFICATIONS  PRICE

7.9-inch 
iPad mini 4

CAPACITY 128GB 
PROCESSOR A8
CONNECTIVITY Wi-Fi
CAMERA 8MP
TOUCH ID Yes

£399

9.7-inch iPad CAPACITY 128GB
PROCESSOR A10
CONNECTIVITY Wi-Fi
CAMERA 8MP
TOUCH ID Yes

£409

12.9-inch 
iPad Pro

CAPACITY 256GB
PROCESSOR A10X
CONNECTIVITY Wi-Fi
CAMERA 12MP
TOUCH ID Yes

£919

 iPhone  iPad

 Choose an iPhone  Choose an iPad
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 The iPad Pro comes in 10.5-inch and 

12.9-inch sizes, packed with either 64GB, 

256GB or 512GB of storage. All models 

are available with the option of mobile 

network connectivity. The Pro’s A10X 

chip is the most powerful in any iOS 

device, and it has an impressive four-

speaker sound system, too. Adding the 

pressure-sensitive Apple Pencil and 

120Hz refresh rate makes it a smooth, 

accomplished drawing tool.

 iPad Pro From 
£619

UPDATED

JUNE 2017

EXPECTED

2018

UPDATED

JUNE 2017

EXPECTED

2018

UPDATED

SEPT 2017

EXPECTED

LATE 2018

 The Watch is Apple’s quiet revolution, 

and it’s now the number one watch in 

the world. Series 3 is meant to cement 

that status quo. To achieve that, Series 3 

lets you make and receive calls from 

your wrist without your iPhone around 

for the first time – the sci-fi dream is 

now a reality. You can also stream Apple 

Music to it – another benefit that means 

you can leave your phone at home.

Performance-wise, the processor has 

seen a 70% speed boost, and the new 

W2 wireless chip is far faster and more 

power efficient. All that, yet the case is 

still the same slimline size.

Apple also introduced new colours 

and bands, plus a new dark grey colour 

for the high-end ceramic model. 

From £329 (Series 3)

UPDATED

SEPT 2017

EXPECTED

SEPT 2018

 Watch
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 Getting a colour-accurate display used 

to cost a pretty penny, but this monitor 

is both impressive and affordable. It hits 

99% of the Adobe RGB gamut – great for 

colour-critical work – and supports 10-bit 

colour. Throw in a host of ports (including 

USB-C), an IPS display and a great price, 

and you have a seriously good screen.

 We love this display. At 32 inches 

diagonally it’s big enough to make its  

4K resolution worthwhile, and its colour 

rendering is excellent – 100% of sRGB, 

93% of Adobe RGB and 97% of the P3 

gamut that Apple’s new MacBook Pro 

uses. It’s big, bold, beautiful and superb 

for productivity and colour work alike.

 With two blazing fast Thunderbolt 3 

ports and a 5Gbps USB-C port to boot, 

the Drobo 5D3 can provide you with rapid 

file transfers to and from your Mac. You 

can load it up with up to five HDDs or 

SSDs of differing capacities, giving you 

plenty of flexibility for storage options. 

It’s pricey, but a worthy investment.

 This router has an awful lot going for it. 

The winner of issue 321’s group test, the 

Asus scored an impressive five stars in 

three out of four categories. It performed 

brilliantly in our tests, has excellent 

connectivity (with both Ethernet and 

ADSL options), and it looks great too. It 

will keep your network powered for years.

 The Eco-Tank ET-2600 has a fairly high 

cost, but its innovative cartridge-free 

design will save you a ton of money 

in the long run. It’s got a scanner and 

copier, plus Wi-Fi and USB connectivity. 

Replacement inks are cheap, working out 

at a mere 0.2p per page for mono text, 

and just 0.35p per page for colour.

 The original TS3 

gave Macs a new level 

of connectivity. Now 

the TS3 Plus offers 

an incredible 14 ports. 

The TS3 Plus is quite 

pricey, but its 10Gbps 

USB-C port and four 

USB-A ports (among others), make it 

our Thunderbolt dock of choice. The 

Thunderbolt 3 port supplies up to 85W, 

so it can even charge a 15in MacBook Pro. 

 This drive is the fastest portable SSD 

we’ve ever tested. Freecom claims its 

write speeds can reach 700MB/sec, but 

in our tests it blazed past that to reach 

713.8MB/sec write speeds and 907.3MB/

sec read speeds, thanks to its USB 3.1 

Gen 2 capability. It’s costly, but worth 

it if you feel the need for speed.

 The Netatmo 

Presence is an 

impressive outdoor 

security camera. Set 

in a sturdy housing, 

it’s built to defy the 

elements. It has a  

built-in floodlight to 

deter intruders, and a 100° field of view 

recorded in 1080p. There’s also an SD 

card included, making it easy to store 

and access your footage.

 Your MacBook 

needs protection, 

and the STM Kings 

backpack is the best 

way to guarantee 

that. Winner of 

MF316’s group test, 

it cleverly suspends 

your MacBook away from the floor to 

prevent bumps. With loads of storage, 

comfortable straps and a snazzy design, 

it’s a great all-rounder.

 MONITOR

Philips 328P6AUBREB
£396 philips.co.uk

 NETWORK STORAGE

Drobo 5D3
£601 drobo.co.uk

 PRINTER

Epson EcoTank ET-2600
£179 epson.co.uk

 ULTRA HD MONITOR

Philips 328P6VJEB 
£551 philips.co.uk

 WIRELESS ROUTER

Asus DSL-AC88U AC3100
£210 asus.com/uk

 IP CAMERA

Netatmo Presence
£190 netatmo.com

 EXTERNAL SSD

Freecom mSSD MAXX 512GB
£247 freecom.com

 THUNDERBOLT DOCK

CalDigit TS3 Plus
£349 caldigit.com/uk

 MACBOOK BAG

STM Kings
£98 stmgoods.com
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 With rich, warm 

sound that works 

with pretty much 

any genre, the KEF 

Egg speakers are 

ideal partners for 

your Mac. They 

support high-quality aptX Bluetooth too, 

making them perfect for wireless 

playback. Quirky design, solid build quality 

and support for external subwoofers 

makes them a great choice.

 If you own an iPhone 

7, you’ll know the 

struggle of trying to 

listen to music and 

charge your phone 

at the same time. 

These in-ear Lightning 

headphones solve that, thanks to their 

built-in charging port. They’ve also got 

great audio quality, excellent noise 

cancellation and will pause your tunes 

when removed from your ears.

 Dash cams help 

record what happens 

when you drive – 

useful if you’re in an 

RTC. If you’re in the 

market for one, this 

cam is one of the best. 

Packed with Wi-Fi, 

GPS logging, Full HD video and a night 

view as well, you get an awful lot for your 

money. There’s even a free 16GB memory 

card included in the box.

 Want a multiroom 

audio system in your 

home? This little speaker 

is your best option, 

hands down. It cleaned 

up in MF309’s group 

test, scoring five stars 

in every test category. 

From top-notch sound to 

tons of great features, the Zipp is a superb 

choice. It even boasts AirPlay for great 

integration with Macs and iOS devices. 

 Don’t be fooled by this 

mic’s small form factor; it 

punches hugely above its 

weight. Its close-up sound 

is intimate and bassy, and 

brings out the best in any 

voice. No matter whether 

you’re recording an 

interview, creating 

a podcast or just jamming with your 

band, its clarity and depth makes it 

easy to recommend.

 Love music as much 

as we do? Then you’ll 

want to get your mitts 

on one of these. It plays 

high-res audio files, 

and absolutely blows 

MP3 files out of the 

water. One listen will 

change the way you hear your audio 

tracks and, unlike other high-res audio 

players, it’s reasonably priced. It really 

will rock your world.

 Packed full of 

tracking features 

for a host of sports, 

and filled with 

genuinely insightful 

metrics, this is a 

fitness smartwatch 

for nearly any 

occasion. Its battery will last you days, 

perfect for the odd weekend hiking trip. 

With all this, it’s not hard to see why it 

won MF308’s group test. 

 DESKTOP SPEAKER

Kef Egg
£350 kef.com

 PORTABLE SPEAKER

Libratone Zipp
£224 libratone.com

 HIGH-RES AUDIO PLAYER

Pioneer XDP-30R
£348 pioneer-audiovisual.eu

 IN-EAR HEADPHONES

Pioneer Rayz Plus
£149 pioneerrayz.com

 PORTABLE BATTERY PACK

Apple iPhone 7 Smart  
Battery Case £99 apple.com/uk

 ACTION CAMERA

GoPro Hero6 Black
£500 gopro.com

 DASH CAM

Transcend DrivePro 230
£150 transcend-info.com

 MICROPHONE

Blue Microphones Raspberry
£164 bluemic.com

 FITNESS SMARTWATCH

Garmin Vivoactive HR
£240 garmin.com

 Despite that silly-

looking hump on its 

back, the official battery 

case for the iPhone 7 is 

rather impressive. It’s 

easy to fit, the buttons 

feel great, and the soft 

inner lining protects your phone against 

scratches. The built-in battery isn’t the 

largest capacity around, yet it has more 

than enough juice for busy days, and the 

bump is surprisingly comfy.

 GoPro’s latest 

action cam 

is a stunner, 

with 4K video 

at 60fps and  

1080p video at a 

whopping 240fps 

for fantastic slow-motion footage. It’s 

waterproof to 10 metres, has improved 

image stabilisation, wider dynamic range 

and better performance in low light than 

its Hero5 Black predecessor, too.
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 PHOTO EDITOR (MAC)

Affinity Photo
£48.99  serif.com

 VIDEO EDITOR (MAC)

Final Cut Pro X 10.3
£299.99  apple.com/uk 

 WEB DESIGN APP (MAC)

RapidWeaver 7
£79  realmacsoftware.com

 WRITING APP (MAC)

Scrivener
About £34 literatureandlatte.com

 UTILITY (MAC)

Carbon Copy Cloner 5
£31.10 bombich.com

 SYSTEM ENHANCEMENT (MAC)

Bartender 3
£11.10 macbartender.com

 STREAMING SERVICE (MAC/IOS)

Spotify
Free, £9.99 per month (Premium)

spotify.com

 PRODUCTIVITY APP (MAC/IOS)

Fantastical 2
£38.99 (Mac), £2.99 (iPhone)  

flexibits.com

 EMAIL MANAGER (MAC/IOS)

Spark
Free sparkmailapp.com

 It’s hard not to love 

Affinity Photo. Whether 

you fancy yourself as 

a seasoned pro or a 

photo novice, you’ll 

find this image editor powerful and easy 

to use. Its interface offers the perfect 

blend of ease of use and quick access to 

powerful features, and its useful batch 

processing is a great addition. An app 

that packs both power and practicality 

for less than £50? We’re in!

 Apple’s Final Cut Pro 

has always been a good 

option for video editors, 

and the latest version 

makes it even better. 

It introduces ‘roles’, which can be 

colour-coded to make your timeline’s 

components easier to navigate, something 

that’s further boosted by the streamlined 

interface. This version also supports the 

Touch Bar and wide colour gamut display 

on recent models of MacBook Pro.

 Ever since Apple stopped 

updating iWeb, Mac users 

have been searching for 

the ideal replacement. 

Well, look no further – 

it’s RapidWeaver. Don’t know how to 

write HTML and CSS code? No worries, 

RapidWeaver lets you design visually 

if you want to. You can build all kinds 

of page and publish to many different 

platforms, and extend the app’s functions 

with thousands of add-ons.

 It’s not often that a 

sequel is even better than 

its predecessor, but 

Scrivener 3 is a great 

example. Version 2 was 

already good, winning MF319’s group test, 

but version 3 adds so much. Its revamped 

interface is hugely customisable, its 

templates are fantastic, managing 

footnotes is a breeze, and the whole app 

is light and speedy. If you write, Scrivener 

is absolutely essential.

 When disaster strikes 

and your hard drive fails, 

having a backup can be 

a lifesaver. This app 

makes creating and 

restoring from backups an absolute 

breeze. It comes with a helpful guided 

restore feature, plus a Cloning Coach that 

monitors what you do and looks out for 

potential problems. If you’re looking to 

clone or back up your hard drive, this is 

the app you need.

 Some apps are so 

simple and effective 

that you don’t know 

how you lived without 

them. Bartender is 

one: it lets you choose what appears in 

the menu bar, and when things appear 

too. You can set triggers, such as an app 

only appearing when it’s updating, and 

rearrange items. Bartender’s settings are 

clear and concise. It sounds simple, but 

it’ll change the way you use your Mac.

 Feeling inbox anxiety? 

The solution could be 

Spark, an email app for 

Mac and iOS. It’s centred 

on a ‘smart inbox’, which 

prioritises your emails based on perceived 

importance – no more losing that vital 

work email among a sea of spam. You can 

snooze messages to be reminded about 

them later, and search your mailboxes by 

expressing yourself in natural language, 

too. And to top it all off, it’s free.

 If you find your 

calendar and reminders 

are getting out of 

control, Fantastical is the 

app for you. It supports 

natural language entry, so that you can 

enter events and reminders as you would 

speak and Fantastical will get to work. It’s 

got a nifty menu bar shortcut, plus a great 

interface, clever calendar management 

and a powerful iOS app to boot. 

 Despite strong 

competition from the likes 

of Tidal, Apple Music and 

Amazon, Spotify is our 

top music-streaming 

choice. It hits all the right notes, from its 

fair price to its curated playlists. Its library 

is one of the largest on the market, and its 

interface is simple and straightforward 

to use. And, unlike Apple Music and 

Tidal, it has a free tier as well.



PHOTO STREAM Shot of the month

 

We’re all in the midst of 

dreaming of summer holidays, 

or at least planning a break 

from the office. But we won’t 

be able to officially move on 

into summer until we can bid 

a proper farewell to the most 

crazy winter/spring we’ve seen 

in a long time. We had a few 

snow days here in Bath – team 

member Jo even got snowed 

up in Teignmouth! So thanks 

to trothwyr from Wales for 

capturing the cold snap with 

this lovely ‘white blanket’ scene!

 

Share your pics with us using 

the hashtag #MacFormat on 

Instagram. In each issue, 

we’ll pick our favourite 

to feature on this page. 

GET ON INSTAGRAM

 Share your images with us by using the 

hashtag #MacFormat and we’ll print the 

best here in the magazine. While you’re 

there, follow @MacFormat (Twitter) and 

@MacFormatUK (Instagram).

 macformat.com  @macformat

WHAT  
TO DO! 

  1 Open an Instagram account.

 2  Follow @MacFormatUK (of course).

 3 Take a picture of, or with, your Apple kit.

 4 Share it on Instagram or Twitter.

 5 Use the hashtag #MacFormat.

 6 Feel the warm glow of an  

appreciative Apple community.

 7 See if you made it onto the  

pages of this very magazine!

 8 Repeat.

Goodbye winter, 
Hello, summer 

BY TROTHWYR 
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Written by Alex Blake 

SuperDrives 
into the sunset 
 You could argue that 

Apple ditched optical 

media too soon, given 

that many people still 

watch movies on Blu-ray 

and now Ultra HD (4K) 

Blu-ray discs. It bit the 

bullet a long time ago 

when it came to its tools 

for creating video discs, 

releasing the final 

versions of DVD Studio 

Pro and iDVD in 2009 

and 2011, respectively.

Neither app gained 

Blu-ray support, and 

the Mac soon ditched 

optical drives altogether.

In 2008, Steve Jobs 

called Blu-ray “a bag of 

hurt” as it was complex 

to license. Apple decided 

to wait and see how the 

market developed. But, 

in the end, it has never 

added Blu-ray playback 

into Macs, never mind 

creation tools.

A very 
tangled iWeb
 In 2006, Apple had 

a vision for the web, 

where everyone could 

easily create their own 

website in a few clicks.

That vision was 

manifested in iWeb, 

complete with widgets 

letting you embed 

various widgets, such 

as YouTube videos and 

maps. In 2012, iWeb fell 

victim to changing 

publishing patterns as 

people moved to sites 

like Medium and Tumblr 

rather than building 

websites from scratch.

‘Sherlocked!’ 
 Before Spotlight there 

was Sherlock. Though 

a simple search app, it 

generated controversy 

when Karelia Software 

claimed Apple copied 

its Watson app when 

it released Sherlock 3. 

Since then, ‘sherlocking’ 

has come to refer to 

the practice of Apple 

releasing an app that’s 

similar to that of a rival.

NEXT ISSUE
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1984

 It doesn’t sound 

much today, but 

MacPaint was exciting 

because it could make 

graphics you could 

use in other apps. 

To advertise it, Apple 

bought up all 39 ad 

pages in a single issue 

of Newsweek.

1996 

 First developed in 

1996, Shake quickly 

became the industry 

standard for visual 

effects compositing 

in films. Apple bought 

its developer Nothing 

Real in 2002 and later 

incorporated some 

features into Final Cut.

2005 

 Where iPhoto was 

for lightweight edits, 

Aperture was the 

heavy-duty photo-

editing solution from 

Apple. Ten years later 

it was discontinued 

in favour of Photos, 

which took on some 

(but not all) of its 

editing features.

2005 

 The Front Row app 

was designed to be a 

complete media centre 

for your movies, music 

and photos. Alas, it was 

discontinued in 2011 as 

Apple moved towards 

streaming media on 

demand – the default 

for Apple Music, and 

4K movies on Apple TV.

A
pple has made some 

great apps over the 

years, but not all 

of them have survived into 

the modern era. Some apps 

were great ideas at the time, 

but soon became outdated, 

while others got superceded 

by even more impressive 

replacements. Here’s a 

rundown of the most notable 

apps from Apple that are no 

longer with us.

1987

 Before the World 

Wide Web, there was 

HyperCard. It had a 

graphical interface 

comprised of virtual 

cards that could 

contain text, media or 

other info. HyperTalk, 

its programming 

language, later 

influenced JavaScript.

Gone, but not forgotten
The big apps that didn’t make the cut

2002 

 The much-loved 

photo-editing app 

iPhoto was included 

with new Macs from 

2002 through to 

2015, when it was 

replaced by Photos.

1984

 In 1984, Apple 

debuted one of the 

first computer office 

suites in the form of 

AppleWorks. It was 

spun out to Claris, 

incorporated GS 

Works and was then 

brought back in-house 

by Apple in 1997.

1990

2000

2005

1980

1985

1995

2010
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